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This document describes the features of Oracle Database for Microsoft Windows (x64) software installed on a computer with an AMD64 or Intel EM64T processor and any of the following operating systems:
This Preface contains these topics:
This guide is intended for database administrators, network administrators, security specialists, and developers who use Oracle Database for Windows.
To use this document, you need:
For information about Oracle's commitment to accessibility, visit the Oracle Accessibility Program website at http://www.oracle.com/us/corporate/accessibility/index.html
.
Access to Oracle Support
Oracle customers have access to electronic support through My Oracle Support. For information, visit http://www.oracle.com/support/contact.html
or visit http://www.oracle.com/accessibility/support.html
if you are hearing impaired.
For more information, see the following documents in the Oracle Database documentation set:
Many books in the documentation set use the sample schemas, which are installed by default when you select the Basic Installation option with an Oracle Database installation. Refer to Oracle Database Sample Schemas for information about how these schemas were created and how you can use them yourself.
The following text conventions are used in this document:
Convention | Meaning |
---|---|
boldface | Boldface type indicates graphical user interface elements associated with an action, or terms defined in text or the glossary. |
italic | Italic type indicates book titles, emphasis, or placeholder variables for which you supply particular values. |
monospace | Monospace type indicates commands within a paragraph, URLs, code in examples, text that appears on the screen, or text that you enter. |
This section describes new features of Oracle Database and provides pointers to additional information. New features information from previous releases is also retained to help those users migrating to the current release.
The following sections describe new features:
Starting with release 10.2.0.4, Oracle Database and Client are supported on Microsoft Windows Vista (x64) and Windows Server 2008 (x64).
Starting with release 10.2.0.5, Oracle Database and Client are supported on Microsoft Windows 7 (x64) and Windows Server 2008 R2 (x64).
See Also: Oracle Database New Features Guide for information about new features in Oracle Database 10g Release 2 (10.2) that are not platform-specific |
This section contains these topics:
Large Page Support
Large page support provides a performance boost for memory-intensive database servers running on Windows Server 2003. By taking advantage of newly introduced operating system support, Oracle Database 10g Release 2 (10.2) can now make more efficient use of processor memory addressing resources.
Scheduler
This release includes a new database scheduler to provide enterprise scheduling functionality. External jobs performed by the user are started using the OracleJobScheduler
service. This service is disabled by default. In order to use the external jobs functionality, the administrator must set the username and password for the user account under which this service must run, and enable the service.
Restricting execution of external jobs to a low-privileged user prevents any random database user from gaining operating system level privileges, but it also places restrictions on the kinds of jobs that can be run. Jobs requiring a higher level of operating system privileges cannot be run by this mechanism.
On Windows, running an external job involves the following processes:
extjob
service (one service, with one thread for each job) See Also:
|
Database Password Encryption
When a user attempts a remote login to Oracle Database, the password is automatically encrypted before it is sent to the remote database. For more information, see "Automatically Encrypted Database Passwords".
Data Pump Import and Export
Two new utilities offer faster transfer of files to and from Oracle Database. The older file transfer utilities, Import and Export, are retained for use with databases created with earlier versions of Oracle software. For more information about Data Pump Import and Export, see Chapter 2, "Database Tools on Windows".
Oracle Database Client Features
Oracle Enterprise Manager Console is available only with Oracle Database Client.
Desupported Features
Migration Utility is not supported in Oracle Database 10g Release 2 (10.2). Pro*C/C++ is supported in Oracle Database 10g Release 2 (10.2), but the graphical user interface to Pro*C/C++ is not.
This chapter describes how Oracle Database architecture takes advantage of some of the more advanced services in Windows operating systems.
This chapter contains these topics:
Oracle Database on Windows is a stable, reliable, and high performing system upon which to build applications. Each release of the database provides new platform-specific features for high performance on Windows.
Oracle Database operates the same way on Windows as it does on other platforms. The architecture offers several advantages on Windows, such as:
Automatic Storage Management (ASM) is an integrated file system and volume manager expressly built for Oracle Database files. ASM provides the performance of raw I/O with the easy management of a file system. It simplifies database administration by eliminating the need for you to directly manage potentially thousands of Oracle Database files. It does this by enabling you to divide all available storage into disk groups. You manage a small set of disk groups and ASM automates the placement of the database files within those disk groups.
The internal process architecture of Oracle Database is thread-based. Threads are objects within a process that run program instructions. Threads enable concurrent operations within a process so that a process can run different parts of its program simultaneously on different processors. A thread-based architecture provides the following advantages:
Internally, the code to implement the thread model is compact and separate from the main body of Oracle Database code. Exception handlers and routines track and de-allocate resources. They add robustness, with no downtime because of resource leaks or an ill-behaved program.
Oracle Database is not a typical Windows process. On Windows, an Oracle Database or Automatic Storage Management instance (threads and memory structures) is a Windows service: a background process registered with the operating system. The service is started by Windows and requires no user interaction to start. This enables the database to open automatically at startup.
When running multiple Oracle Database or Automatic Storage Management instances on Windows, each instance runs its own Windows service with multiple component threads. Each thread may be required for the database to be available, or it may be optional and specific to certain platforms. The background processes read and write from various datafiles, depending on your configuration. Oracle Database architecture on Windows is illustrated in Figure 1-1. Examples of optional and required threads on Windows are listed in Table 1-1.
Figure 1-1 Oracle Database Architecture on Windows
Table 1-1 Required and Optional Oracle Database Threads
Oracle Database Thread | Description | Required/Optional |
---|---|---|
| database writer | Required |
| log writer | Required |
| memory manager process | Required |
| process monitor | Required |
| process spawner process | Required |
| system monitor | Required |
| checkpoint process (thread on Windows) that runs by default on Windows | Optional |
| archive process (or thread on Windows) | Optional |
| distributed recovery background process | Optional |
Oracle Database for Windows is supplied as a set of executables and dynamic link libraries (DLLs). Executable images can be modified using ORASTACK
to change the size of the stack used by the threads of the Oracle Database process. Oracle recommends you use this tool only under the guidance of Oracle Support Services.
Oracle Database supports 64-bit file I/O to allow use of files larger than 4 gigabytes (GB). In addition, physical and logical raw files are supported as data, log, and control files to support Oracle Real Application Clusters (Oracle RAC) on Windows and for those cases where performance must be maximized.
Oracle recommends that you use Automatic Storage Management instead of raw files. It provides the performance benefits of raw files with much better manageability. Automatic Storage Management is available for both single instance and Oracle RAC databases.
Raw files are unformatted disk partitions that can be used as one large file. Raw files have the benefit of no file system overhead, because they are unformatted partitions. Windows supports raw files, similar to UNIX. Using raw files for database or log files can have a slight performance gain. Windows 2000 and above has a disk manager (diskmgmt.msc
) to manage all volumes. Windows Server 2003 includes command line utilities (diskpart.exe
) to manage volumes including raw. Oracle recommends that you use Windows volume mount points for addressing raw volumes.
To Oracle Database, raw files are no different from other Oracle Database files. They are treated in the same way by Oracle Database as any other file and can be backed up and restored through Recovery Manager or OCOPY
.
Several features allow Oracle Database to support an increasingly large number of database connections on Windows:
Note: Oracle Real Application Clusters is not supported on Windows XP and Windows Vista. |
Oracle Database is increasingly integrated with Windows, easing maintenance and improving enterprise-level deployment in security, directory, and transaction services. Integration features in Oracle Database include:
Oracle Advanced Security includes Oracle PKI (public key infrastructure) integration for authentication and single sign-on. You can integrate Oracle-based applications with the PKI authentication and encryption framework, using Oracle Wallet Manager.
Oracle Services for Microsoft Transaction Server (MTS) allow Oracle databases to be used as resource managers in MTS - coordinated transactions, providing strong integration between Oracle databases and MTS. The Oracle Services for MTS act as a proxy for the Oracle database to the Microsoft Distributed Transaction Coordinator (MSDTC). As a result, these services provide client-side connection pooling and allow client components that leverage Oracle to participate in distributed transactions. Oracle Services for MTS can operate with Oracle databases running on any operating system, given that the services themselves are run on Windows.
Oracle Database takes advantage of a native implementation and also stores recovery information in Oracle Database itself. Oracle Services for Microsoft Transaction Server allows development in all industry-wide data access interfaces, including Oracle Call Interface (OCI), ActiveX Data Objects (ADO), OLE DB, Oracle Data Provider for .NET (ODP.NET), Oracle Objects for OLE (OO4O), and Open Database Connectivity (ODBC). The Oracle OCI API offers greatest efficiency.
Note: Windows Vista and Windows Server 2008 introduce new MSDTC changes that do not interoperate with older versions of Oracle Services for MTS. Oracle Services for MTS 10.2.0.4 and later, with the exception of 11.1.0.6, support these new changes on Windows Vista Service Pack 1 and Windows Server 2008 or later. |
Oracle Fail Safe ensures that Oracle Database (and also other Oracle and third-party applications) can be configured and managed for high availability on Windows clusters. An instance runs on only one node at a time.
A cluster is a group of independent computing systems that operates as a single virtual system, eliminating individual host systems as points of failure. Oracle Fail Safe works with Microsoft Cluster Server to ensure that if a failure occurs on one cluster system, then workloads running on that system fail over quickly and automatically to a surviving system. Oracle Database combined with Oracle Fail Safe on a Windows cluster ensures protection from both hardware and software failures.
For well-configured solutions, Oracle Fail Safe ensures a surviving system to be operational in less than a minute, even for heavily-used databases.
See Also: Oracle Fail Safe Manager is not supported. |
See Also: Your Oracle Fail Safe documentation set, available on separate media in the Oracle CD-ROM package |
Oracle Real Application Clusters are integrated with Microsoft Cluster Server clusters deployed on all Windows operating systems that support clustering. This enhances high availability features of Oracle Real Application Clusters by offering:
See Also:
|
Oracle Database for Windows includes various tools to perform database functions. This chapter describes preferred tools to perform common database administration tasks and explains how tools can be started.
Unless otherwise noted, features described in this guide are common to Oracle Database Enterprise Edition, Oracle Database Standard Edition, and Oracle Database Personal Edition.
This chapter contains these topics:
Database tools is a collective term for tools, utilities, and assistants that you can use to perform database administration tasks. Some database tools perform similar tasks, though no one database tool performs all database administration tasks. The following sections indicate which database tools can be used on particular operating systems and preferred tools to use for common database administration tasks.
Almost all database tools are available on all supported versions of Windows. The following are not supported on Oracle Database for 64-bit Windows:
See Also: Oracle Database Release Notes for Microsoft Windows x64 (64-Bit) for a complete list of unsupported features in Oracle Database for 64-bit Windows |
Oracle Enterprise Manager and its optional management packs have additional integrated tools to assist in managing databases. See Oracle Enterprise Manager Concepts for more information.
Table 2-1 lists various database tools you can use to perform common database administration tasks. Oracle recommends you use tools listed in the "Preferred Database Tool" column of the table. After choosing a tool to perform a task, go to Table 2-2, for instructions on how to start the tool.
Note: TheVOLSIZE parameter for Export and Import utilities is not supported on Windows. If you attempt to use the utilities with the VOLSIZE parameter, then error LRM-00101 occurs. For example: D:\> exp system/manager full=y volsize=100m; LRM-00101: unknown parameter name 'volsize' EXP-00019: failed to process parameters, type 'EXP HELP=Y' for help EXP-00000: Export terminated unsuccessfully |
Table 2-1 Preferred Database Tools
Administration Task | Preferred Tool | Other Tools |
---|---|---|
Create a database | Database Configuration Assistant | None |
Delete database services | Database Configuration Assistant | ORADIM |
Start a database | Oracle Enterprise Manager Console | SQL*Plus |
Shut down a database | Oracle Enterprise Manager Console | Control Panel SQL*Plus |
Change database passwords | ORAPWD | ORADIM |
Migrate database users to a directory | User Migration Utility | None |
Migrate a database | Upgrade Information Tool | None |
Upgrade a database | Run provided scripts in SQL*Plus | None |
Export data | Data Pump Export (EXPDP) | Export (EXP) |
Import data | Data Pump Import (IMPDP) | Import (IMP) |
Load data | Oracle Enterprise Manager Load Wizard | SQL*Loader (SQLLDR) |
Back up database | Oracle Enterprise Manager Backup Wizard | Recovery Manager (RMAN) OCOPY |
Recover database | Oracle Enterprise Manager Recovery Wizard | Recovery Manager (RMAN) OCOPY |
Authenticate database administrators and users | Oracle Enterprise Manager Console | SQL*Plus Windows operating system Oracle Administration Assistant for Windows |
Store encrypted and decrypted Oracle Wallet (Oracle Advanced Security and Oracle PKI integration) | Oracle Wallet Manager | None |
Grant database roles | Oracle Enterprise Manager Console | Local Users and Groups User Manager SQL*Plus |
Create database objects | Oracle Enterprise Manager Console | SQL*Plus |
The following points refer to tools listed in Table 2-1, "Preferred Database Tools":
The database wallet that Database Configuration Assistant automatically generates during database registration can only be used with an Oracle Database 10g Release 1 (10.1) or later server. You cannot use this database wallet for earlier versions of the database, nor can you use it for Oracle Internet Directory Release 9.0.4 or earlier.
This section describes how to start each of the database tools in the following categories:
If you have multiple Oracle homes on your computer from previous releases, then see Appendix B, "Optimal Flexible Architecture", in Oracle Database Installation Guide for Microsoft Windows x64 for a description of differences between Oracle homes in different releases.
Beginning in Oracle8i release 8.1.3, each Oracle home, including the first Oracle home you create on your computer, has a unique HOME_NAME. To start Oracle Administration Assistant for Windows from any Oracle home, choose Start >
Programs >
Oracle - HOME_NAME >
Configuration and Migration Tools >
Administration Assistant for Windows.
To ensure that only trusted applications run on your computer, Windows Vista, Windows Server 2008, and Windows Server 2008 R2 provide User Account Control. If you have enabled this security feature, then, depending on how you have configured it, Oracle Universal Installer prompts you for either your consent or your credentials when installing Oracle Database Client. Provide either the consent or your Windows Administrator credentials as appropriate.
You must have Administrator privileges to run some configuration tools, or to run any tool or application that writes to any directory within the Oracle home. If User Account Control is enabled, and you are logged in as the local Administrator, then you can successfully run each of these commands in the usual way. However, if you are logged in as a member of the Administrator group, then you must explicitly invoke these tasks with Windows Administrator privileges.
The following tools must be run with Administrator privileges:
asmtoolg
). This tool is available as a Configuration and Migration Tool. To create a Windows shortcut with Windows Administrator privileges:
To start a command prompt window with Windows Administrator privileges:
When you open this window, the title bar reads Administrator: Command Prompt. Commands run from within this window are run with Administrator privileges.
Table 2-2 describes how to start assistants and other tools from the Start Menu. It also tells where to go for further information about using these products.
Note: When you use an assistant, you must have read and write access to the directory where database files will be moved or created. To create an Oracle Database, you must have an administrative privilege. If you run Database Configuration Assistant from an account that is not part of the Administrators group, then the tool exits without completing the operation. |
Note: All Start Menu paths begin with choose Start > Programs > Oracle - HOME_NAME >. |
Table 2-2 Starting Database Tools from the Start Menu
Tool | Start Menu Path | More Information |
---|---|---|
Configuration and Migration Tools | Chapter 8, "Authenticating Database Users with Windows" | |
Configuration and Migration Tools | "Creating a Database on Windows Using Database Configuration Assistant" | |
Enterprise Manager Console | Oracle Enterprise Manager Console is available from the Start Menu only with Oracle Database Client. | |
Configuration and Migration Tools | Oracle Database Globalization Support Guide | |
Configuration and Migration Tools | Microsoft ODBC Administration online help | |
Configuration and Migration Tools | Oracle Database Net Services Administrator's Guide | |
Configuration and Migration Tools | Oracle Database Net Services Administrator's Guide | |
Integrated Management Tools | Oracle Internet Directory Administrator's Guide | |
Configuration and Migration Tools | To install Oracle Counters for Windows Performance Monitor, choose Advanced Installation and then the Custom installation type. | |
Application Development | SQL*Plus User's Guide and Reference "Starting and Shutting Down a Database with SQL*Plus" | |
Integrated Management Tools | Oracle Database Advanced Security Administrator's Guide | |
Automatic Storage Management Administration | From Application Development, select SQL*Plus |
Note: After installing Oracle Database 10g Companion Products, Oracle Wallet Manager is not available from the Start menu. See Table 2-3, "Starting Database Tools from the Command Line" for instructions on starting Oracle Wallet Manager from the command line. |
Table 2-3 describes how to start Oracle Database tools from the command line, and where to go for further information about using these products.
Table 2-3 Starting Database Tools from the Command Line
Tool | Enter at Prompt | More Information |
---|---|---|
| Oracle Enterprise Manager Console is installed only with Oracle Database Client | |
DBVERIFY starts and prompts you for a filename parameter. To obtain a list of parameters, enter:
| | |
EXPDP starts and prompts you for parameters. To obtain a list of these parameters, enter:
| Oracle Database Utilities for instructions on use of Data Pump Export Oracle Database Error Messages for information about error messages | |
IMPDP starts and prompts you for parameters. To get a list of these parameters, enter:
| Oracle Database Utilities for instructions on use of Data Pump Import Oracle Database Error Messages for information about error messages | |
Database Configuration Assistant |
DBCA wizard starts in interactive mode. For silent options and other command line options enter:
| "Using DBCA" in Oracle Database 2 Day DBA |
EXP starts and prompts you for parameters. To obtain a list of these parameters, enter:
| Oracle Database Utilities for instructions on use of Export Oracle Database Error Messages for information about error messages | |
Import |
IMP starts and prompts you for parameters. To get a list of these parameters, enter:
| Oracle Database Utilities for instructions on use of Import Oracle Database Error Messages for information about error messages |
| "Modifying Oracle Counters for Windows Performance Monitor Parameters" | |
Oracle Wallet Manager |
| Chapter 10, "Storing Oracle Wallets in the Windows Registry" |
To get a list of ORADIM options, enter either of the following:
| "Using ORADIM to Administer an Oracle Database Instance" | |
Password file is hidden. Use Windows Explorer to see it in a file list. Choose View > Options > View > Show All Files | "Creating and Populating Password Files" | |
| Oracle Database Backup and Recovery Basics | |
| ||
SQL*Loader displays a Help screen with available keywords and default values. | ||
| ||
User Migration Utility |
To get a list of parameters, enter:
| "Using the User Migration Utility" in Oracle Database Advanced Security Administrator's Guide |
| "Manually Configuring Disks for Automatic Storage Management" in Oracle Database Installation Guide for Microsoft Windows x64 |
Note: Three special conditions apply when running Export or Import utilities on Windows. First, default values forBUFFER and RECORDLENGTH parameters are 4 KB and 2 KB respectively. This default RECORDLENGTH parameter does not depend on the value of BUFSIZ defined in the system header file. If you specify a value larger than USHRT_MAX (64 KB), you will get a warning message. Second, the VOLSIZE parameter is not supported. Third, to export an entire database, you must use the EXP_FULL_DATABASE role. |
Table 2-4 describes how to start each Windows tool and where to go for more information about using these products.
Table 2-4 Starting Windows Tools
Tool | Start Procedure | More Information |
---|---|---|
Choose Start | "Using Event Viewer to Monitor a Database" Your operating system documentation | |
Choose Start | Your operating system documentation | |
Choose Start | "Using Oracle Counters for Windows Performance Monitor" Your operating system documentation | |
At the command prompt enter: C:\> regedit | "Using Registry Editor to Modify Configuration Information" Chapter 14, "Configuration Parameters and the Registry" Your operating system documentation | |
Right-click the Task Bar and choose Task Manager | "Using Task Manager to Monitor Applications and Processes" Your operating system documentation | |
Local Users and Groups | Choose Start | "Using Local Users and Groups to Manage Users and Groups" Your operating system documentation |
Choose Start | Chapter 8, "Authenticating Database Users with Windows" Your operating system documentation |
Footnote 1 MMC is started whenever Oracle Administration Assistant for Windows is started.
This section describes Windows-specific information for using SQL*Loader (SQLLDR
).
This section discusses possible values for the operating system dependent file processing specifications string option (os_file_proc_clause
), referred to in "Specifying Datafile Format and Buffering" in Chapter 8, "SQL*Loader Control File Reference", in Oracle Database Utilities.
Stream record format in which each record is terminated by a record terminator. If "str terminator_string" is not specified, then the record terminator defaults to either the Windows-style record terminator (the two-character sequence carriage return, \r, followed by line feed, \n) or the UNIX-style record terminator (single-character line feed, \n). Maximum record size is 48 KB.
When processing stream format data files, SQL*Loader can usually recognize record terminators automatically, whether they are Windows-style or UNIX-style. So you usually do not need to specify which record terminator you are using.
For external table loads, however, only Windows-style record terminators are recognized automatically. If your data file contains UNIX-style record terminators, you must specify the record terminator. If you are using SQL*Loader (with external_table
option), then specify the UNIX-style record terminator by specifying "str
'\n'"
on the INFILE
line in the SQL*Loader control file. For example:
You can also specify the record terminator in hex, by specifying "str x'0a'"
(assuming an ASCII-based character set). For example:
Note that the "0
" (zero) before the "a
" is required. If you are using SQL with an access parameter list to create the external table, then you must specify '\n'
in a RECORDS
DELIMITED
BY
clause. For example:
You can also use a hex string in this case. For example:
Note that in this case, the "0" (zero) before the "x" and the "0" (zero) before the "a" are both required.
Fixed record format in which each record is exactly n
bytes long. Record terminators are not required with fixed record format. If the record includes a record terminator, then the record terminator bytes are included in the number of bytes n
.
Variable record format in which the length of each record in a character field is included at the beginning of each record in the datafile. Record terminators are not required with the variable record format. This format provides some added flexibility over the fixed record format and a performance advantage over the stream record format. You can specify a datafile that is to be interpreted as being in variable record format as follows:
In this example, n
specifies the number of bytes in the record length field. If n
is not specified, SQL*Loader assumes a length of 5 bytes. Specifying n
larger than 40 will result in an error. Lengths are always interpreted in bytes, even if character-length semantics are in effect for the file. This is necessary because the file could contain a mix of fields, some processed with character-length semantics and others processed with byte-length semantics.
The distribution media for SQL*Loader contains case study files for control files, datafiles, and setup files in ulcase1,...ulcase11
in the following directory: Oracle_Home
\rdbms\demo.
When SQL*Loader executes, it can create a file called a bad file or reject file in which it places records that were rejected because of formatting errors or because they caused Oracle Database errors. If you have specified that a bad file is to be created, it overwrites any existing file with the same name; ensure that you do not overwrite a file you want to retain.
When preparing SQL*Loader control files (.ctl
), you must follow certain syntax and notational conventions.
In full path descriptions, backslashes do not require escape characters or other special treatment. When embedding a single or double quotation mark inside a string delimited by double quotation marks, place a backslash escape character before the embedded quotation mark.
When specifying datatypes in the SQL*Loader control file, note that the default sizes of native datatypes shown in Table 2-5 are specific to Windows. These datatypes can be loaded with correct results only between systems where they have the same length in bytes. You cannot override these defaults in the control file. If the byte order is different between the systems, you can indicate the byte order of the data with the BYTEORDER
parameter, or you can place a byte-order mark (BOM) in the file.
Table 2-5 Default Sizes of Native Datatypes
Native Datatypes | Default Field Length |
---|---|
DOUBLE | 8 |
FLOAT | 4 |
INTEGERFoot 1 | 4 |
SMALLINT | 2 |
Footnote 1 The default listed is correct if INTEGER is specified without a size. But INTEGER(n) is also allowed. In that case, n specifies the size of the INTEGER field in bytes.
See Also: Oracle Database Utilities for a complete list of options and instructions on using SQL*Loader |
You can use Windows tools in various ways to manage Oracle Database:
Event Viewer lets you monitor events in your system. An event is an important occurrence in the system or application (such as Oracle Database) that requires user notification. While messages for major events can appear on-screen as you work at your computer, events not requiring your immediate attention are recorded by Windows in the Event Viewer log file. You can then view this information at your convenience.
Event Viewer can be used to monitor Oracle Database events, such as:
AS
SYSDBA
In addition, the operating system audit trail is logged to Event Viewer.
See Also: Chapter 6, "Monitoring a Database on Windows" for specific instructions on accessing and using Event Viewer to monitor Oracle Database events |
Microsoft Management Console provides a central location for network administration. Microsoft Management Console hosts applications (called snap-ins) that administrators can use to manage their networks. Oracle snap-ins enable database administrators to:
Oracle Counters for Windows Performance Monitor is integrated into Windows Performance Monitor. This tool enables you to view performance of processors, memory, cache, threads, and processes. Performance information provided includes device usage, queue lengths, delays, throughput measurements, and internal congestion measurements. This information is provided as charts, alerts, and reports.
You can use Oracle Counters for Windows Performance Monitor to monitor key Oracle Database information, such as:
You can use your findings to improve database performance.
See Also: "Using Oracle Counters for Windows Performance Monitor" for specific instructions on accessing and using Oracle Counters for Windows Performance Monitor to monitor Oracle Database performance |
Oracle Database stores its configuration information in a structure known as the registry. You can view and modify this configuration information through Registry Editor. The registry contains configuration information for your computer and must not be accessible for editing by inexperienced users. Only experienced administrators should view and change this information.
Registry Editor displays configuration information in a format similar to Windows Explorer. In the left-hand window is a tree-like format consisting of keys (or folders). When one of these keys is highlighted, parameters and values assigned to that key are displayed in the right-hand window.
When you install products from your CD-ROM, configuration parameters are automatically entered in the registry. These parameters are read each time your Windows computer is started and whenever an Oracle Database product is started. These parameters include settings for:
See Also: Chapter 14, "Configuration Parameters and the Registry" for definitions of Oracle Database configuration parameters and specific instructions on using the registry to modify Oracle Database configuration parameters |
Task Manager has three tabs:
Local Users and Groups enables you to manage users and groups on Windows. Specifically, you can:
Windows 2000 Resource Kit includes several diagnostic and tuning utilities.
QuickSlice provides a quick overview of what is occurring on the system, using a graphical user interface.
Process Viewer summarizes resource usage by a process.
Process Explorer provides a detailed display of resource usage by a process.
Task List displays resource usage and other details of a process when its processor identifier or process name is given as an argument. This tool also displays a list of executables and DLLs associated with a process.
See Also:
|
This chapter describes how to create a database after installing Oracle Database, using either Database Configuration Assistant or command-line tools.
This chapter contains these topics:
All mounted Oracle Database servers in a network must have unique database names. When a database is created, a name is associated with it and stored in its control files. If you provide the database keyword, either in the CREATE DATABASE
statement or when prompted by Database Configuration Assistant, then that value becomes the name for that database.
If you attempt to mount two Oracle Database servers with the same database name, then you receive the following error during mounting of the second server:
If there are two or more Oracle Database servers on the same computer, but located in different Oracle homes, then the following rules apply:
To change the name of an existing database, you must use the CREATE CONTROLFILE
statement to re-create your control files and specify a new database name.
Note: Directory path examples in this chapter follow Optimal Flexible Architecture (OFA) guidelines. If you specified non-OFA directories during installation, then your directory paths will differ. |
Oracle Database can access database files on a remote computer using Universal Naming Convention (UNC), but it may degrade database performance and network reliability. UNC is a PC format for specifying locations of resources on a local area network. UNC uses the following format:
For example, the UNC specification for file system01.dbf
in directory C:\oracle\product\10.2.0\oradata\orcl
on shared server argon
would be \\argon\oracle\product\10.2.0\oradata\orcl\system01.dbf
.
Locations of archive log files cannot be specified using UNC. Always set initialization parameter LOG_ARCHIVE_DEST_
n
to a mapped drive. If you set it to a UNC specification, then Oracle Database does not start and you receive the following errors:
An ORA-00256 error also occurs if you enter \\\meldell\rmdrive
or \\\meldell\\rmdrive
. Control files required the additional backslashes for Oracle8 release 8.0.4, but redo log files and datafiles did not.
Oracle recommends you use Database Configuration Assistant to create a database, because it is easier. It offers the same interface and operates the same way on all supported platforms, so no step-by-step procedures or screen shots are included here.
Database Configuration Assistant enables you to:
An initialization parameter file is an ASCII text file containing parameters. It can be used to create and modify a database using command-line tools. When you create a database using Database Configuration Assistant, a server parameter file (SPFILE) is created from the initialization parameter file, and the initialization parameter file is renamed. Oracle does not recognize the renamed file as an initialization parameter file, and it is not used after the instance is started.
If you want to modify an instance created with Database Configuration Assistant after it starts, you must use ALTER SYSTEM
statements. You cannot change the SPFILE itself, because it is a binary file that cannot be browsed or edited using a text editor. The location of the newly-created SPFILE is ORACLE_BASE
\
ORACLE_HOME
\database
. The SPFILE filename is spfile
SID
.ora
.
See Also: "Managing Initialization Parameters Using a Server Parameter File" in Oracle Database Administrator's Guide |
This section describes how to create a new database manually. As part of its database software files, Oracle Database provides a sample database creation script and a sample initialization parameter file, both of which can be edited to suit your needs. Alternatively, if you have an existing script you can use it as-is to create a database manually or edit it using the sample database creation script as a guide.
Database creations are of three types:
Table 3-1 summarizes tasks involved in creating a new database for each of these database creation categories. Each step is explained in detail in the following subsections.
Table 3-1 Manual Database Creation Tasks
Task | Copy existing database and delete old database | Copy existing database and keep old database | Create new database when no database exists on system |
---|---|---|---|
| Yes | Yes | Yes |
Exporting an Existing Database | Yes | MaybeFoot 1 | Not applicable |
| Yes | No | Not applicable |
Modifying the Initialization Parameter File | Yes | Yes | Yes |
Starting an Oracle Database Instance | Yes | Yes | Yes |
Creating and Starting an Oracle Database Service | No | Yes | Yes |
Putting the CREATE DATABASE Statement in a Script | Yes | Yes | Yes |
Running the CREATE DATABASE Script | Yes | Yes | Yes |
| Yes | MaybeFoot 2 | Not applicable |
Updating ORACLE_SID in the Registry | No | Only if you change the default | Yes |
| Yes | Yes | Yes |
Footnote 1 Yes if you copy data from the existing database to the new database; no otherwise.
Footnote 2 Yes if you import tables and other objects exported from the existing database; no otherwise.
We use an example in the following sections to demonstrate how to create a database. In this example, the existing database is the starter database with a SID
of orcl
located in directory C:\oracle\product\10.2.0\oradata\orcl
. You will copy orcl
to a new database with a database name and SID
of prod
located in directory C:\oracle\product\10.2.0\oradata\prod
. You will then delete starter database orcl
.
Create the following directories in which to put administration and database files for new database prod
:
C:\oracle\product\10.2.0\admin\prod
C:\oracle\product\10.2.0\admin\prod\bdump
C:\oracle\product\10.2.0\admin\prod\pfile
C:\oracle\product\10.2.0\admin\prod\udump
C:\oracle\product\10.2.0\oradata\prod
You are required to export an existing database only if you intend to copy its contents to a new database. If you are working with data from an earlier Oracle release, then you can use Export for this task. If you are using Oracle Database 10g Release 1 (10.1) or later data, then Oracle recommends that you use Data Pump Export because it supports new Oracle Database 10g Release 1 (10.1) or later features, such as floating points.
Although you can start Data Pump Export or Export in either parameter mode or interactive mode, Oracle recommends parameter mode. Interactive mode provides less functionality than parameter mode and exists for backward compatibility only.
The syntax for Data Pump Export parameter mode is:
The syntax for Data Pump Export interactive mode is:
Enter only the command expdp
SYSTEM
/password
to begin an interactive session and let Data Pump Export prompt you for information it needs.
Note: If you use parameter mode, then Data Pump Export considers filenames and directory names to be invalid if they contain one or more blank spaces. The workaround is to enclose the full path in theDUMPFILE= parameter in triple quotation marks. For example:
If Data Pump Export is used in interactive mode, then the filename or directory name can contain a space without quotation marks. |
The syntax for Export parameter mode is:
The syntax for Export interactive mode is:
Enter only the command exp
SYSTEM
/password
to begin an interactive session and let Export prompt you for information it needs.
Note: If you use parameter mode, then Export considers filenames and directory names to be invalid if they contain one or more blank spaces. The workaround is to enclose the full path in theFILE= parameter in triple quotation marks. For example:
If Export is used in interactive mode, then the filename or directory name can contain a space without quotation marks. |
To export all data from an existing database to a new database:
ORACLE_SID
to the database service of the database whose contents you intend to export. For example, if the database you intend to export is starter database orcl
, then enter the following at the command prompt. Note that there are no spaces around the equal sign (=
) character. You now have a full database export of starter database orcl
in file myexp.dmp
. All messages from Data Pump Export are logged in file myexp.log
.
You now have a full database export of starter database orcl
in file myexp.dmp
. All messages from Export are logged in file myexp.log
.
Deleting database files is required only when you copy an existing database to a new database to replace the old database. In the following example, you delete the database files of starter database orcl
.
To delete database files:
orcl
at the command prompt: C:\oracle\product\10.2.0\oradata\orcl
: File Name | File Name | File Name | File Name |
---|---|---|---|
control01.ctl | drsys01.dbf | temp01.dbf | xdb01.dbf |
control02.ctl | cwmlite01.dbf | tools01.dbf | redo01.log |
control03.ctl | example01.dbf | undotbs01.dbf | redo02.log |
index01.dbf | system01.dbf | user01.dbf | redo03.log |
To use starter database orcl
as the basis for your new database, first copy ORACLE_BASE
\admin\orcl\pfile\init.ora
. Second, put the copy in ORACLE_BASE
\admin\prod\pfile\init.ora
. Third, modify the file as described in this section.
Note: Beginning with Oracle9i release 2 (9.2), nesting of quotation marks using the backslash (\) escape character is no longer supported. This may affect how Oracle Database interprets parameter values in your initialization parameter file. For example, if you specifiedCONTROL_FILES = "ctlfile\'1.ora" in releases before release 9.2, the filename would be interpreted as ctlfile'1.ora . Starting with release 9.2, the filename would be interpreted as ctlfile\'1.ora . Oracle highly recommends modifying your parameter files to remove such references. See Oracle Database Reference for other methods of nesting quotation marks in initialization parameter values. |
If you do not have an existing database on your system, then you cannot copy an existing initialization parameter file to use as the basis for your new initialization parameter file. However, you can use the sample initialization parameter file initsmpl.ora
provided in
as the basis for the initialization parameter file for database prod
.
If you use initsmpl.ora
as the basis for the initialization parameter file, then you must set the following parameters to the indicated values, or you will not be able to start database prod
:
DB_NAME=prod.domain
Parameter DB_NAME
indicates the database name and must match the name used in the CREATE DATABASE
statement in "Putting the CREATE DATABASE Statement in a Script". You give a unique database name to each database. You can use not more than eight characters for a database name. The name is not required to match the SID of the database service.
INSTANCE_NAME=prod.domain
SERVICE_NAMES=prod.domain
CONTROL_FILES = ( "C:\oracle\product\10.2.0\oradata\prod\control01.ctl", "C:\oracle\product\10.2.0\oradata\prod\control02.ctl", "C:\oracle\product\10.2.0\oradata\prod\control03.ctl")
Parameter CONTROL_FILES
lists database control files. You do not have control files on your file system at this point, because control files are created when you run the CREATE DATABASE
statement. Ensure that you specify the complete path and filename, including drive letter.
BACKGROUND_DUMP_DEST = C:\oracle\product\10.2.0\admin\prod\bdump
USER_DUMP_DEST = C:\oracle\product\10.2.0\admin\prod\udump
DB_FILES=100
Modifying initialization parameter DB_FILES
is not required, but it is recommended to optimize performance. Set this parameter to the same number as the value of the MAXDATAFILES
option of the CREATE DATABASE
statement. The value of 100
is used for this example.
See Also: Oracle Database Reference for information about other initialization parameters that you can add or modify |
Start an instance without mounting a database.
You are not required to specify the PFILE
clause in this example, because the initialization parameter file is stored in the default location. At this point, there is no database. Only the SGA is created and background processes are started in preparation for the creation of a new database.
You are required to create and start an Oracle Database service only if you do one of the following:
Before you create the database, first create a Windows service to run the database. This service is the Oracle Database process, oracle.exe
, installed in the form of a Windows service.
Use ORADIM to create the service. After it has been created, the service starts automatically. See "Using ORADIM to Administer an Oracle Database Instance" for information about how to use ORADIM.
To create and start an Oracle Database service:
Note that the previously created initialization parameter file is specified, with complete path, including drive name. You can check if the service is started in the Services window of the Control Panel.
ORACLE_SID
to equal prod
. Note that there are no spaces around the equal sign (=) character: The CREATE DATABASE
statement is a SQL statement that creates the database. A script containing this statement can be used anytime you create a database.
The CREATE DATABASE
statement may have the following parameters:
MAXDATAFILES
- default value: 32, maximum value: 65534 MAXLOGFILES
- default value: 32, maximum value: 255 When you run a CREATE DATABASE
statement, Oracle Database performs several operations depending upon clauses that you specified in the CREATE DATABASE
statement or initialization parameters that you have set.
Note: Oracle-managed files is a feature that works with theCREATE DATABASE statement to simplify administration of Oracle Database. Oracle-managed files eliminates the requirement to directly manage operating system files comprising an Oracle Database server, because you specify operations in terms of database objects rather than filenames. For more information about using Oracle-managed files see Oracle Database Administrator's Guide. |
To create database prod
, copy and save the following statement in a file named script_name
.sql
:
To use the SQL script to create a database:
OracleServicePROD
, and its status column must display Started. If not, then select the service name and choose Start. You can also check the status of the service by entering the following at the command prompt:
A list of all Windows services currently running on the system appears. If OracleServicePROD
is missing from the list, then enter:
PROD
the current SID
: ORACLE_BASE
\
ORACLE_HOME
\bin
to your PATH
environment variable: Start SQL*Plus from the command prompt, and connect to the database as SYSDBA:
The message connected
appears.
script_name
.sql
that you created in "Putting the CREATE DATABASE Statement in a Script": If the database is successfully created, then the instance is started and the following message appears numerous times: Statement
processed
You can use Data Pump Import (for Oracle Database 10g Release 1 (10.1) or later data) or Import (for earlier data) to import the full export created in "Exporting an Existing Database" into the new database. Although you can start Data Pump Import or Import using either parameter mode or interactive mode, Oracle recommends parameter mode because it provides more functionality. Interactive mode exists solely for backward compatibility.
The syntax for Data Pump Import parameter mode is:
The syntax for Data Pump Import interactive mode is:
Enter only impdp
SYSTEM/
password
to begin an interactive session and let Data Pump Import prompt you for information it needs.
Note: If you use parameter mode, then Data Pump Import considers filenames and directory names to be invalid if they contain one or more blank spaces. The workaround is to enclose the full path in theDUMPFILE= parameter in triple quotation marks. For example:
If you use Data Pump Import in interactive mode, then the filename or directory name can contain a space without quotation marks. |
The syntax for Import parameter mode is:
The syntax for Import interactive mode is:
Enter only imp
SYSTEM/
password
to begin an interactive session and let Import prompt you for information it needs.
Note: If you use parameter mode, then Import considers filenames and directory names to be invalid if they contain one or more blank spaces. The workaround is to enclose the full path in theFILE= parameter in triple quotation marks. For example: FILE="""C:\program files\export.dmp""" If you use Import in interactive mode, then the filename or directory name can contain a space without quotation marks. |
Note: If the original database from which the export file was generated contains a tablespace that is not in the new database, then Import tries to create that tablespace with associated datafiles.The easy solution is to ensure that both databases contain the same tablespaces. Datafiles are not required to be identical. Only tablespace names are important. |
If this is the first database on the system or if you intend to make the new database the default database, then you must make a change in the registry.
The Registry Editor window appears.
\HKEY_LOCAL_MACHINE\SOFTWARE\ORACLE\HOME0
for the first Oracle home on your computer. For subsequent installations to different Oracle homes on the same computer, the path is \HKEY_LOCAL_MACHINE\SOFTWARE\ORACLE\HOME
ID
where ID is the unique number identifying the Oracle home. See Also: Chapter 14, "Configuration Parameters and the Registry" for more information about subkey locations for multiple Oracle homes |
ORACLE_SID
on the right side of the Registry Editor window. prod
in this example. If you do not yet have parameter ORACLE_SID
, because this is the first database on your system, then you must create it.
To create parameter ORACLE_SID
:
The Add Value dialog appears:
ORACLE_SID
in the Value Name field. A string editor dialog appropriate for the data type appears:
Registry Editor adds parameter ORACLE_SID
.
Registry Editor exits.
Caution: If anything goes wrong while operating the new database without a backup, then you must repeat the database creation procedure. Back up your database now to prevent loss of data. |
To back up the new database:
Caution: Although ORADIM returns the prompt immediately, you must wait for the database and the service to stop completely before continuing to Step 2. Wait until the Control Panel indicates serviceOracleServicePROD has stopped. If you do not do this, then the backup may be useless because it was taken while data was being written to datafiles. |
Database files consist of the initialization parameter file, control files, online redo log files, and datafiles.
When the backup is complete, you can start the database again, create users and objects, if necessary, make any other changes, and use the database.
Be sure to back up the database after making any significant changes, such as switching archiving mode or adding a tablespace or datafile.
Caution: Do not store database files on a compressed drive. This can result in write errors and decreased performance. |
ORADIM is a command-line tool that is available with Oracle Database. You are required to use ORADIM only if you are manually creating, deleting, or modifying databases. Database Configuration Assistant is an easier tool to use for this purpose.
The following sections describe ORADIM commands and parameters. Note that each command is preceded by a dash (-
). To get a list of ORADIM parameters, enter:
Note:
|
When you use ORADIM, a log file called oradim.log
opens in ORACLE_BASE
\
ORACLE_HOME
\database
, or in the directory specified by registry parameter ORA_CWD
. All operations, whether successful or failed, are logged in this file. You must check this file to verify success of an operation.
If you have installed an Oracle Database service on Windows 2000, then when logging in as SYSTEM user (LocalSystem), with startup mode set to Automatic, it is possible that the Oracle Database service starts but the database does not start automatically. The following error message is written to file ORADIM.LOG
in directory ORACLE_BASE
\
ORACLE_HOME
\database
:
Oracle Enterprise Management Agent, Oracle Enterprise Manager Management Server and Oracle Internet Directory may also fail, because they cannot connect to the database for the same reason. The workarounds are:
SQLNET.ORA
You can modify SQLNET.ORA
, either by removing the line
or by changing it to
You can start the database manually after the Oracle Database service has started, using SQL*Plus and connecting as SYSDBA
.
See Also: Your operating system documentation for instructions on starting services |
To use ORADIM to create an instance, enter:
where
-NEW
indicates that you are creating a new instance. This is a mandatory parameter. -SID
SID
is the name of the instance to create. -SRVC
service_name
is the name of the service to create (OracleService
SID
). -ASMSID
SID
is the name of the Automatic Storage Management (ASM) instance to create. -ASMSRVC
service_name
is the name of the ASM service to create. -STARTMODE
auto
| manual
indicates whether to start the instance when the Oracle Database service is started. Default is manual
. -SRVCSTART system | demand
indicates whether to start the Oracle Database service on computer restart. -PFILE
filename
is the initialization parameter file to be used with this instance. Ensure that you specify the complete path name of this file, including drive letter. -SPFILE
indicates that a server parameter file (SPFILE) be used during startup instead of a PFILE. -TIMEOUT
secs
sets the maximum time to wait (in seconds) before the service for a particular SID
stops. To create an instance called PROD
, for example, you can enter:
To use ORADIM to start an instance and services, enter
where
-STARTUP
indicates that you are starting an instance that exists. This is a mandatory parameter. -SID
SID
is the name of the instance to start. -ASMSID
SID
is the name of the ASM instance to start. -STARTTYPE
srvc
, inst
indicates whether to start the service or the instance. One or both values can be specified. If it is not specified, then the registry is checked for the current setting. -STARTTYPE srvc
is equivalent to running net start oracleservice<sid>
from the command line.
-STARTTYPE inst
is equivalent of running startup
within SQL*Plus.
-PFILE
filename
is the initialization parameter file to be used with this instance. Ensure that you specify the complete path name of this file, including drive letter. -SPFILE
indicates that a server parameter file (SPFILE) be used during startup instead of a PFILE. To start an instance called puma
, for example, you can enter:
The Enterprise Database Control service (OracleDBConsole
SID
) is dependent on the Oracle Database service (OracleService
SID
). You must stop the dependent Enterprise Database Control service (if installed) before running ORADIM
to stop the database instance service.
To use ORADIM to stop an instance, enter:
where
-SHUTDOWN
indicates that you are stopping an instance. This is a mandatory parameter. -SID
SID
specifies the name of the instance to stop. -ASMSID
SID
is the name of the ASM instance to stop. -SHUTTYPE
srvc
, inst
indicates whether to stop the service or the instance. One or both values can be specified. If it is not specified, then the registry is checked for the current setting. -SHUTMODE
specifies how to stop an instance. This is an optional parameter. If you do not specify how to stop an instance, then normal
is the default mode. To stop an instance called puma
, for example, you can enter:
You can edit an existing instance to change such values as instance name, startup mode, shutdown mode, and shutdown type. To use ORADIM to modify an instance, enter:
where
-EDIT
indicates that you are modifying an instance. This is a mandatory parameter. -SID
SID
specifies the name of the instance to modify. This is a mandatory parameter. -ASMSID
SID
is the name of the ASM instance to modify. -STARTMODE
indicates whether to start the instance when the Oracle Database service is started. Default is manual
. -SRVCSTART system | demand
indicates whether to start the Oracle Database service on computer restart. -PFILE
filename
specifies the initialization parameter file to be used with this instance. Ensure that you specify the complete path name of this file, including drive letter. -SPFILE
indicates that a server parameter file (SPFILE) be used during startup instead of a PFILE. -SHUTMODE
specifies how to stop an instance. This is an optional parameter. If you do not specify how to stop an instance, then normal
is the default mode. -SHUTTYPE
indicates whether to stop the service or the instance. One or both values can be specified. If it is not specified, then the registry is checked for the current setting. To specify a new initialization parameter file for the instance prod
, for example, you can enter:
The Enterprise Database Control service (OracleDBConsole
SID
) is dependent on the Oracle Database service (OracleService
SID
). You must stop the dependent Enterprise Database Control service (if installed) before running ORADIM
to delete the database instance.
To use ORADIM to delete an instance, enter:
where
-DELETE
indicates that you are deleting an instance or service. This is a mandatory parameter. -SID
SID
specifies the name of the SID to delete. -SRVC
service_name
specifies the name of the service to delete. -ASMSID
SID
is the name of the ASM instance to delete. -ASMSRVC
service_name
is the name of the ASM service to delete. To delete an instance called prod
, for example, you can enter:
This section contains these topics:
To back up a 32-bit Oracle home database:
SYSDBA
: .trc
file to use as a template to re-create the control files on the 64-bit computer: To migrate an Oracle Database 10g Release 2 (10.2) database for 32-bit Windows to an Oracle Database 10g Release 2 (10.2) database for 64-bit Windows:
The following table provides more information about the values you must supply.
Parameter | Description |
---|---|
SID | SID of the database you are upgrading |
PASSWORD | Password for the new Oracle Database 10g Release 2 (10.2) for 64-bit Windows database. This is the password for the user connected with SYSDBA privileges. The -INTPWD option is not required. If you do not specify it, then operating system authentication is used, and no password is required. |
USERS | Maximum number of users who can be granted SYSDBA and SYSOPER privileges |
ORACLE_HOME | Oracle home directory. Ensure that you specify the full path name with the -PFILE option, including drive letter of the Oracle home directory. |
IFILE
(include file) entry, then copy the file specified by the IFILE
entry to the 64-bit Oracle home and edit the IFILE
entry in the initialization parameter file to point to its new location. ORACLE_BASE
\
ORACLE_HOME
\database\pwd
SID
.ora
., where SID
is your Oracle instance ID. _SYSTEM_TRIG_ENABLED = false
parameter to the ORACLE_HOME
\database\ORACLE_
SID
\init.ora
file before changing the word size. ORACLE_HOME
\rdbms\admin
directory from the command prompt. SYSDBA
: CREATE CONTROLFILE
command. Edit the trace file created in "Backing Up a 32-Bit Oracle Database" to change the paths to the datafiles, log files and control files to point to the Oracle home on the 64-bit computer. This creates the new control file in ORACLE_HOME
\database
. Here is an example of a database named "orcl32" on a 32-bit computer migrating to "orcl64" on a 64-bit computer:
init
file from the 32-bit computer to include the new control file generated in the preceding step. UPGRADE
mode to run utlirp.sql
: You might need to use the PFILE
option to specify the location of your initialization parameter file.
To migrate an Oracle Database 10g Release 1 (10.1) or older database to an Oracle Database 10g Release 2 (10.2) database for 64-bit Windows:
This chapter describes configuration tasks you can perform to increase security and other configuration tasks you must perform before using Oracle interMedia and other Oracle options. Where appropriate, the chapter provides references to other guides for those configuration tasks.
This chapter contains these topics:
Note: Directory path examples in this chapter follow Optimal Flexible Architecture (OFA) guidelines. If you specified non-OFA compliant directories during installation, then your directory paths will differ. See Appendix B, "Optimal Flexible Architecture", in Oracle Database Installation Guide for Microsoft Windows x64 for more information. |
By default, all installations of Windows XP Service Pack 2 and higher enable the Windows Firewall to block virtually all TCP network ports to incoming connections. This is also true for Windows Server 2003 Service Pack 1, Windows Vista, Windows Server 2008, and Windows Server 2008 R2. Consequently, any Oracle products that listen for incoming connections on a TCP port will not receive any of those connection requests, and the clients making those connections will report errors.
Depending upon which Oracle products are installed and how they are used, some postinstallation configuration of the Windows Firewall might be required for the products to be functional on these operating systems.
This section contains these topics:
Table 4-1 lists the Oracle Database 10g Release 1 (10.1) or later executables that listen on TCP ports on Windows. If they are in use and accepting connections from a remote client computer, then Oracle recommends that you add them to the Windows Firewall exceptions list to ensure correct operation. Except as noted, they can be found in ORACLE_HOME
\bin
.
The RMI registry application and daemon executable listed in Table 4-1 are used by Oracle Ultra Search to launch a remote crawler. They must be added to the Windows Firewall exception list if you are using the Ultra Search remote crawler feature, and if the remote crawler is running on a computer with the Windows Firewall enabled.
Note: If multiple Oracle homes are in use, then several firewall exceptions may be needed for the same executable: one for each home from which that executable loads. |
See Also: Oracle Database Oracle Clusterware and Oracle Real Application Clusters Installation Guide for Microsoft Windows for more information about Oracle RAC executables requiring Windows Firewall exceptions |
Table 4-1 Oracle Executables Requiring Windows Firewall Exceptions
File Name | Executable Name |
---|---|
| Oracle Database |
| Oracle TNS Listener |
| Oracle Database Control |
| Java Virtual Machine |
| Apache Web Server |
| Oracle Process Manager |
| RMI registry application |
| RMI daemon executable |
| Data Guard Manager |
| Oracle Services for Microsoft Transaction Server |
| Oracle Transparent Gateway for SYBASE |
| Oracle Transparent Gateway for Teradata |
| Oracle Transparent Gateway for MS-SQL Server |
| Oracle Transparent Gateway for DRDA |
| Oracle Procedural Gateway for APPC |
| Oracle Procedural Gateway for APPC |
| Oracle Procedural Gateway for Websphere MQ |
| Oracle Procedural Gateway for Websphere MQ |
| Generic Connectivity |
| External Procedures |
| Oracle Internet Directory LDAP Server |
Postinstallation configuration for the Windows Firewall must be undertaken if all of the following conditions are met:
These components include the Oracle Database, network listeners, and any Web servers or services.
If no other computers connect to the computer with the Oracle software, then no postinstallation configuration steps are required and the Oracle software will function as expected.
If the Windows Firewall is not enabled, then no postinstallation configuration steps are required.
You can configure Windows Firewall by opening specific static TCP ports in the firewall or by creating exceptions for specific executables so that they are able to receive connection requests on any ports they choose. To configure the firewall, choose Control Panel > Windows Firewall > Exceptions or enter netsh firewall add...
at the command line.
Alternatively, Windows will inform you if a foreground application is attempting to listen on a port, and it will ask you if you want to create an exception for that executable. If you choose to do so, then the effect equals creating an exception for the executable either in the Control Panel or from the command line.
If you cannot establish certain connections even after granting exceptions to the executables listed in Table 4-1, then follow these steps to troubleshoot the installation:
*.conf
files), the Oracle key in the Windows registry, and network configuration files in ORACLE_HOME
\network\admin
. ORACLE_HOME
\network\admin\listener.ora
in a PROGRAM=
clause. Each of these must be granted an exception in the Windows Firewall, because a connection can be made through the TNS Listener to that executable. netsh firewall show state verbose=enable
to Oracle Support for diagnosis and problem resolution. See Also:
|
Oracle Database installs with a number of default accounts. Database Configuration Assistant locks and expires most default database accounts upon successful installation. Oracle recommends changing all user passwords immediately after installation.
See Also: Oracle Database Administrator's Guide for more information about default database accounts and passwords |
Oracle recommends that you configure Oracle Database files, directories, and registry settings to allow only authorized database administrators (DBAs) to have full control. If you created a database using Database Configuration Assistant, then no further action is required.
This section describes the permissions automatically set by Oracle Universal Installer and Database Configuration Assistant and the steps to set these permissions manually.
This section contains these topics:
See Also: Your operating system documentation for more information about modifying NTFS file system and Windows registry settings |
Beginning with Oracle9i release 2 (9.2), Oracle Universal Installer and Database Configuration Assistant set file permissions when Oracle Database software is installed.
This section contains these topics:
During Oracle Database installation, by default Oracle Universal Installer installs software in ORACLE_BASE
\
ORACLE_HOME
. Oracle Universal Installer sets the following permissions to this directory, and all files and directories under this directory:
Administrators
- Full Control System
- Full Control Authenticated Users
- Read, Execute and List Contents Important: If these accounts exist and possess more restrictive permissions, then the most restrictive permissions are retained. If accounts other thanAdministrators , System , and Authenticated Users exist, then the permissions for these accounts are removed. |
During database configuration, Database Configuration Assistant installs files and directories in the following default locations, where database_name
is the database name or SID:
ORACLE_BASE
\admin\
database_name
(administration file directories) ORACLE_BASE
\oradata\
database_name
(database file directories) ORACLE_BASE
\oradata\
database_name
(redo log files and control files) ORACLE_BASE
\
ORACLE_HOME
\database
(SPFILE
SID
.ORA
) Database Configuration Assistant sets the following permissions to these directories, and all files and directories under these directories:
Administrators
- Full Control System
- Full Control Important: If these accounts exist and possess more restrictive permissions, then the most restrictive permissions are retained. If accounts other thanAdministrators and System exist, then the permissions for these accounts are removed. |
To ensure that only authorized users have full file system permissions:
Directory | Group and Permissions |
---|---|
ORACLE_BASE \ ORACLE_HOME |
|
ORACLE_BASE \admin\ database_name |
|
ORACLE_BASE \oradata\ database_name |
|
ORACLE_BASE \ ORACLE_HOME \database\spfile SID .ora |
|
Note: Oracle Database uses the Windows LocalSystem built-in security account. Therefore, file permissions must be granted to theSystem account of the local computer running Oracle Database. |
See Also: Your operating system online help for more information about how to modify NTFS file system and registry settings |
Oracle recommends that you remove write permissions from users who are not Oracle Database DBAs or system administrators in HKEY_LOCAL_MACHINE\SOFTWARE\ORACLE
of the Windows registry.
To remove write permissions:
HKEY_LOCAL_MACHINE\SOFTWARE\ORACLE
. The Registry Key Permissions dialog appears.
SYSTEM
account must have Full Control, since this is the account with which Oracle Database runs. This release includes a new database scheduler to provide enterprise scheduling functionality. External jobs performed by the user are started using the OracleJobScheduler
service. This service is disabled by default. In order to use the external jobs functionality, the administrator must set the username and password for the user account under which this service must run and enable the service.
Restricting execution of external jobs to a low-privileged user prevents unauthorized database users from gaining operating system level privileges, but it also places restrictions on the kinds of jobs that can be run. Jobs requiring a higher level of operating system privileges cannot be run by this mechanism.
Performance related components of Oracle interMedia are now packaged on the Companion CD. Although interMedia functions properly without the Companion CD, the following components must be installed from the Companion CD in order to achieve acceptable performance of image processing:
Oracle interMedia includes the following components.
Client
Oracle interMedia Client provides an Oracle Database interMedia Audio, Image, and Video Java interface that lets you use local (client-side) applications to manipulate or modify multimedia data stored in a network-accessible (server-side) database. To use the Java library, set environment variable CLASSPATH
so that it contains the Oracle interMedia library.
Client also provides a simple interMedia Image sample (SimpImg.exe
) that was developed using Microsoft Visual C++. SimpImg.exe
locates and updates images, using interMedia Image in Oracle Database.
Audio
Oracle interMedia Audio manages audio data in multiple file formats in Oracle Database. Types of audio data supported include conversations, songs, and other sounds in popular audio file formats. This makes it possible to integrate audio data with other application-specific object-relational data.
Video
Oracle interMedia Video manages video data in multiple video file formats. This makes it possible to integrate video data with other application-specific object-relational data.
Image
Oracle interMedia Image provides image storage, retrieval, and format conversion capabilities through an object data type (ODT). It also supports image storage, using Binary Large Objects (BLOBs), and references to image data residing in external files (BFILEs).
The Image component of Oracle interMedia also comes with a sample demonstration that shows how an image is extracted from Oracle Database.
Locator
Oracle interMedia Locator enables Oracle Database to support online internet-based geocoding facilities for locator applications and proximity queries.
If you upgrade from an earlier Oracle release to the current release, Oracle interMedia will be upgraded automatically if it is detected. If for some reason you want to upgrade interMedia manually, follow this procedure:
SYSDBA
: imdbma.sql
: NOT_INSTALLED
, then no prior release of Oracle interMedia was installed on your computer. You must install rather than upgrade Oracle interMedia. INSTALLED
, then the current Oracle interMedia release is installed on your computer. u0
nnnnn
0.sql
, then Oracle interMedia release nnnnn is currently installed. For example, u0800060.sql
means that Oracle Image Cartridge release 8.0.6.0.0 is currently installed. If you install Enterprise Edition, then Database Configuration Assistant starts automatically after installation. If you choose any Database Configuration Assistant installation type other than Customized, then interMedia does not require manual configuration. All tasks described in this section are performed automatically.
If you select Customized installation, then Database Configuration Assistant will guide you through configuration of Oracle interMedia.
If you are creating and configuring a database manually, then you can configure Oracle interMedia Audio, Video, Image, and Locator as follows:
SYSDBA
: ordinst.sql
: iminst.sql
: Note: If you manually copy your Oracle8ilistener.ora and tnsnames.ora files into your Oracle Database network directory, then you must modify network configuration files tnsnames.ora and listener.ora on your server to enable external routine calls to work and interMedia to function properly. Follow the procedure in Oracle Database Net Services Administrator's Guide. |
To configure Oracle interMedia Audio, Video, and Image demos, follow instructions in readme.txt
files at locations shown in Table 4-2.
Table 4-2 interMedia Demo Instructions
Demo | File Location |
---|---|
Audio |
|
Video |
|
Image |
|
Note: Thesereadme.txt files contain UNIX line breaks. If you simply double-click them, they will open in Notepad by default, and Notepad does not recognize UNIX line breaks. Use write.exe or edit.com instead. |
Directory \img\demo
also contains demo_ordimg.mk
, the makefile to make interMedia Image demos for a Microsoft C compiler. But before you can build and run the demonstration, you must first modify it to adapt it to your environment.
To configure Oracle interMedia Locator demonstrations, go to the following directory:
Sample data that can be loaded into Oracle Database is in nh_cs.sql
. Examples that show use of Locator functionality are in geohttp.sql
and geolocate.sql
. Examples of data indexes created by using Locator are in geoindex.sql
.
Oracle Text enables text queries through SQL and PL/SQL from most Oracle interfaces. By installing Oracle Text with an Oracle Database server, client tools such as SQL*Plus and Pro*C/C++ are able to retrieve and manipulate text in Oracle Database.
Oracle Text manages textual data in concert with traditional data types in Oracle Database. When text is inserted, updated, or deleted, Oracle Text automatically manages the change.
Your Oracle Text postinstallation tasks depend on your situation.
If you install Oracle Text from the CD-ROM and have a previous release of Oracle Text (formerly called interMedia Text) installed, then see Oracle Text Application Developer's Guide.
If you upgrade your database, then you may be required to configure Oracle Net for external procedures. Otherwise, Oracle Text may not work. In any case other than upgrade, Oracle Net will be configured correctly by default to work with Oracle Text. See Oracle Text Application Developer's Guide and Oracle Text Reference.
If you are indexing formatted documents such as Microsoft Word, then you must set your environment to use the Inso filter before you can index your documentation set. For more information about setting up your environment for Inso filtering, see Oracle Text Reference.
Note: The Inso filter is not supported on Windows XP 64-bit Edition Version 2003 or Windows Server 2003 Datacenter Edition for 64-bit Itanium 2 Systems. |
Finally, if you install Oracle Text from the CD-ROM and do not have a previous release of Oracle Text installed, then Oracle Database is configured for use with Oracle Text if one of the following is true:
See Also: For more information about creating a starter database |
If none of these is true, then you must configure Oracle Database for use with Oracle Text by using Configuring Oracle Text Using Database Configuration Assistant.
Configuring Oracle Text Using Database Configuration Assistant
To use Database Configuration Assistant to configure Oracle Database for use with Oracle Text at the time you create the database, simply select Oracle Text as the option to configure when prompted.
To configure the database at a later time:
Choose Start > Programs > Oracle - HOME_NAME > Configuration and Migration Tools > Database Configuration Assistant.
Oracle Spatial makes storage, retrieval, and manipulation of spatial data easier and more intuitive to users.
One example of spatial data is a road map. A road map is a two-dimensional object that contains points, lines, and polygons representing cities, roads, and political boundaries such as states. A road map represents geographic information. Locations of cities, roads, and political boundaries are projected onto a two-dimensional display or piece of paper, preserving relative positions and relative distances of objects.
If you install Oracle Spatial through Enterprise Edition, then no manual configuration is required. All Oracle Spatial configuration tasks are performed automatically.
If you install both Oracle Spatial and Oracle Database together through Enterprise Edition or Standard Edition Custom installation, then Database Configuration Assistant starts automatically after installation. If you choose Custom installation and select Create new database, then the assistant asks if Oracle Spatial is to be configured automatically.
If you install Oracle Spatial during a separate installation from Enterprise Edition, then you must either start Database Configuration Assistant and select Configure database options in a database or configure Oracle Spatial manually.
To configure Oracle Spatial manually:
SYSDBA
: ordinst.sql
: Connect to the database as user SYSTEM:
mdinst.sql
: Note: Scriptmdinst.sql has a variable %MD_SYS_PASSWORD% that Oracle Universal Installer will instantiate at installation time. Therefore, if you have changed the mdsys user's password, then be sure during a manual installation to remember also to update script mdinst.sql with that password. |
Oracle Database installs replication packages and procedures automatically rather than as a separate manual process. There are many configuration and usage possibilities with Advanced Replication.
This section describes how to manually configure Advanced Replication in Oracle Database. Follow the instructions only if you add Advanced Replication to an installation of Oracle Database that was not previously configured with this feature.
See Also: Oracle Database Advanced Replication for more information about Advanced Replication and for definitions of master sites and materialized view sites |
Configuring Advanced Replication consists of the following steps:
Recommended tablespace and rollback segment requirements for Advanced Replication are shown in Table 4-3.
Table 4-3 Advanced Replication Tablespace/Rollback Segment Requirements
Tablespace/Rollback Segment | Minimum Free Space |
---|---|
SYSTEMFoot 1 | 20 MB |
UNDO TABLESPACE | 10 MB |
RBS | 5 MB |
TEMP | 10 MB |
USERS | No specific requirement |
Footnote 1 Replication triggers and procedures are stored here.
If you use Advanced Replication, then certain parameter values must be added to the initialization parameter file, and others must be set to recommended values. Parameter names and values for the master site and materialized view sites are shown in Table 4-4.
Table 4-4 Advanced Replication Initialization Parameters
Parameter Name | Recommended Value | Site |
---|---|---|
| 50 MB | master |
| 300 seconds | master |
| TRUE | master |
| 4 | master |
| Add 9 to current value | master |
| 2Foot 1 | master |
| 2 | materialized view |
Footnote 1 Depends on number of n-way sites.
If you use Advanced Replication and intend to set up a large number of replicated objects, then you are required to monitor the following data dictionary tables with the SQL SELECT
command:
ARGUMENT$
IDL_CHAR$
IDL_UB1$
IDL_UB2$
IDL_SB4$
I_ARGUMENT1
I_SOURCE1I$
SOURCE$
TRIGGER
If necessary, increase storage parameters to accommodate storage requirements of large numbers of replicated objects.
This chapter describes how to administer Oracle Database for Windows.
This chapter contains these topics:
This section tells you how to manage the services that Oracle Database installs on your computer.
This section provides information about the following:
Oracle Database for Windows lets you have multiple Oracle homes on a single computer. This feature, described in Appendix B, "Optimal Flexible Architecture", in Oracle Database Installation Guide for Microsoft Windows x64, affects Oracle services naming conventions. As you perform installations into Oracle home directories:
Oracle Database services must be started for you to use Oracle Database and its products. You can start Oracle Database services from three different locations:
Note: You can start Oracle Database when you startOracleService SID . See "Starting and Shutting Down a Database Using Services" for information about registry parameters that enable you to do this. |
Control Panel
To start Oracle Database services from the Control Panel:
See Also: Your operating system documentation for instructions |
If you cannot find OracleService
SID
in the list, then use ORADIM to create it.
Command Prompt
To start Oracle Database services from the command prompt, enter:
where service
is a specific service name, such as OracleServiceORCL.
Oracle Administration Assistant for Windows
To start Oracle Database services from Oracle Administration Assistant for Windows:
>
Programs >
Oracle - HOME_NAME >
Configuration and Migration Tools > Administration Assistant for Windows SID
. where SID
is a specific instance name, such as orcl
.
This starts service OracleServiceORCL
.
On occasion (for example, when re-installing Oracle Database), you must stop Oracle Database services. You can stop Oracle Database services from three different locations:
Note: You can stop Oracle Database in normal, immediate, or abort mode when you stopOracleService SID . See "Starting and Shutting Down a Database Using Services" for information about registry parameters that enable you to do this. |
Control Panel
To stop Oracle Database services from the Control Panel:
See Also: Your operating system documentation for instructions |
Oracle
HOME_NAME
TNSListener
and click Stop. Oracle
HOME_NAME
TNSListener
is stopped.
OracleService
SID
and click Stop. OracleService
SID
is stopped.
Command Prompt
To stop Oracle Database services from the command prompt, enter:
where service
is a specific service name, such as OracleServiceORCL
.
Oracle Administration Assistant for Windows
To stop Oracle Database services from Oracle Administration Assistant for Windows:
>
Programs > Oracle - HOME_NAME >
Configuration and Migration Tools >
Administration Assistant for Windows. where SID
is a specific instance name, such as orcl
.
This stops service OracleServiceORCL.
Oracle Database services can be set to start automatically whenever the Windows computer is restarted. You can turn auto-start on or off from two different locations:
Control Panel
To use the Control Panel to configure when and how Oracle Database is started:
See Also: Your operating system documentation for instructions |
Oracle Administration Assistant for Windows
To automatically start Oracle Database services from Oracle Administration Assistant for Windows:
>
Programs >
Oracle - HOME_NAME >
Configuration and Migration Tools >
Administration Assistant for Windows. where SID
is a specific instance name, such as orcl
.
These instructions assume that a database instance has been created.
Note: Directory path examples in this chapter follow Optimal Flexible Architecture (OFA) guidelines. If you specified non-OFA compliant directories during installation, then your directory paths will differ. See Appendix B, "Optimal Flexible Architecture", in Oracle Database Installation Guide for Microsoft Windows x64 for more information. |
To start or shut down Oracle Database:
This command uses the initialization parameter file specified in path
\
filename
. To start a database using a file named init2.ora
located in
you would enter:
If no PFILE
is specified, then the command looks for an SPFILE
in ORACLE_HOME
\database
. If the command finds one, then the command uses it to start the database. If it does not find an SPFILE
, then it uses the default initialization parameter file located in ORACLE_BASE
\ADMIN\db_name\pfile
.
where mode is normal
, immediate
, or abort
.
In a normal
shutdown, Oracle Database waits for all currently-connected users to disconnect and disallows any new connections before shutting down. This is the default mode.
In an immediate
shutdown, Oracle Database terminates and rolls back active transactions, disconnects clients, and shuts down.
In an abort
shutdown, Oracle Database terminates active transactions and disconnects users; it does not roll back transactions. The database performs automatic recovery and rollback the next time it is started. Use this mode only in emergencies.
See Also: Chapter 2, "Database Tools on Windows" for a list of other tools that can start Oracle Database and this guide for information about options you can specify when starting your database. |
You can start or shut down Oracle Database by starting or stopping service OracleService
SID
in the Control Panel. Starting OracleService
SID
is equivalent to using the STARTUP
command or manually entering:
Stopping OracleService
SID
is equivalent to using the SHUTDOWN
command or manually entering:
You can enable starting and stopping Oracle Database through OracleService
SID
two different ways:
Oracle Administration Assistant for Windows
To start or stop a database using Oracle Database services from Oracle Administration Assistant for Windows:
>
Programs >
Oracle - HOME_NAME >
Configuration and Migration Tools >
Administration Assistant for Windows. where SID
is a specific instance name, such as ORCL
.
Setting Registry Parameters
To start or stop Oracle Database through Oracle Database Services, set the following registry parameters to the indicated values:
ORA_
SID
_AUTOSTART
When set to true
, the default value, this parameter causes Oracle Database to start when OracleService
SID
is started.
ORA_
SID
_PFILE
This parameter sets the full path to the initialization parameter file. If this entry is not present, then oradim will try to start the database with an SPFILE
or PFILE
from ORACLE_HOME
\database
.
ORA_SHUTDOWN
When set to true
, this parameter enables the selected instance of Oracle Database to be shut down when OracleService
SID
is stopped. This includes any database in the current Oracle home. Default value is false
.
ORA_
SID
_SHUTDOWN
When set to true
, the default value, this parameter causes the instance of Oracle Database identified by the SID
value to shut down when OracleService
SID
is stopped manually—using either the Control Panel or Net stop command.
Caution: IfORA_SHUTDOWN or ORA_SID_SHUTDOWN is set to false , then manually shutting down OracleServiceSID will still shut down Oracle Database. But it will be an abnormal shutdown, and Oracle does not recommend it. |
The following two registry parameters are optional:
ORA_
SID
_SHUTDOWNTYPE
This parameter controls database shutdown mode. Set it to a
(abort
), i
(immediate
), or n
(normal
). Default mode is i
(immediate
) if you do not set this parameter.
ORA_
SID
_SHUTDOWN_TIMEOUT
This parameter sets maximum time to wait before the service for a particular SID
stops.
The registry location of these required and optional parameters is determined by the number of Oracle home directories on your computer. If you have only one Oracle home directory, then these parameters belong in:
If you have multiple Oracle home directories, then these parameters belong in:
where ID
is incremented for each additional Oracle home directory on your computer.
Note: If you use ORADIM to create or edit instances, then it automatically sets the relevant registry parameters to their appropriate values. |
See Also: Chapter 14, "Configuration Parameters and the Registry" for instructions on adding and editing registry parameters |
Starting or Stopping OracleServiceSID from the Control Panel
This automatically starts ORADIM and issues the -STARTUP
command using the initialization parameter file identified by ORA_
SID
_PFILE
.
This automatically starts ORADIM, which issues the -SHUTDOWN
command in the mode indicated by ORA_
SID
_SHUTDOWNTYPE
, and shuts down Oracle Database.
See Also: Your operating system documentation for instructions on starting and stopping services. |
ORACLE_SID
configuration parameter to the SID
for the first instance to run: where SID
is the name of the Oracle Database instance.
AS
SYSDBA
: where ORACLE_BASE
is c:\oracle\product\10.2.0
(unless you changed it during installation) and db_name
is the name of the instance.
Use Password Utility to create password files. Password Utility is automatically installed with Oracle Database utilities. Password files are located in directory ORACLE_BASE
\
ORACLE_HOME
\DATABASE
and are named PWD
sid
.ORA
, where SID
identifies the Oracle Database instance. Password files can be used for local or remote connections to Oracle Database.
To create and populate a password file:
where
FILE
specifies the password filename. SID
identifies the database instance. PASSWORD
sets the password for account SYS
. ENTRIES
sets maximum number of entries in password file. This corresponds to maximum number of distinct users allowed to connect to the database simultaneously with either the SYSDBA or the SYSOPER DBA privilege. REMOTE_LOGIN_PASSWORDFILE
to exclusive
, shared
, or none
. The value exclusive
specifies that only one instance can use the password file and that the password file contains names other than SYS
. In search of the password file, Oracle Database looks in the registry for the value of parameter ORA_SID_PWFILE
. If no value is specified, then it looks in the registry for the value of parameter ORA_PWFILE
, which points to a file containing usernames, passwords, and privileges. If that is not set, then it uses the default:
The default value is shared
. It specifies that multiple instances (for example, a Real Application Clusters environment) can use the password file. However, the only user recognized by the password file is SYS
. Other users cannot log in with SYSOPER
or SYSDBA
privileges even if those privileges are granted in the password file. The shared
value of this parameter affords backward compatibility with earlier Oracle releases. Oracle Database looks for the same files as it does when the value is exclusive
.
The value none
specifies that Oracle Database ignores the password file and that authentication of privileged users is handled by the Windows operating system.
AS SYSDBA
: SYSDBA
: If the grant is successful, then the following message displays:
This adds scott
to the password file and enables scott
to connect to the database with SYSDBA
privileges. Use SQL*Plus to add or delete usernames, user passwords, and user privileges in password files.
The password file is not automatically hidden. It can be made invisible and visible again from two different locations:
Note: The password file must be visible before it can be moved, copied, or deleted. |
Command Prompt
The password file is displayed as PWD
sid
.ora
:
The password file is now hidden:
Windows Explorer
To make the password file invisible or visible again:
ORACLE_BASE
\
ORACLE_HOME
\database
. The PWD
sid
.ora
Properties dialog opens.
To view or hide an invisible password file:
ORACLE_BASE
\
ORACLE_HOME
\database
. When connecting to the starter database from a remote computer as SYS
, you must use a different password from the one described in Oracle Database Installation Guide for Microsoft Windows x64 when logging on with SYSDBA
privileges. This is because the password file enables database access in this situation and it requires the password oracle
for this purpose.
With Oracle Database, the password used to verify a remote database connection is automatically encrypted. Whenever a user attempts a remote login, Oracle Database encrypts the password before sending it to the remote database. If the connection fails, then the failure is noted in the operating system audit log.
Note: Configuration parameterORA_ENCRYPT_LOGIN is retained for backward compatibility and is set to true by default. See Chapter 14, "Configuration Parameters and the Registry" for instructions on adding and setting configuration parameters in the registry. |
Oracle Database can access database files on a remote computer using Universal Naming Convention (UNC), but it may degrade database performance and network reliability. UNC is a PC format for specifying locations of resources on a local area network. UNC uses the following format:
For example, UNC specification for file system01.dbf
in directory C:\oracle\product\10.2.0\oradata\orcl
on shared server argon
would be:
Locations of archive log files cannot be specified using UNC. Always set initialization parameter LOG_ARCHIVE_DEST_
n
to a mapped drive. If you set it to a UNC specification, then Oracle Database does not start and you receive the following errors:
An ORA-00256 error also occurs if you enter \\\meldell\rmdrive
or \\\meldell\\rmdrive
. Control files required the additional backslashes for Oracle8 release 8.0.4, but redo log files and datafiles did not.
If you installed Oracle Database through the Typical installation, then it is created in NOARCHIVELOG
mode. If you created your database through the Custom option of Database Configuration Assistant, then you had the choice of either ARCHIVELOG
or NOARCHIVELOG
.
In NOARCHIVELOG
mode, redo logs are not archived. Setting your archive mode to ARCHIVELOG
and enabling automatic archiving causes redo log files to be archived. This protects Oracle Database from both instance and disk failure.
This section describes how to change archive mode to ARCHIVELOG
and enable automatic archiving.
See Also: For complete descriptions ofARCHIVELOG and NOARCHIVELOG modes, see "Managing Archived Redo Logs" in Oracle Database Administrator's Guide |
SYSDBA
: The following output indicates the database is not in archive mode:
ARCHIVELOG
: The following output indicates the database is now in archive mode:
ORACLE_BASE
\ADMIN\
db_name
\pfile\init.ora
. Note: TheLOG_ARCHIVE_DEST_n parameter can specify standby destinations that are running Oracle Standard Edition, but only when specifying local destinations with the LOCATION attribute. See "Oracle Software Requirements" in Oracle Data Guard Concepts and Administration for details. |
#
sign from in front of each. Note: Double quotation marks aroundLOG_ARCHIVE_FORMAT |
LOG_ARCHIVE_DEST_
n
value to identify an existing drive and directory in which to archive your filled redo logs. Note: Default size of Redo logs is approximately 100 MB. |
LOG_ARCHIVE_FORMAT
value to indicate the appropriate archiving format: %%
ORACLE_SID
%%%T.ARC
This format specifies the thread number. This number is padded to the left by zeroes. The default value is one with a range of up to three characters. Example: SID0001.ARC
%%
ORACLE_SID
%%%S.ARC
This format specifies the log sequence number. This number is padded to the left by zeroes. The default value is one with a range of up to five characters. Example: SID0001.ARC
%%
ORACLE_SID
%%%t.ARC
This format specifies the thread number. The number is not padded. The default value is one with no range limit on characters. Example: SID1.ARC
%%
ORACLE_SID
%%%s.ARC
This format specifies the log sequence number. The number is not padded. The default value is one with no range limit on characters. Example: SID1.ARC
The following output indicates that automatic archiving of redo log files is enabled and an archiving destination is specified:
This chapter describes how to monitor Oracle Database for Windows.
This chapter contains these topics:
Table 6-1 describes tools that enable you to monitor Oracle Database.
Table 6-1 Database Monitoring Tools
Tool | Functionality |
---|---|
Oracle Counters for Windows Performance Monitor | Monitor database objects, such as CPU usage, buffer cache, or a background process. |
Event Viewer | Monitor database events. |
Trace Files | Record occurrences and exceptions of database operations |
Alert Logs | Record important information about error messages and exceptions during database operations. |
Oracle Enterprise Manager Database Management Packs | Monitor and tune using tools with real-time graphical performance information. See Also: Your Oracle Enterprise Manager documentation set for more information |
Oracle Administration Assistant for Windows | View information about or terminate any Oracle thread. |
Note: A 64-bit version of Oracle Enterprise Manager Grid Control is not available in this release. Oracle Enterprise Manager Grid Control can manage a 64-bit Windows database from a remote Linux or Windows 32-bit computer. |
Oracle Counters for Windows Performance Monitor is a graphical tool for measuring the performance of Oracle Database for Windows objects on a local server or other servers on a network. This tool is the same in appearance and operation as Windows Performance Monitor, except it has been preloaded with Oracle Database performance elements.
On each computer, you can view behavior of objects, such as buffer cache, data dictionary cache, datafiles, threads, and processes. An object is a graphical representation of an element in your system. Every element, resource, and device in your system can be represented as an object.
Note: Before using Oracle Counters for Windows Performance Monitor to view Oracle-specific counters, you must specify theSYSTEM password using operfcfg .exe or Oracle Administration Assistant for Windows. See "Using operfcfg" or "Using Oracle Administration Assistant for Windows" for instructions. |
A set of counters is associated with each object. A counter is a unit of measurement used by Performance Monitor to display activity. The type of activity the counter measures depends on the type of object.
Certain types of objects and their respective counters are present on all systems. Other counters, such as application-specific counters, appear only if the computer is running the associated software.
Each of these objects has an associated set of counters that provide information about device usage, queue lengths, delays, and information used to measure throughput and internal congestion.
When you install Oracle Counters for Windows Performance Monitor, values are automatically set in the registry as described in Chapter 14, "Configuration Parameters and the Registry".
Oracle Counters for Windows Performance Monitor lets you monitor only one database instance at a time. For this reason, the registry contains the following values:
Hostname
Username
Password
Use operfcfg to change these values. Oracle recommends setting the security level on each of these registry values.
See Also: Chapter 14, "Configuration Parameters and the Registry" for instructions on how to use operfcfg |
To use Oracle Counters for Windows Performance Monitor for another database instance on the same computer or a UNIX computer, change the values appropriately in the registry. You can also monitor non-Windows installations of Oracle Database by changing Hostname
registry value so it points to another computer specified in file tnsnames.ora
.
To access Oracle Counters for Windows Performance Monitor:
Choose Start >
Programs >
Oracle - HOME_NAME >
Configuration and Migration Tools >
Oracle Counters for Windows Performance Monitor.
Oracle Counters for Windows Performance Monitor has four views you can choose from the View menu:
See Also: Your operating system documentation for complete information about the four views |
For each view you can decide objects to monitor, what counters to use for each object, and graphical attributes of the view. When an object is chosen, it is assigned a counter, a color, and added to the status bar at the bottom of Oracle Counters for Windows Performance Monitor.
To add objects to a view:
The Add to Chart dialog appears.
If no data or Oracle Database objects appear, then either Oracle Database is not running or an invalid host string or password has been entered. If the database is not started, then exit Oracle Counters for Windows Performance Monitor, start the database, and restart Oracle Counters for Windows Performance Monitor.
The selections you have chosen to monitor are displayed.
All Oracle Database system resources that can be monitored through Oracle Counters for Windows Performance Monitor begin with 'Oracle Database'. This section lists Oracle Database objects and describes their associated counters. These measures are defined in
Note: You can monitor only one instance at a time using Oracle Counters for Windows Performance Monitor on a given computer. |
Oracle Database Buffer Cache
The counter is phyrds/gets %. The percentage of phyrds/gets is calculated as a Miss ratio. The lower the Miss counter, the better. To improve performance, increase the number of buffers in the buffer cache, if memory is available on the computer. This value is not time-derived.
Oracle Database Redo Log Buffer
The counter is redo log space requests. The value of this counter must be near zero. If this value increments consistently, then processes have had to wait for space in the redo log buffer. In this case, it may be necessary to increase the size of the redo log buffer.
Oracle Database Data Dictionary Cache
The counter is getmisses/gets %. The value of this counter must be less than 10 or 15% for frequently accessed data dictionary caches. If the ratio continues to increase over this threshold while your application is running, then increase the amount of memory available to the data dictionary cache.
To increase the memory available to the cache, increase the value of initialization parameter SHARED_POOL_SIZE
. This value is not time-derived.
See Also: Oracle Database Performance Tuning Guide for more detailed information about tuning memory allocation in Oracle Database |
Oracle Database Library Cache
The counter is reloads/pins %. This is the percentage of SQL statements, PL/SQL blocks, and object definitions that required reparsing. Total Reloads must be near zero. If the ratio of Reloads to Pins is greater than 1%, then reduce the library cache misses. This value is not time-derived.
Oracle Database Data Files
The counters are phyrds/sec and phywrts/sec. These values are time-derived. Disk contention occurs when multiple processes try to access the same disk simultaneously. Depending on results from monitoring disk activity, corrective actions could include:
Oracle Database DBWR stats1
The two counters available, buffers scanned/sec and LRU scans/sec, are helpful in tuning Buffer Cache. Buffers scanned/sec is the number of buffers DBWR scanned in each second. The buffers scanned are on the LRU (Least Recently Used) list. LRU scans/sec is the number of times DBWR scanned the (Least Recently Used) buffer list in each second.
Oracle Database DBWR stats2
The two counters available, timeouts/sec and checkpoints/sec, are helpful in determining how much work DBWR has been requested to perform. Timeouts/sec is the number of times DBWR timed-out in each second. DBWR is on a three second timeout interval. If DBWR has not been posted within a three second interval, then it times out.
Checkpoints/sec is the number of checkpoint messages processed by database writer in each second. Whenever a checkpoint occurs, DBWR must be messaged (posted) to "write dirty buffers to disk".
Oracle Database Dynamic Space Management
The counter is recursive calls/sec. Dynamic extension causes Oracle Database to execute SQL statements in addition to those SQL statements issued by user processes. These SQL statements are called recursive calls.
If Oracle Database makes excessive recursive calls while an application is running, then it may be necessary to determine the cause. Examine the recursive calls statistic through dynamic performance table V$SYSSTAT
.
Oracle Database Free List
The counter is free list waits/requests %. Contention for free lists is reflected by contention for free data blocks in buffer cache. You can determine if contention for free lists is reducing performance by querying V$WAITSTAT
.
If the number of free list waits for free blocks is greater than 1% of the total number of requests, then consider adding more free lists to reduce contention.
Oracle Database Sorts
The available counters are sorts in memory/sec and sorts on disk/sec. The default sort area size is adequate to hold all data for most sorts. However, if your application often performs large sorts on data that does not fit into the sort area, then you may increase sort area size.
If no data or Oracle Database objects appear in the Objects list of the Add to (Chart, Alert, Log, Report) dialog, then:
If the log file indicates an invalid host string or password, then check the registry for correct values for Hostname
, Password
, and Username
. See "HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services" for further information about these values.
Oracle Database for Windows problems and other significant occurrences are recorded as events in an application event log. View and manage these recorded events in Event Viewer.
To access Event Viewer:
>
Programs >
Administrative Tools >
Event Viewer. The Event Viewer window appears.
Figure 6-1 displays the Application view window, Table 6-2 shows what is recorded in each column, and Table 6-3 interprets icons that appear at the left edge of the viewer.
Table 6-2 Application View Definitions
Column Name | Definition |
---|---|
Date | Date event took place |
Time | Time event took place |
Source | Application that recorded event |
Category | Classification of event |
Event | Unique number assigned to event |
Computer | Computer name on which event occurred |
Table 6-3 Event Viewer Icons
Icon | Event Type | Suggested Action |
---|---|---|
Red Stop Sign | Error | Always check these icons. |
Lower-case "i" in Blue Circle | Information | Noncritical system events. Check these icons only to track a specific event. |
Exclamation Point in Yellow Circle | Warning | Special events, such as instance termination or services shutdown. Investigate these icons, but they are usually noncritical. |
Oracle Database for Windows events display with a source of Oracle.SID.
Event number 34 specifies an audit trail event. These events are recorded if parameter AUDIT_TRAIL
is set to db
(true
) or os
in the initialization parameter file. Option os
enables system wide auditing and causes audited records to be written to Event Viewer. Option db
enables system wide auditing and causes audited records to be written to the database audit trail (table SYS.AUD$
). Some records, however, are written to Event Viewer.
Event numbers other than 34 specify general database activities, such as an instance being started or stopped.
When you double-click an icon in Event Viewer, the Event Detail dialog appears with more information about the selected event. Figure 6-2, for example, shows details about EventID 1011. In the Description field you will find a text description of the event. In the Data field you can choose Bytes to see the information in hexadecimal format or Words to see DWORDS for the same data.
See Also: Microsoft operating system documentation for more information about using Event Viewer |
Setting AUDIT_TRAIL
to db
or os
causes more records to be written to Event Viewer. This can fill up the Event Viewer log file. Follow these procedures to increase log file size:
The Event Log Settings dialog appears.
You are returned to Event Viewer.
Oracle Database for Windows background threads use trace files to record occurrences and exceptions of database operations, as well as errors. Background thread trace files are created regardless of whether parameter BACKGROUND_DUMP_DEST
is set in the initialization parameter file. If BACKGROUND_DUMP_DEST
is set, then trace files are stored in the directory specified. If the parameter is not set, then trace files are stored in directory ORACLE_BASE
\ADMIN\
db_name
\bdump
.
Oracle Database creates a different trace file for each foreground and background thread. The name of the trace file contains the name of the thread, followed by the extension ".trc"
. The following are examples of foreground trace file names:
ops_ora_5804.trc
ops_ora_4160.trc
The following are examples of background trace file names:
ops_pmon_1556.trc
ops_mmon_3768.trc
ops_lgwr_2356.trc
ops_dbw0_132.trc
Trace files are also created for user threads if parameter USER_DUMP_DEST
is set in the initialization parameter file. Trace files for user threads have the form ora
xxxxx
.trc
, where xxxxx
is a 5-digit number indicating the Windows thread ID
.
Alert logs contain important information about error messages and exceptions that occur during database operations. Each Oracle Database for Windows instance has one alert log; information is appended to the file each time you start the instance. All threads can write to the alert log.
For example, when automatic archiving of redo logs is halted because no disk space is available, a message is placed in the alert log. The alert log is the first place to check if something goes wrong with the database and the cause is not immediately obvious.
The alert log is named alert_
SID
.log
and is found in the directory specified by parameter BACKGROUND_DUMP_DEST
in the initialization parameter file. If parameter BACKGROUND_DUMP_DEST
is not set, then file alert_
SID
.log
is generated in ORACLE_BASE
\admin\
db_name
\bdump
. Alert logs should be deleted or archived periodically.
To view information about Oracle Database threads using Oracle Administration Assistant for Windows, you must either enable Windows native authentication for the database or run utility ocfgutil.exe
with arguments username
and password
. The utility stores the username and password in the following registry location:
When Windows native authentication is not enabled, Oracle Remote Configuration Agent retrieves the username and password from this registry key to log in to the database.
To view information about Oracle Database threads using Oracle Administration Assistant for Windows:
>
Programs >
Oracle - HOME_NAME >
Configuration and Migration Tools >
Administration Assistant for Windows. SID
is a specific instance name, such as orcl
. The Process Information dialog appears, listing name, type, user, thread ID, and CPU usage for each Oracle Database thread.
This chapter describes how to tune the Windows Server operating system to ensure that Oracle Database is running in the best possible environment.
This chapter contains these topics:
Note: For the sake of brevity, this discussion uses the collective term Windows Server when a statement applies to Windows 2000 Server and Windows Server 2003 operating systems. |
Windows Server operating systems offer considerably fewer tuning adjustments than UNIX. This difference constrains systems administrators when they try to optimize Windows Server performance, but it also makes Windows Server easier to use.
There are still ways, however, to make Windows Server a better application server environment for Oracle Database. Most of the operating system specific procedures described in this chapter enable Oracle Database to reserve more system resources, such as CPU, memory, and disk I/O.
In addition, because Oracle Database is a high-performance database management system that effectively uses resources of your Windows computer, it should not also serve as any of the following:
These configurations consume network, memory, and CPU resources. In addition, the Windows computer that is running Oracle Database should not be locally accessed with a high frequency or intensively used for local user processing, unless it has enough resources to accommodate all this activity.
Large page support is a feature of Oracle Database 10g Release 1 (10.1) or later. It provides a performance boost for memory-intensive database instances. By taking advantage of newly introduced operating system support, Oracle Database 10g Release 1 (10.1) or later can now make more efficient use of processor memory addressing resources. Specifically, when large page support is enabled, the CPUs in the system will be able to access the Oracle Database buffers in RAM more quickly. Instead of addressing the buffers in 4KB increments, the CPUs are told to use 4MB page sizes when addressing the database buffers.
This feature is particularly useful when the Oracle buffer cache is several gigabytes. Smaller-sized configurations will still see a gain when using large pages, but the gain will not be as great as when the database is accessing large amounts of memory.
To enable large page support, the system administrator must grant the "Lock pages in memory" privilege to the oracle
user. This privilege is not enabled by default when Windows is installed. To grant this privilege:
The Control Panel window opens.
The Administrative Tools window opens.
The Local Security Settings window opens.
The Local Security Policy Setting dialog opens.
The Select Users or Groups dialog opens.
oracle
user from the Name list. To take advantage of large pages on Windows Server 2003, the amount of physical memory must be greater than the amount of System Global Area (SGA) specified in the parameter file.
Large pages may not be allocated at all times during instance startup; either all of the SGA is allocated using large pages or all of SGA is allocated using regular pages.
Note: Large page usage locks the entire SGA into physical memory. Physical memory is not released during a shrink operation. |
See Also: Your operating system documentation for restrictions on allocating large pages |
To enable large page support:
ORACLE_BASE
\
ORACLE_HOME
\bin\oracle.key
. oracle.key
in a text editor and record the value found. It is set by Oracle Universal Installer. The default is: Note: Although Registry Editor lets you view and modify registry keys and parameter values, you normally are not required to do so. In fact, you can render your system useless if you make incorrect changes. Therefore, only advanced users should edit the registry! Back up your system before making any changes in the registry. |
HKEY_LOCAL_MACHINE
. Find the key corresponding to the value found in oracle.key
. In the default case, for example, you would look for:
ORA_LPENABLE=1
to enable large page support on all instances ORA_
SID
_LPENABLE=1
to enable large page support on a specific instance By default Oracle allocates the minimum available large page size when using large pages. The minimum available large page size, 16 MB, is obtained by using the GetLargePageMinumum
function.
Caution: Do not set initialization parameterlock_sga when large pages are enabled. Large page usage locks the entire SGA into physical memory. When used with parameter lock_sga , database startup fails with an error because the operating system automatically locks. That is, it prevents memory from being paged to disk when large pages are requested. Physical memory is not released during a shrink operation. |
One of the settings provided by default during installation of Windows Server gives interactive foreground applications priority over every background process. To prevent foreground applications on the server console from taking excessive processor time away from Oracle Database, you can reduce priority for foreground applications.
See Also: Your operating system documentation for instructions on reducing priority of foreground applications |
Windows memory manager divides up system memory into three different pools described in Table 7-1.
Table 7-1 Windows Server Memory Shares
Pool | Percent of Total Memory |
---|---|
Kernel and other system services | 9% |
File Cache | 41% |
Paged Memory | 50% |
Windows Server memory manager tries to balance each application's usage of memory by dynamically paging memory between physical RAM and a virtual memory paging file. If an application is particularly memory-intensive (like Oracle Database) or if a large number of applications are running concurrently, then combined memory requirements of the applications may exceed physical memory capacity.
The large proportion of memory reserved for file caching (41%) can be quite beneficial to file and print servers. But it may not be advantageous to application servers that often run memory-intensive network applications. A Windows Server file cache is particularly unnecessary for Oracle Database, which performs its own caching through System Global Area.
You can reset the Windows Server memory model from the default file and print server, with its large file cache, to a network applications model, with a reduced file cache and more physical memory available for Oracle Database.
See Also: Your operating system documentation for instructions |
After you have significantly reduced the file cache as described in "Configure Windows Server to Be an Application Server", you can retrieve additional physical memory for Oracle Database by disabling services not needed for core operating system functionality. Unnecessary services include:
Consult with your systems administrator to identify other unnecessary services.
Do not disable any of the following services:
See Also: Your operating system documentation for instructions on disabling unnecessary services |
Remove all unnecessary network protocols on Windows so that processing time can be concentrated on servicing only critical protocols.
See Also: Your operating system documentation for instructions on removing unnecessary network protocols |
If multiple protocols must be installed on the server, you can give the protocol most frequently used by Oracle Database highest priority by resetting the network protocol bind order.
See Also: Your operating system documentation for instructions on resetting network protocol bind order |
If you have public and private network interface cards (NICs) on a single Windows computer and they are not in the correct order, then you might experience problems with any configuration (Oracle Enterprise Manager, for example) that uses gethostname
.
If the private NIC is seen first by Windows, then a gethostname
call will return the host name of the private interconnect. Whichever tool is calling gethostname
will have configuration or connectivity problems stemming from this non-public network information.
On a Windows 2000 computer, you can determine the current order of your NICs, and change it if necessary, as follows:
Microsoft releases operating system patches, called Service Packs, on a quarterly basis. Service Packs are collections of bug fixes and product enhancements to the basic Windows Server release. In general, apply Service Packs as soon as it is safe to do so, since they fix bugs and can improve Windows Server performance or functionality.
While Service Packs are supposed to fix bugs, they sometimes introduce new problems as well. In general, it is safest to wait a few weeks after a Service Pack is released before implementing it. This allows time for other field sites to report any problems with the SP release.
The latest Windows Server Service Packs may be downloaded as self-extracting archives from http://support.microsoft.com
Unless there are assurances that the Service Pack works without flaws on Windows Server, choose to create an Uninstall
directory. This enables the Service Pack to be removed and the original configuration to be restored.
Service Pack files overwrite similarly-named files in the previous Windows Server configuration. However, Service Pack files can be overwritten in turn by setup programs that copy files from the original installation media.
For example, installing a new network protocol or printer driver usually requires copying files from original Windows Server installation media. When Service Pack files are comprehensively or selectively overwritten, the Service Pack must be re-applied.
Compared to CPU and memory speeds, hard disk drives are extremely slow. Now that hard disk drives are relatively inexpensive, Oracle recommends that Windows Server use logical volumes comprised of striped physical disks. Data striping is an effective means of reducing the impact of relatively slow hard drives by distributing file I/O across a number of hard drives simultaneously.
Note: Data striping through the operating system is not permitted with Automatic Storage Management (ASM), which does its own striping. Hardware striping is allowed with ASM, but it is not necessary. |
Striping data across a number of disks is one example of a redundant array of inexpensive disks (RAID). There are several different types of RAID, also referred to as RAID levels, ranging from high performance to high reliability. The three most common RAID levels in Oracle Database installations are RAID-0, RAID-1, and RAID-5. Descriptions of each RAID level follow Table 7-2, which shows each level's read and write penalties.
Table 7-2 RAID Levels in Oracle Database Installations
RAID Level | Read PenaltyFoot 1 | Write PenaltyFoot 2 |
---|---|---|
0 (Disk Striping) | 1:1 | 1:1 |
1 (Disk Mirroring) | 1:1 | 2:1 |
0 + 1 | 1:1 | 2:1 |
5 (Distributed Data Gathering) | 1:1 | 4:1 |
Footnote 1 Read penalty is ratio of I/O operations to read requests.
Footnote 2 Write penalty is ratio of I/O operations to write requests.
Disk Striping
RAID level 0 enables high-performance, fault-intolerant disk striping. Multiple physical hard disks are aggregated into a logical whole, either by a disk controller or through the operating system (for example, Windows 2000 Server striped volumes). Data operations against the logical volume are broken down into as many chunks as there are physical drives in the array, making simultaneous use of all disks. Given identical hard disks, if one hard disk has a throughput rate of DISKRATE
operations/second, then a RAID 0 logical volume has a rate of:
The downside of RAID 0 is its lack of fault tolerance. If one disk in the logical volume fails, the whole volume fails and must be restored from a backup.
Disk Mirroring
RAID level 1 enables fault tolerant disk mirroring with some chance of a performance penalty. Essentially, every write to a mirrored disk is duplicated on another drive dedicated to this purpose (the mirror drive). If the mirrored disk fails, the mirror drive is brought online in real time. After the faulted drive is replaced, the mirror configuration can be reestablished.
The read penalty for RAID level 1 is nominally 1:1, but it may benefit from split reads on some controllers. When the controller knows which mirror can be accessed fastest, for example, it can lower seek times by directing I/O operations to that disk.
Disk Striping + Mirroring
RAID level 0+1 enables mirroring of an array of striped hard disks. This is a blend of RAID 0 and RAID 1, offering high-performing fault tolerance.
Distributed Data Guarding
RAID level 5, also known as disk striping with parity, eliminates the costly requirement to mirror. In RAID 5, multiple hard disks are aggregated into a striped logical volume, similar to RAID 0, but each drive contains parity information such that any single drive failure is tolerated. With one failed drive, a RAID-5 system can allow continued access to data, although access times are greatly reduced due to on-the-fly rebuilding of bytes from parity information. RAID-5 solutions usually allow hot-swapping of faulty drives with replacements, triggering a rebuild of the failed drive's data onto the replacement from parity information.
The write penalty of 4:1 results from 2 reads and 2 writes during parity calculation.
If there are enough physical disks in Windows Server, create at least two striped volumes (in addition to a standalone hard disk or striped volume for the operating system). One striped volume can be used for sequential data access, and the other can be used for random data access.
Oracle Database redo logs and archived redo logs, for example, are written in sequential order. Because of reduced head movement, hard disks perform best when reading or writing sequential data.
Oracle Database data files, however, are usually accessed in random order. Random access in a hard disk results in significant head movement, translating to slower data access.
Unless redo logs are separated from datafiles (at physical device level), undo file I/O contention may result, increasing access times for both types of files.
Some virtual memory paging is likely even if Oracle Database is the only network application running on Windows Server, because Windows Server memory manager will attempt to move seldom-used pages to disk to free up more physical memory for hot pages.
Multiplexing the Windows Server virtual memory paging file is a good strategy to boost overall system performance. Splitting the paging file onto at least two different physical volumes (or logical volumes as long as underlying physical volumes do not overlap) provides a significant performance boost to virtual memory swapping operations.
Even though this is a good technique to increase speed of virtual memory paging, too much paging activity is still a performance hit and should be corrected by adding more RAM to the server.
General Page File Sizing Tip
Oracle recommends that total combined size of your page files be at least equal to physical RAM on your computer. Configurations where combined size is two to four times the size of physical RAM are not uncommon. Minimize paging as much as possible. But situations in which the operating system runs out of or low on paging space are to be avoided at all costs. Adequately-sized paging files spaced across physical disks spread out I/O most efficiently, because the operating system spreads paging evenly across page files.
Note: Internal read/write batch size for Windows is 4K. |
Once procedures in previous sections have been applied, remember to close any unnecessary foreground applications. First, remove all applications from Startup folders of Windows Server console operators. Second, minimize the window when executing long-running scripts from a command prompt, so that Windows Server can focus on the operation and not on a flood of window repaint messages. Third, disable screen savers, which can quickly saturate the CPU. If a screen saver must be run, choose Blank Screen, which uses the least amount of processing time.
This chapter describes authentication of Oracle Database users with Windows operating systems.
This chapter contains these topics:
Oracle Database can use Windows user login credentials to authenticate database users. Benefits include:
The Windows native authentication adapter (automatically installed with Oracle Net Services) enables database user authentication through Windows. This enables client computers to make secure connections to Oracle Database on a Windows server. The server then permits the user to perform database actions on the server.
Note: Current user database links are not supported with Windows native authentication. |
Note: This chapter describes using Windows native authentication methods with Windows 2000 and above. For information about Secure Sockets Layer (SSL) protocol and Oracle Internet Directory, see Oracle Database Advanced Security Administrator's Guide and Oracle Internet Directory Administrator's Guide. |
The Windows native authentication adapter works with Windows authentication protocols to enable access to Oracle Database.
If the user is logged on as a Windows 2000 domain user from a Windows 2000 computer, then Kerberos is the authentication mechanism used by the NTS adapter. For all other users, NTLM is the authentication mechanism used by the NTS adapter.
If authentication is set to NTS on a standalone Windows computer, ensure that Windows service NTLM Security Support Provider is started. If this service is not started on a standalone Windows computer, then NTS authentication fails. This issue is applicable only if you are running Windows 2000 in standalone mode.
Client computers do not need to specify an authentication protocol when attempting a connection to Oracle Database. Instead, Oracle Database determines the protocol to use, completely transparent to the user. The only Oracle Database requirement is to ensure that parameter SQLNET.AUTHENTICATION_SERVICES
contains nts
in the following file on both the client and database server:
This is the default setting for both after installation. For Oracle8 release 8.0.x releases, you must manually set this value.
If typical, your Oracle Database network includes client computers and database servers, and computers on this network may use different Oracle Database software releases on different Windows operating systems on different domains. This combination of different releases means that the authentication protocol being used can vary.
Table 8-1 lists Oracle Database software and Windows operating system releases required to enable Kerberos as the default authentication protocol:
Table 8-1 Software Requirements to Enable Kerberos Authentication Protocol
Location | Windows Software | Oracle Database Software |
---|---|---|
Client Computer | Windows 2000 | Oracle8i Client or later |
Database Computer | Windows 2000 | Oracle8i Database or later |
Domain | Windows 2000 | None |
For all other combinations of Windows operating system and Oracle Database software releases used in your network, the authentication protocol used is NTLM.
See Also: Your operating system documentation for more information about each authentication protocol |
This section describes how user login credentials are authenticated and database roles are authorized in Windows 2000 domains. User authentication and role authorization are defined in Table 8-2.
Table 8-2 User Authentication and Role Authorization Defined
Feature | Description | More Information |
---|---|---|
User authentication | Process by which the database uses the user's Windows login credentials to authenticate the user. | |
Role authorization | Process of granting an assigned set of roles to authenticated users. |
Oracle Database supports user authentication and role authorization in Windows 2000 domains. Table 8-3 describes these basic features.
Table 8-3 Basic Features of User Authentication and Role Authorization
Feature | Description |
---|---|
Authentication of external users | Users are authenticated by the database using the user's Windows login credentials enabling them to access Oracle Database without being prompted for additional login credentials. |
Authorization of external roles | Roles are authorized using Windows local groups. Once an external role is created, you can grant or revoke that role to a database user. Initialization parameter |
Table 12–4 describes user authentication and role authorization methods to use based on your Oracle Database environment:
Table 8-4 User Authentication and Role Authorization Methods
Method | Database Environment |
---|---|
Enterprise users and roles | You have many users connecting to multiple databases. Enterprise users have the same identity across multiple databases. Enterprise users require use of a directory server. Use enterprise roles in environments where enterprise users assigned to these roles are located in many geographic regions and must access multiple databases. Each enterprise role can be assigned to multiple enterprise user in the directory. If you do not use enterprise roles, then you have to assign database roles manually to each database user. Enterprise roles require use of a directory server. |
External users and roles | You have a smaller number of users accessing a limited number of databases. External users must be created individually in each database and do not require use of a directory server. External roles must also be created individually in each database, and do not require use of a directory server. External roles are authorized using group membership of the users in local groups on the system. |
See Also: Oracle Database Advanced Security Administrator's Guide for more information about Enterprise users and roles |
When you install Oracle Database, a special Windows local group called ORA_DBA
is created (if it does not exist from an earlier Oracle Database installation), and your Windows username is automatically added to it. Members of local group ORA_DBA
automatically receive the SYSDBA privilege.
Membership in ORA_DBA
enables you to:
where net_service_name
is the net service name of the remote Oracle Database server
ORA_DBA
, enabling them to have the SYSDBA
privilege External users and roles are in general defined by something external to Oracle Database. In a Windows environment, they are defined by the operating system.
This chapter describes external user and external role creation and management using either Oracle Administration Assistant for Windows or by a combination of Oracle Database command line tools, Registry Editor, and other Windows tools.
Note: Both methods can also administer external users and roles in Windows 2000 domains, but cannot be used to administer an enterprise user or an enterprise role. See Oracle Database Advanced Security Administrator's Guide for more information about tools available for administering enterprise users and roles. |
This chapter contains these topics:
Oracle Administration Assistant for Windows runs from Microsoft Management Console and enables you to configure the following Oracle Database users and roles so that the Windows operating system can authenticate them, and they can access Oracle Database without a password:
In addition, Oracle Administration Assistant for Windows can create and grant local and external database roles to Windows domain users and global groups.
With Oracle Administration Assistant for Windows, none of the following need be done manually:
This section describes how to perform the following tasks with Oracle Administration Assistant for Windows:
If you want to use Oracle Administration Assistant for Windows to manage a remote computer, you must have administrator privileges for the remote computer. Oracle Administration Assistant for Windows always creates users in Oracle Database with the domain name as the prefix. If you are managing Oracle7 release 7.x or later databases remotely, you must set registry parameter OSAUTH_PREFIX_DOMAIN
to true
on the remote computer. This parameter is located in
If a Windows 2000 computer is not identified with a Domain Name System (DNS) domain name, you will receive the following error message:
To assign a DNS name:
>
Settings >
Control Panel >
System >
Network Identification >
Property >
More >
Primary DNS. US.ORACLE.COM
. When you use Oracle Administration Assistant for Windows for the first time, it adds the local computer to its navigation tree. You can then add other computers.
To add a computer to the Microsoft Management Console tree:
>
Programs >
Oracle - HOME_NAME >
Configuration and Migration Tools >
Administration Assistant for Windows. Microsoft Management Console starts.
The Computer icon appears.
>
Computer. The Add Computer dialog appears.
The OS Database Administrators - Computer node creates an operating system-authenticated database administrator with SYSDBA
privileges for every database instance on the computer. The OS Database Operators - Computer node creates an operating system-authenticated database operator with SYSOPER
privileges for every database instance on the computer.
To grant database administrator (SYSDBA
) privileges to database administrators (DBAs) for all databases on a computer:
>
Programs >
Oracle - HOME_NAME >
Configuration and Migration Tools >
Administration Assistant for Windows. Oracle Administration Assistant for Windows starts.
The OS Database Administrators - Computer for hostname
dialog appears.
SYSDBA
privileges from the Domain list. The user now appears in the OS Database Administrators - Computer window.
To grant database operator (SYSOPER
) privileges to DBAs for all databases on a computer:
>
Programs >
Oracle - HOME_NAME >
Configuration and Migration Tools >
Administration Assistant for Windows. Oracle Administration Assistant for Windows starts.
The OS Database Operators - Computer for hostname
dialog appears.
SYSOPER
privileges from the Domain list. The user now appears in the OS Database Operators - Computer window.
To enable Secure Sockets Layer (SSL) when connecting to Oracle Database, start the Oracle Database service and the listener service in the same user account as the wallet created in Oracle Wallet Manager. Do not use the default user account in the Windows Services dialog. If the Oracle Database service and the listener service are started in the default user accounts, then SSL does not work, and the listener does not start. Support for SSL is an Oracle Advanced Security feature. Oracle Wallet Manager is also an Oracle Advanced Security feature.
See Also: Oracle Database Advanced Security Administrator's Guide for more information about SSL support |
To connect to a database:
ORCL
: If you connect to Oracle Database, the following Windows nodes appear beneath the instance. If these nodes do not appear, double-click the instance.
When connecting to a local computer, Oracle Administration Assistant for Windows first tries to connect to the database as a SYSDBA
, using the Bequeath networking protocol. When connecting to a remote computer, Oracle Administration Assistant for Windows first tries to connect to the database using Windows native authentication as a SYSDBA,
using the TCP/IP networking protocol (port 1521 or the deprecated 1526). If it is unsuccessful, one or more dialogs appear and prompt you to enter information to connect to the database.
The dialog shown here appears because the Windows domain user with which you are attempting to connect to Oracle Database is not recognized as an authenticated user with SYSDBA
privileges. Enter an Oracle Database username and password to access the database. To avoid being prompted with this dialog again, configure your domain user to be a database administrator authenticated by the Windows operating system.
The next dialog appears either because you are not using the TCP/IP networking protocol to connect to a remote installation of Oracle Database or because Oracle Database is not running. Using a protocol other than TCP/IP (Named Pipes for example) causes this dialog to appear each time you attempt a remote connection.
If you do not want this dialog to appear each time, then change to the TCP/IP protocol and ensure the Oracle Net Services listener for the database is listening on the default port 1521 (or the deprecated default port 1526). Otherwise, this dialog appears every time. Ensure also that Oracle Database is started.
SYSDBA
privilege. SYSDBA
privileges. Otherwise, your logon fails. Note: Oracle Net Services provides a Trace Assistant tool that helps diagnose connection problems by converting existing trace file text into a more readable format. See "Using the Trace Assistant to Examine Trace Files" in Oracle Database Net Services Administrator's Guide. |
To view database authentication parameter settings:
O
S_AUTHENT_PREFIX
OS_ROLES
OS_AUTHENT_PREFIX
is an init.ora
file parameter that authenticates external users attempting to connect to Oracle Database with the user's Windows username and password. The value of this parameter is attached to the beginning of every user's Windows username.
By default, the parameter is set to none ("") during Oracle Database creation. Therefore, a Windows domain username of frank
is authenticated as username frank
. If you set this parameter to xyz
, then Windows domain user frank
is authenticated as user xyzfrank
.
OS_ROLES
is an init.ora
file parameter that, if set to true
, enables the Windows operating system to manage authorization of an external role for a database user. By default, OS_ROLES
is set to false
. You must set OS_ROLES
to true
and restart Oracle Database before you can create external roles. If OS_ROLES
is set to false
, Oracle Database manages granting and revoking of roles for database users.
If OS_ROLES
is set to true
, and you assign an external role to a Windows global group, then it is granted only at the Windows global group level, and not at the level of the individual user in this global group. This means that you cannot revoke or edit the external role assigned to an individual user in this global group through the Roles tab of the User Name Properties dialog at a later time. Instead, you must use the field in the Assign External OS Roles to a Global Group dialog to revoke the external role from this global group (and therefore all its individual users).
External roles assigned to an individual domain user or local roles (with OS_ROLES
set to false
) assigned to an individual domain user or Windows global group are not affected by this issue. They can be edited or revoked.
If OS_ROLES
is set to true
, you cannot grant local roles in the database to any database user. You must grant roles through Windows. See "Creating a Local Database Role" and "Creating an External Operating System Role" for more information.
The External OS Users node of Oracle Administration Assistant for Windows enables you to authenticate a Windows user to access Oracle Database as an external user without being prompted for a password. External users are typically regular database users (not database administrators) to which you assign standard database roles (such as DBA
), but do not want to assign SYSDBA
(database administrator) or SYSOPER
(database operator) privileges.
To create an external operating system user:
Create External OS User Wizard starts, and the first of three wizard dialogs appears. The first dialog is for Windows Users and Groups.
The assigned properties appear.
Note: If you select a Windows global group for authentication when using Oracle Administration Assistant for Windows, all users currently in the group are added to Oracle Database. If at a later time, you use a Windows tool to add or remove users in this Windows global group, these updates are not reflected in Oracle Database. The newly added or removed users must be explicitly added or removed in Oracle Database with Oracle Administration Assistant for Windows. |
The Local Roles node of Oracle Administration Assistant for Windows enables you to create a role and have it managed by the database. Once a local role is created, you can grant or revoke that role to a database user. To create a local database role:
Create Local Role Wizard starts, and the first of three wizard dialogs appears. The first dialog is for Name and Authentication.
Select Password if you want use of this role to be protected by a password. These roles can only be used by supplying an associated password with the SET ROLE
command. See Oracle Database 2 Day DBA for additional information.
Enter the password to use with this role.
Confirm the password by entering it a second time.
The Granted System Privileges field displays the list of system privileges granted to the local role. To revoke a system privilege, make an appropriate selection, then choose Revoke.
The Granted Roles field displays the list of roles granted to the role. Both local roles and external roles can appear in this list. To revoke roles, make appropriate selections, then choose Revoke.
The External OS Roles node of Oracle Administration Assistant for Windows enables you to create an external role and have it managed by the Windows operating system. Once an external role is created, you can grant or revoke that role to a database user. To create an external role:
Create External OS Role Wizard starts, and the first of three wizard dialogs appears. The first dialog is for Name. Authentication: External appears in this dialog to indicate that only external roles can be created.
Note: Create External OS Role Wizard is available only ifinit.ora parameter OS_ROLES is set to true . If it is set to false , then you must first change it to true and then restart Oracle Database. |
The System Privileges dialog appears.
The Roles dialog appears.
The Granted Roles field displays the list of roles granted to the external role.
The OS Database Administrators node of Oracle Administration Assistant for Windows enables you to authorize a Windows user with SYSDBA
privileges for a specific instance on a computer. To grant administrator (SYSDBA)
privileges for a single database:
The OS Database Administrators for instance
dialog appears. In the example shown here, the instance is MARK
:
SYSDBA
privileges from the Domain list. The user now appears in OS Database Administrators.
The OS Database Operators node of Oracle Administration Assistant for Windows enables you to authorize a Windows user with SYSOPER privileges for a specific instance on a computer. To grant operator (SYSOPER) privileges for a single database:
The OS Database Operators for instance
dialog appears. In the example shown here, the instance is MARK
:
SYSOPER
privileges from the Domain list. The user now appears in OS Database Operators.
Instead of using Oracle Administration Assistant for Windows, you can manually configure administrators, operators, users, and roles to be authenticated by the operating system. Manual configuration involves using Oracle Database command line tools, editing the registry, and creating local groups in Active Directory Users and Computers.
All of the following can be manually configured to access Oracle Database without a password:
SYSDBA
privilege) SYSOPER
privilege) In addition, you can manually create and grant local and external database roles to Windows domain users and global groups.
This section describes:
Note: Use extreme care when manually configuring administrators, operators, users, and roles to be authenticated by the operating system. If possible, use Oracle Administration Assistant for Windows to perform configuration procedures. |
This section describes how to authenticate external operating system users (not database administrators) using Windows, so that a password is not required when accessing the database. When you use Windows to authenticate external operating system users, your database relies solely on the operating system to restrict access to database usernames.
In the following procedure, two Windows usernames are authenticated:
frank
frank
on domain sales
Local user frank
logs into its local Windows client computer to access an Oracle Database server, which can be on a different computer. To access other databases and resources on other computers, the local user must provide a username and password each time.
Domain user frank
on domain sales
logs into a sales
domain that includes many other Windows computers and resources, one of which contains an Oracle Database server. The domain user can access all the resources the domain provides with a single username and password.
The procedure is divided into two sets of tasks performed on different computers:
OS_AUTHENT_PREFIX
to your init.ora
file. The OS_AUTHENT_PREFIX
value is prefixed to local or domain usernames attempting to connect to the server with the user's operating system name and password. The prefixed username is compared with Oracle Database usernames in the database when a connection request is attempted. Using parameter OS_AUTHENT_PREFIX
with Windows native authentication methods is the recommended method for performing secure, trusted client connections to your server.
OS_AUTHENT_PREFIX
. Your choices are: If you specify xyz
, as in this procedure's example, then xyz
is prefixed to the beginning of the Windows username (for example, xyzfrank
for local user frank
or xyzsales\frank
for domain user frank
on domain sales
). String values are case insensitive.
""
(two double quotes with no space between) This option is recommended, because it eliminates the need for any prefix to Windows usernames (for example, frank
for local user frank
or sales\frank
for domain user frank
on domain sales
).
If you do not specify a value for OS_AUTHENT_PREFIX
, it defaults to OPS$
(for example, OPS$frank
for local user frank
or OPS$sales\frank
for domain user frank
on domain sales
).
frank
with the Computer Management tool, or create a domain username for frank
with Active Directory Users and Computers (if the appropriate name does not currently exist). See your operating system documentation for detailed instructions. frank
instead of frank
on domain sales
). Otherwise, go to step 8. HKEY_LOCAL_MACHINE\SOFTWARE\ORACLE\HOME
ID
, where ID
is the Oracle home directory you want to edit. >
Add Value. The Add Value dialog appears:
OSAUTH_PREFIX_DOMAIN
in the Value Name field. REG_EXPAND_SZ
from the Data Type list. The String Editor dialog appears:
true
in the String field to enable authentication at the domain level. There may be multiple frank
usernames on your network, including local user frank
, domain user frank
on sales
, and possibly several domain users frank
on other domains. Entering true
enables the server to differentiate among them. Entering false
causes the domain to be ignored and local user frank
to become the default value of the operating system user returned to the server.
Registry Editor adds the parameter.
Registry Editor exits.
SQLNET.AUTHENTICATION_SERVICES
in file sqlnet.ora
contains nts
. Unless you have changed it, the SYSTEM
password is MANAGER
by default.
where xyz
is the value you chose for initialization parameter OS_AUTHENT_PREFIX
, and frank
is the Windows local username.
where XYZ
is the value you chose for initialization parameter OS_AUTHENT_PREFIX
, and SALES\FRANK
is the domain name and Windows domain username. Double quotes are required and the entire syntax must be in uppercase.
Double quotes are required and the entire syntax must be in uppercase.
SYSDBA
name: This causes the change to parameter OS_AUTHENT_PREFIX
to take effect.
frank
with the same username and password that exist on the Windows server (if the appropriate name does not currently exist). SQLNET.AUTHENTICATION_SERVICES
in file sqlnet.ora
contains nts
. where connect_identifier
is the net service name for Oracle Database.
Oracle Database searches the data dictionary for an automatic login username corresponding to the Windows local or domain username, verifies it, and enables connection as xyzfrank
or xyzsales\frank
.
frank
by viewing the roles assigned in steps 12 or 14 of "External User Authentication Tasks on the Oracle Database Server". which outputs for local user frank
:
or, for domain user frank
:
Because the Oracle Database username is the whole name xyzfrank
or xyzsales\frank
, each object created by xyzfrank
or xyzsales\frank
(that is, table, view, index, and so on) is prefixed by this name. For another user to reference the table shark
owned by xyzfrank
, for example, the user must enter:
This section describes how to enable Windows to grant the database administrator (SYSDBA
) and database operator (SYSOPER
) privileges to database administrators. With this privilege, database administrators can issue the following commands from a client computer and connect to Oracle Database without entering a password:
To enable this feature, the Windows local or domain username of the database administrator must belong to one of the Windows local groups listed in Table 9-1.
Table 9-1 Windows Local Groups with SYSDBA and SYSOPER Privileges
Local Group | Privileges |
---|---|
|
|
|
|
|
|
|
|
Footnote 1 ORA_DBA
is automatically created during installation. See section "Operating System Authentication Enabled at Installation" for information.
The manual procedure for enabling database administrators to connect as SYSOPER
or SYSDBA
without a password is divided into two sets of tasks performed on different computers:
See Also: Your operating system documentation for instructions on managing users and groups |
SQLNET.AUTHENTICATION_SERVICES
in file sqlnet.ora
contains nts
. HKEY_LOCAL_MACHINE\SOFTWARE\ORACLE\HOME
ID
where ID
is the Oracle home that you want to edit.
OSAUTH_PREFIX_DOMAIN
to true
. SQLNET.AUTHENTICATION_SERVICES
in file sqlnet.ora
contains nts
. where net_service_name
is the Oracle Net net service name for Oracle Database.
ORA_DBA
or ORA_SID_DBA
in step 1 of "SYSDBA/SYSOPER Authentication Tasks on the Oracle Database Server", then enter either of the following: If you specified ORA_OPER
or ORA_
SID
_OPER
in step 1, then enter:
You are now connected to the Windows server. If you connect with SYSDBA
, you are given DBA privileges.
This section describes how to grant Oracle Database roles to users directly through Windows (known as external roles). When you use Windows to authenticate users, Windows local groups can grant these users external roles.
All privileges for these roles are active when the user connects. When using external roles, all roles are granted and managed through the operating system. You cannot use both external roles and Oracle Database roles at the same time.
Consider the following example. With external roles enabled, you log on to a Windows domain with domain username sales\frank
(sales
is the domain name and frank
is the domain username). You then connect to Oracle Database as Oracle Database user scott
. In this case, you receive the roles granted to sales\frank
but not the roles granted to scott
.
The procedure for manually creating an external role is divided into two sets of authorization tasks performed on different computers:
OS_ROLES
to the init.ora
file. OS_ROLES
to true
. The default setting for this parameter is false
.
SQLNET.AUTHENTICATION_SERVICES
in file sqlnet.ora
contains nts
. DBSALES3
: DBSALES3
whatever Oracle Database roles are appropriate to your database environment: SYSDBA
: where
sid
identifies the database instance rolename
identifies the database role granted D
indicates that this database role is to be a default role of the database user A
indicates that this database role includes ADMIN
OPTION
Characters D
and A
are optional. If specified, they must be preceded by an underscore.
For this example, ORA_orcl_dbsales3_D
is created.
See Also: Your operating system documentation for instructions on managing users and groups |
You can create multiple database roles and grant them to several possible Windows groups with differing options, as shown in the following table. Users connecting to the ORCL
instance and authenticated by Windows as members of all four of these Windows local groups will have the privileges associated with dbsales3
and dbsales4
by default (because of option _D
). If these users first connect as members of dbsales3
or dbsales4
and use the SET ROLE
command, then they can also gain access to database roles dbsales1
and dbsales2
. But if these users try to connect with dbsales1
or dbsales2
without first connecting with a default role, they are unable to connect. Finally, these users can grant dbsales2
and dbsales4
to other roles (because of option _A
).
Database Roles | Windows Groups |
---|---|
dbsales1 | ORA_ORCL_dbsales1 |
dbsales2 | ORA_ORCL_dbsales2_a |
dbsales3 | ORA_ORCL_dbsales3_d |
dbsales4 | ORA_ORCL_dbsales4_da |
Note: When Oracle Database converts the group name to a role name, it changes the name to uppercase. |
SQLNET.AUTHENTICATION_SERVICES
in file sqlnet.ora
contains nts
. where connect_identifier
is the net service name for the Oracle Database connection that you created in Step 3.
You are connected to the Windows server over net service with Oracle Database username scott/tiger
. Roles applied to Oracle Database username scott
consist of all roles defined for the Windows username that were previously mapped to the database roles (in this case, ORA_DBSALES3_D
). All roles available under an authenticated connection are determined by the Windows username and the Oracle-specific Windows local groups to which the user belongs (for example, ORA_
SID
_DBSALES1
or ORA_
SID
_DBSALES4_DA
).
Note: OSDBA and OSOPER are generic names for two special operating system groups that control database administrator logins when using operating system authentication. Windows-specific names for OSDBA and OSOPER are described in "Manually Granting Administrator and Operator Privileges for Databases". See Oracle Database Administrator's Guide for more information about OSDBA and OSOPER. |
You can migrate local or external users to enterprise users with User Migration Utility. Migrating from a database user model to an enterprise user model provides solutions to administrative, security, and usability challenges in an enterprise environment. In an enterprise user model, all user information is moved to an LDAP directory service, which provides the following benefits:
User Migration Utility is a command-line tool. Its syntax is of the form:
To get a list of User Migration Utility parameters, enter:
See Also: "Using the User Migration Utility" in Oracle Database Advanced Security Administrator's Guide |
This chapter describes storing and retrieving of Oracle Wallets in the Windows registry.
Oracle Wallets store private keys, trust points, and digital certificates used in public key applications for authentication and encryption. Oracle Wallet Manager creates and manages Oracle Wallets. Oracle public key applications use obfuscated Oracle Wallets for authentication and encryption.
Note: Oracle Wallet Manager is a feature of Oracle Advanced Security, a separately licensable option to Oracle Database. |
In a Windows 2000 domain, a user's profile is stored on the local computer. When a local user logs on to that computer, that user's profile on the local computer is uploaded into the user profile in that computer's registry. When a user logs out, that user's profile stored on the local file system is updated, ensuring that the domain user or local user always has the most recent user profile version.
Parameter WALLET_LOCATION
in file sqlnet.ora
specifies the location of the obfuscated Oracle Wallet for use by Oracle PKI applications. For example, the WALLET_LOCATION
parameter for storing an Oracle Wallet in the registry in:
would be:
Continuing the example, the encrypted Oracle Wallet would be stored in the registry in:
and the obfuscated Oracle Wallet would be stored in:
On Windows operating systems, if there is no value specified for parameter WALLET_LOCATION
, then Oracle PKI applications first look for the obfuscated wallet in registry key:
If no obfuscated wallet is found there, Oracle PKI applications look for it in the file system of the local computer at location:
Regardless of location, wallets are always stored in the same format. All functionality is the same except for the location of the wallets.
Oracle Wallet Manager creates and manages Oracle Wallets. If you want to use the Windows registry for Oracle Wallets, then you must select the Use Windows System Registry check box. If Windows System Registry is selected, then the tool shows a list of existing keys when it opens a wallet or saves a new wallet. The list appears in:
You can select one of the existing locations or enter the name for a new location (registry key). If you enter a new key called key1
, for example, then the tool creates the following registry key:
The encrypted wallet will be stored in:
The obfuscated wallet will be stored in:
If you do not select the Use Windows System Registry check box, then the tool displays all the available drives and directories on the local computer. You can select one of the existing directories or enter a new directory. The tool stores the encrypted or obfuscated wallet in the selected directory or creates the directory if it does not exist.
Multiple nonreplicated databases cannot share wallets. If sqlnet.ora
files contain wallet location information, then databases also cannot share sqlnet.ora
files.
The only exception to this rule is password-authenticated or Kerberos-authenticated enterprise user security with default database-to-directory connection configuration that uses passwords. This configuration keeps database wallets in the default location, where Database Configuration Assistant creates them. In this situation, no wallet location information is stored in the sqlnet.ora
file, and the wallet can be shared among multiple databases.
Note: If SSL is used for enterprise user authentication, then the wallet location must be specified in thesqlnet.ora file. So sqlnet.ora files cannot be shared by multiple databases for SSL-authenticated enterprise users. |
This chapter describes integration of Oracle public key infrastructure (PKI) with Windows 2000 public key infrastructure (Windows PKI) on Windows operating systems.
Oracle public key infrastructure (PKI) is used by Oracle Enterprise Security Manager, LDAP-enabled Oracle Enterprise Manager, Oracle's Secure Socket Layer (SSL) authentication, Oracle Database, and Oracle Application Server.
Note: Oracle Security Manager is installed only with Oracle Database Client. |
Oracle PKI includes the following components:
Oracle Wallets store digital certificates, trust points, and private keys used in public key applications for encryption, decryption, digital signature, and verification.
This section describes Windows public key infrastructure.
This section contains these topics:
Note: Microsoft Certificate Store integration works only with digital certificates that use Microsoft Enhanced Cryptographic Provider. To create these certificates, you need to install Windows High Encryption Pack and select Microsoft Enhanced Cryptographic Provider. Also, when there are multiple of these certificates available for the same key usage (signature/key exchange), the first certificate retrieved will be used for Oracle SSL. |
Microsoft Certificate Stores are repositories for storing digital certificates and their associated properties. Windows 2000 stores digital certificates and certificate revocation lists in logical and physical stores. Logical stores contain pointers to public key objects in physical stores. Logical stores enable public key objects to be shared between users, computers, and services without requiring storage of duplicates of objects for each user, computer, or services. Public key objects are physically stored in the registry of the local computer or, for some user certificates, in Active Directory. Standard system certificate stores defined by Microsoft include:
MY or Personal holds a user's certificates for which the associated private key is available. The MY certificate store maintains certificate properties that indicate the Cryptographic Service Provider (CSP) associated with the private key. An application uses this information to obtain the private key from the CSP for the associated certificate. CA holds issuing or intermediate certificate authority (CA) certificates. ROOT holds only self-signed CA certificates for trusted root CAs.
Microsoft Certificate Services (MCS) consists of the following modules:
Server Engine handles all certificate requests. It interacts with other modules at each processing stage to ensure that the proper action is taken based on the state of the request. The Intermediary module receives requests for new certificate from clients and then submits them to Server Engine. The Policy module contains the set of rules controlling the issuance of certificates. This module may be upgraded or customized as needed.
Wallet Resource Locator (WRL) specifies that parameter WALLET_LOCATION
in file sqlnet.ora
identifies a particular PKI. You can choose between using Oracle Wallet or Microsoft Certificate Stores by setting parameter WALLET_LOCATION
in sqlnet.ora
. To use credentials from Microsoft Certificate Stores, set parameter WALLET_LOCATION
in sqlnet.ora
to:
The Oracle application uses Oracle's TCP/IP with SSL protocol (TCPS) to connect to Oracle Server. The SSL protocol uses X.509 certificates and trust points from the user's Microsoft Certificate Store for SSL authentication.
This chapter describes how to configure and use Microsoft Active Directory as the LDAP directory.
This chapter contains these topics:
This section describes how Microsoft Active Directory is used as an LDAP directory server by Oracle Database.
This section contains these topics:
Active Directory is the LDAP-compliant directory server included with Windows 2000. Active Directory stores all Windows 2000 information, including users, groups, and policies. Active Directory also stores information about network resources (such as databases) and makes this information available to application users and network administrators. Active Directory enables users to access network resources with a single login. The scope of Active Directory can range from storing all the resources of a small computer network to storing all the resources of several wide areas networks (WANs).
When using Oracle features that support Active Directory, ensure that the Active Directory computer can be successfully reached using all possible TCP/IP host name forms to reach the domain controller. For example, if the host name of the domain controller is server1
in the domain acme.com
, then ensure that you can ping that computer using all of the following:
server1.acme.com
acme.com
server1
Active Directory often issues referrals back to itself in one or more of these forms, depending upon the operation being performed. If any of the forms cannot reach the Active Directory computer, then some LDAP operations may fail.
The following Oracle Database features support or have been specifically designed to integrate with Active Directory:
Oracle Database provides Oracle Net Services directory naming, which uses a directory server. This feature has been enabled to work with Microsoft Active Directory. Directory Naming enables clients to connect to the database making use of information stored centrally in an LDAP-compliant directory server such as Active Directory. For example, any net service name previously stored in the tnsnames.ora
file can now be stored in Active Directory.
Oracle Net Configuration Assistant provides automatic discovery of directory servers. When you select Active Directory as the directory server type, Oracle Net Configuration Assistant automatically discovers the directory server location and performs related tasks.
See Also: "Configuring Oracle Database to Use Active Directory" for more information about Active Directory configuration |
Oracle Database services, net service names, and enterprise role entries in Active Directory can be displayed and tested in two Windows tools:
Windows Explorer displays the hierarchical structure of files, directories, and local and network drives on your computer. It can display and test Oracle Database service and net service name objects.
Active Directory Users and Computers is an administrative tool installed on Windows servers configured as domain controllers. This tool enables you to add, modify, delete, and organize Windows 2000 accounts and groups, and publish resources in the directory of your organization. Like Windows Explorer, it can display and test Oracle Database service and net service name objects. Additionally, it can manage access control.
The property menus of Oracle Database service and net service name objects in Windows Explorer and Active Directory Users and Computers have been enhanced. When you right-click these Oracle directory objects, you now see two new options for testing connectivity:
The Test option tests whether the username, password, and net service name you initially entered can actually connect to Oracle Database. The Connect with SQL*Plus option starts SQL*Plus, which enables you to perform database administration, run scripts, and so on.
Oracle directory object type descriptions in Active Directory have been enhanced to make them easier to understand. In the right pane of Figure 12-1, for example, the Type column reveals that sales
is an Oracle Net Service name.
Oracle database and configuration tools can use the login credentials of the Windows user currently logged on to connect to Active Directory without having to re-enter the login credentials. This feature has two benefits:
If Oracle Database and Oracle Net Services are installed and configured to access Active Directory, then Active Directory Users and Computers displays Oracle directory objects, as illustrated in Figure 12-1:
Figure 12-1 Oracle Directory Objects in Active Directory Users and Computers
Table 12-1 describes the Oracle directory objects appearing in Figure 12-1.
Table 12-1 Oracle Directory Objects
Object | Description |
---|---|
| The domain in which you created your Oracle Context. This domain (also known as the administrative context) contains various Oracle entries to support directory naming. Oracle Net Configuration Assistant automatically discovers this information during Oracle Database integration with Active Directory. |
| The top-level Oracle entry in the Active Directory tree. It contains Oracle Database service and net service name object information. All Oracle software information is placed in this folder. |
| The Oracle Database service name used in this example. |
| Folder for Oracle product information. |
| The net service name object used in this example. |
| Folder for the Oracle security groups. See "Access Control List Management for Oracle Directory Objects" for more information. Enterprise users and roles created with Oracle Enterprise Security Manager also appear in this folder. |
To use Net Directory Naming with Active Directory, you must have certain Microsoft and Oracle software releases, and you must create Oracle schema objects and an Oracle Context. These requirements are discussed in the following sections:
Note: |
For client computers from which you want to manage Oracle Database enterprise users, roles and domains, you must have an Oracle Client on a supported Microsoft Windows operating system.
For the server, you must have an Oracle Database server on a Windows Server operating system.
Both the client computers and the database must be members of a Windows domain.
You must create Oracle schema objects to use net directory naming features with Active Directory. Schema objects are sets of rules for Oracle Net Services and Oracle Database entries and their attributes stored in Active Directory. The following restrictions apply to creating Oracle schema objects to use with Active Directory:
To create an Oracle schema object:
If the Active Directory display is not configured to accept all 24 default languages, then Oracle schema object creation can fail while Oracle Net Configuration Assistant is configuring Active Directory as the directory server. Before running Oracle Net Configuration Assistant to complete directory access configuration, verify that the display specifiers for all 24 languages are populated by entering the following at the command prompt:
where:
domain
context
is the domain context for this Active Directory server. For example, dc=acme
,dc=com
.
temp
file
is a file where you want to put the output. If the command reports that fewer than 24 entries were found, then you can still use Oracle Net Configuration Assistant. However, the report will indicate that Oracle schema object creation failed, rather than simply reporting that display specifiers for some languages were not created.
Display Specifiers Not Created
When Net Configuration Assistant creates the Oracle schema object in Active Directory, the display specifiers for Oracle entries are not created. This means you cannot view Oracle database entries in Active Directory interfaces.
You can manually add these entries into Active Directory after the Oracle schema object has been created by doing the following, using the same Windows user identification you used when creating the Oracle schema object with Net Configuration Assistant:
ORACLE_HOME
\ldap\schema\ad
. adDisplaySpecifiers_us.sbs
to adDisplaySpecifiers_us.ldif
. adDisplaySpecifiers_other.sbs
to adDisplaySpecifiers_other.ldif
. .ldif
files, replacing all occurrences of %s_AdDomainDN%
with the domain DN for the specific Active Directory into which you want to load the display specifiers (for example, dc=acme,dc=com
). where <ad hostname>
is the host name of the Active Directory domain controller to which you want to load the display specifiers.
You must create an Oracle Context to use net directory naming features with Active Directory. Oracle Context is the top-level Oracle entry in the Active Directory tree. It contains Oracle Database service and Oracle Net service name object information.
See Also:
|
Oracle Net Configuration Assistant enables you to configure client computers and Oracle Database to access a directory server. When you choose directory access configuration from Oracle Net Configuration Assistant, it then prompts you to specify a directory server type to use. When you select Active Directory as the directory server type, the Automatic Discovery of Directory Servers feature of Oracle Net Configuration Assistant automatically:
If the Active Directory server has an Oracle Context, then select the following nondefault option:
Oracle Net Configuration Assistant will report that the Oracle Context does not exist. Ignore this and choose to create the Oracle Context anyway. Directory access configuration will complete without trying to re-create the existing Oracle Context.
Note: Regardless of the Oracle Database Client and Oracle Database releases you are using, you must be running in a Windows 2000 domain to take advantage of the automatic directory server discovery features of Oracle Net Configuration Assistant. If you are not running in a Windows 2000 domain, then Oracle Net Configuration Assistant does not automatically discover your directory server, and instead prompts you for additional information, such as the Active Directory location. |
See Also:
|
This section describes how to connect to an Oracle Database server through Active Directory.
This section contains these topics:
When using Oracle Net directory naming, client computers connect to a database by specifying the database or net service name entry that appears in the Oracle Context. For example, if the database entry under the Oracle Context in Active Directory is orcl
, and the client and the database are in the same domain, then a user connects to the database through SQL*Plus by entering the following connect string:
If the client and the database are in different domains, then a user connects to the database through SQL*Plus by entering:
where domain
is the domain in which the Oracle Database server is located.
These connect strings follow DNS-style conventions. While Active Directory also supports connections using X.500 naming conventions, Oracle recommends DNS-style conventions because they are easier to use.
DNS-style conventions enable client users to access an Oracle Database server through a directory server by entering minimal connection information, even when the client computer and Oracle Database server are in separate domains. Names following the X.500 convention are longer, especially when the client and Oracle Database server are located in different domains (also known as administrative contexts).
See Also:
|
Oracle directory objects in Active Directory are integrated with two Microsoft tools:
You can test connectivity to an Oracle Database server from within these Microsoft tools by actually connecting to it, or you can just test the connection with actually connecting. To test connectivity:
To start Windows Explorer:
To start Active Directory Users and Computers:
Choose Start > Programs > Administrative Tools > Active Directory Users and Computers.
Note: All clients accessing an Oracle Database server through Active Directory require read access on all net service name objects in the Oracle Context and must be able to authenticate anonymously with Active Directory. Oracle Net Configuration Assistant automatically sets this up. |
A menu appears with several options. This section covers only the Test and Connect with SQL*Plus options.
This section identifies security groups specific to Oracle directory objects within Active Directory and explains how to add and delete security group members.
This section contains these topics:
Security groups are automatically created when the Oracle Context is created in Active Directory. The user configuring access (and thus creating the Oracle Context) is automatically added to each group. The relevant groups are:
The OracleDBCreators
group is for the person registering the Oracle Database server. The domain administrator is automatically a member of this group. Users in this group can:
You can add or remove users in the security groups with Active Directory Users and Computers.
Note: Use Active Directory Users and Computers to perform the procedures described in this section. Windows Explorer does not provide the necessary functionality. |
To add or remove users:
This enables you to view and edit information that is normally hidden.
The security groups appear in the right window pane.
A menu appears with several options.
The Properties dialog for the group you selected appears (in this example, OracleDBCreators
).
The Select Users, Contacts, Computers, or Groups dialog appears.
Your selections appear in the Select Users, Contacts, Computers, or Groups dialog.
Oracle Database for Windows uses initialization parameters to enable various features of the database every time an instance is started.
This chapter contains these topics:
An initialization parameter file is an ASCII text file containing parameters. By changing parameters and values in an initialization parameter file, you can specify, for example:
Every database instance has a corresponding initialization parameter file and an ORACLE_SID
registry parameter that points to the system identifier for the instance.
The initialization parameter filename takes the form init.ora
. A single instance might have several initialization parameter files, each having some differences that affect system performance.
Note: Yourinit.ora file for initialization parameters is set by Oracle Universal Installer during database installation. These parameter settings may vary depending on your hardware configuration. For descriptions of all initialization parameters and instructions for setting and displaying their values, see Oracle Database Reference. |
If you do not specify a different initialization file with option PFILE
at database startup, then by default Oracle Database uses initialization parameter files located in
Note: If you create a database manually using a SQL script, then you are required to create an initialization parameter file or copy an existing initialization parameter file and modify the contents. If you use Database Configuration Assistant to create a database, then the initialization parameter file is automatically created for you. |
To customize Oracle Database functions, you may be required to edit the initialization parameter file. Use only an ASCII text editor to modify the file.
When you create a database using Database Configuration Assistant, a server parameter file (SPFILE) is created from the initialization parameter file, and the initialization parameter file is renamed. Oracle does not recognize the renamed file as an initialization parameter file, and it is not used after the instance is started.
If you want to modify an instance created with Database Configuration Assistant after it starts, you must use ALTER SYSTEM
statements. You cannot change the SPFILE itself, because it is a binary file that cannot be browsed or edited using a text editor. The location of the newly-created SPFILE is ORACLE_BASE
\
ORACLE_HOME
\database
. The SPFILE filename is spfile
SID
.ora
.
See Also: "Managing Initialization Parameters Using a Server Parameter File" in Oracle Database Administrator's Guide |
Oracle Database provides an annotated sample initialization parameter file with alternative values for initialization parameters. These values and annotations are preceded by comment signs (#
), which prevent them from being processed. To activate a particular parameter, remove the preceding #
sign. To de-activate a particular parameter, edit the initialization parameter file to add a comment sign. The sample file is called initsmpl.ora
. and is located in
If you installed a starter database, the initialization parameter file used by the starter database is located in the same directory. You can use either initsmpl.ora
or the starter database init.ora
as a basis for creating a new Oracle Database initialization parameter file.
To use sample file initsmpl.ora
as part of database creation:
init.ora
. Here are two examples of activation and de-activation of alternative parameters. Several initialization parameters are specified with three different values to create a small, medium, or large System Global Area, respectively. The parameter that creates a small SGA is active in this first example:
To create a medium-sized SGA, comment out the small parameter definition and activate the medium parameter definition. Edit the initialization parameter file as in this second example:
Parameter SGA_MAX_SIZE
holds the maximum size that System Global Area (SGA) can reach for a particular instance. Beginning with Oracle9i release 1 (9.0.1), Oracle Database can change its SGA configuration while the instance is running. This allows sizes of buffer cache, shared pool, and large pool to be changed without instance shutdown.
Oracle Database can start instances underconfigured and allow the instance to use more memory by growing SGA up to a maximum of SGA_MAX_SIZE
. If no SGA_MAX_SIZE
value is specified, then Oracle Database selects a default value that is the sum of all components specified or defaulted at initialization time. If SGA_MAX_SIZE
specified in the initialization parameter file is less than the sum of all components specified or defaulted to at initialization time, then the setting of SGA_MAX_SIZE
in the initialization parameter file serves as an upper bound.
See Also:
|
Memory allocated for the SGA of an instance is displayed on instance startup when using Oracle Enterprise Manager (or SQL*Plus). You can also display the SGA size of the current instance by using the SQL*Plus SHOW
statement with the SGA clause.
Oracle Database Reference describes default values for many initialization parameters as being operating system-specific. However, not all parameters that it describes as having operating system-specific values affect Windows. In these cases, Windows uses either the default value set in the Oracle Database kernel or does not use the parameter. Table 13-1 describes these initialization parameters:
Table 13-1 Initialization Parameters Without Windows-Specific Values
Parameter | Description |
---|---|
| Not supported on Windows and should not be added to the initialization parameter file |
| Supported, but typically unnecessary due to Windows asynchronous I/O capabilities |
| Uses default value set in Oracle Database kernel (no Windows-specific value) |
| Specifies whether Oracle Database includes SGA in core file for Oracle Database background processes |
| Specifies whether Oracle Database includes SGA in core file for foreground (client) processes |
| Specifies directory where Oracle Database dumps core files |
| Oracle Database automatically sets value to number of processors available for your Oracle Database instance |
| Not applicable to Windows |
| Not applicable to Windows |
| Uses maximum value limited by available memory |
| Starter database uses value set in Oracle Database kernel (no Windows-specific value). The Custom database creation option of Database Configuration Assistant enables you to customize the value for this parameter. |
| Uses default value set in Oracle Database kernel (no Windows-specific value) |
Windows-specific parameter values can be viewed by using an ASCII editor to open the initialization parameter file:
To display any parameter value (whether set in the initialization parameter file or the Oracle Database kernel), enter the following command at the SQL*Plus command prompt:
where parameter_name
is the name of a specific initialization parameter.
Check the initialization parameters in Table 13-2 when creating a new database. They cannot be modified after you have created the database. See Chapter 3, "Postinstallation Database Creation on Windows" for details on creating a new database, including the part of the procedure where you modify these parameters.
Table 13-2 Uneditable Database Initialization Parameters
Parameter | Description |
---|---|
| Specifies database Globalization Support character set to use. This parameter can be set only when you create the database. |
| Specifies size in bytes of standard Oracle Database blocks. |
| Specifies name of the database to be created. Database name is a string of eight characters or less. You cannot change the name of a database. |
Footnote 1 Not an initialization parameter, but rather a clause in the CREATE
DATABASE
statement. See Chapter 3, "Postinstallation Database Creation on Windows" for an example of using this clause.
Use size guidelines in this section to calculate Oracle Database limits.
Table 13-3 Block Size Guidelines
Type | Size |
---|---|
Maximum block size | 16,384 bytes or 16 kilobytes (KB) |
Minimum block size | 2 kilobytes (KB) |
Maximum blocks for each file | 4,194,304 blocks |
Maximum possible file size with 16 K sized blocks | 64 Gigabytes (GB) (4,194,304 * 16,384) = 64 gigabytes (GB) |
Table 13-4 Maximum Number of Files for Each Database
Block Size | Number of Files |
---|---|
2 KB | 20,000 |
4 KB | 40,000 |
8 KB | 65,536 |
16 KB | 65,536 |
Type | Size |
---|---|
Maximum file size for a FAT file | 4 GB |
Maximum file size in NTFS | 16 Exabytes (EB) |
Maximum database size | 65,536 * 64 GB equals approximately 4 Petabytes (PB) |
Maximum control file size | 20,000 blocks |
Table 13-6 Shadow Process Memory
Release Number | Memory |
---|---|
Oracle9i release 2 (9.2) | 444 KB |
Oracle9i release 1 (9.0.1) | 444 KB |
Oracle8i release 8.1.7 | 335 KB |
Oracle8i release 8.1.6 | 335 KB |
Oracle8 release 8.1.3 | 265 KB |
Oracle8 release 8.0.5 | 254 KB |
Oracle8 release 8.0.4 | 254 KB |
This chapter describes use of the registry for various Oracle Database for Windows components. It also lists recommended values and ranges for configuration parameters.
This chapter contains these topics:
Oracle Database for Windows uses configuration parameters to locate files and specify runtime parameters common to all Oracle products. When an Oracle program or application requires a translation for a particular configuration variable, Oracle Database for Windows uses the associated parameter. All Oracle parameters are stored in the registry.
Oracle Database for Windows stores its configuration information in a repository (the registry) that is organized in a tree format. The tree format consists of keys in the registry and parameter values for the keys. Keys and parameter values can be viewed and modified in Registry Editor.
Keys are folders that appear in the left pane of a Registry Editor window. A key contains subkeys or parameters.
Caution: Although Registry Editor lets you view and modify registry keys and parameter values, you normally are not required to do so. In fact, you can render your system useless if you make incorrect changes. Therefore, only advanced users should edit the registry! Back up your system before making any changes in the registry. |
Parameters in Registry Editor appear as a string, consisting of three components:
For example, parameter ORACLE_SID
can have the following entry in the registry:
Value classes for Oracle Database for Windows parameters are:
REG_SZ
, REG_EXPAND_SZ
(for an expandable string), or a REG_MULTI_SZ
(for multiple strings) prefix to identify a parameter value entry as a data string REG_DWORD
prefix to identify a value entry as a dword
(hexadecimal data) entry Most Oracle Database for Windows parameter values are string types. Use Oracle Universal Installer defaults when a type is not given.
This section describes Oracle Database for Windows registry parameters for the following keys. Other products, such as Oracle Enterprise Manager, have additional keys and parameters that are not described in this chapter.
Note: Oracle Database for 64-bit Windows has additional configuration parameters that enable and control large page support. See "Large Page Support". |
To modify these registry values, see "Managing Registry Parameters with regedit".
Each time you install Oracle products into a new Oracle home on your computer, HKEY_LOCAL_MACHINE\SOFTWARE\ORACLE\KEY_
HOME_NAME
is created. This subkey contains parameter values for most Oracle products.
Note: See Appendix B, "Optimal Flexible Architecture", in Oracle Database Installation Guide for Microsoft Windows x64 for details on the PATH variable and registry values when you are working with multiple Oracle homes. |
HKEY_LOCAL_MACHINE\SOFTWARE\ORACLE\HKEY_LOCAL_MACHINE\SOFTWARE\ORACLE\KEY_
HOME_NAME
includes the following parameters for an Oracle home directory. Depending on products you install, additional parameters can also be created. See your Windows development manuals.
Specifies the location of Windows help files. The default value is
Specifies supported language, territory, and character set. This parameter specifies the language in which messages appear, the territory and its conventions for calculating week and day numbers, and the character set displayed. Oracle Universal Installer sets this value during installation based on the language setting of the operating system. See Oracle Database Globalization Support Guide for a list of values.
Specifies current working directory. For example, if you set this parameter and then use ORADIM, a log file called oradim.log
is created in this directory. This parameter must be manually set.
Starts Oracle Database when OracleService
SID
service is started. The default value is true.
Specifies full path to initialization parameter file. The default value is ORACLE_BASE
\admin\DB_NAME\pfile\init.ora
When set to true
, the default value, this parameter shuts down the instance of Oracle Database identified by SID
when OracleService
SID
is stopped manually—using either the Control Panel or Net stop command.
Sets maximum time (in seconds) to wait for shutdown to complete before the service for a particular SID stops. The default value is 30
.
Specifies mode in which Oracle Database is shut down when you stop OracleService
SID
. Valid values are a
(abort), i
(immediate), and n
(normal). The default value is i
.
Specifies location of time zone file. Each file contains:
In previous releases, the default value for ORA _TZFILE
was
Beginning with Oracle Database 10g Release 1 (10.1), the default value is
The former default, timezone.dat
, contains most commonly used time zones and is smaller for better database performance. The new default, timezlrg.dat
, includes time zones not defined in the smaller file. To enable use of the smaller file, the database administrator must:
ORA_TZFILE
to the full path name of the location of timezone.dat
file. To view time zone names, use SQL*Plus to make the following query:
If the larger timezlrg.dat
file is used, then it must stay in use unless the user is sure that no data uses one of the added time zones. Also, all databases that share information must use the same time zone file.
See Also: Oracle Database Globalization Support Guide for lists of time zone names for both time zone files |
Specifies Windows processor affinity of each thread within the Oracle Database process. This parameter must be manually added. Oracle recommends consulting Oracle Support Services before changing this parameter. The format is:
Each name
setting must be the name of a background thread, user
for non-background (shadow) threads, or def
for any thread type not handled specifically.
The name
mask sets the affinity mask of the Oracle Database process. Valid background thread names include DBW0
, LGWR
, PMON
, SMON
, ARCH
, RECO
, CKPT
, TRWR
, SNP0
through SNP9
, P000
through P481
, and any other name found in the NAME
column of the v$bgprocess
data dictionary view.
Each affinity setting must be a valid affinity mask (or its numeric equivalent) for the corresponding name. Process affinity masks are used only when Oracle services are first started. Each thread's affinity is set only when the individual thread is started (for example, at database startup time for the background threads).
Specifies the top-level Oracle directory (for example, C:\oracle\product\10.2.0
) that contains ORACLE_HOME
, admin
, and oradata
. The default is ORACLE_BASE
.
Specifies the name of the group containing icons of the Oracle products installed. The parameter is added to your registry when you first install Oracle products, even if Oracle Universal Installer does not create a program group for Oracle products you have installed (for example, if you have installed only Oracle Net software). The default value is Oracle
-
HOME_NAME
.
Specifies Oracle home directory in which Oracle products are installed. This directory is immediately beneath the Oracle base directory in the Oracle directory hierarchy. The default value is the drive letter and name that you specify during installation.
The HKEY_LOCAL_MACHINE
location of Oracle parameters. The default value is software\oracle\HOME
ID.
Specifies home name of Oracle home directory in which Oracle products are installed. The default value is the name that you specify during installation.
Determines Windows scheduling priorities of threads within the Oracle Database management system process. The format is:
The name
class sets the priority
class of the Oracle Database process. Threads can be assigned priority either collectively or individually. The collective name user
designates non-background (shadow) threads; the collective name def
designates any thread type not handled specifically. Valid individual background thread names include DBW0
, LGWR
, PMON
, SMON
, ARCH0
, RECO
, CKPT
, TRWR
, SNP0
through SNP9
, and any other name found in the NAME
column of the v$bgprocess
data dictionary view.
The default value is class:normal; def:normal
.
Note: ORACLE_PRIORITY is not automatically created for you in the registry. When it is not defined in the registry, Windows default values are used for thread priorities. |
Specifies the name of the Oracle Database instance on the host computer. The value of this parameter is the SID for the instance. The default value is specified by the entry in the Database Identification window of Oracle Universal Installer.
Enables user authentication. When it is set to true
, it enables the server to differentiate between one username and another, whether they are local users, domain users, or domain users on another domain in your network. When it is set to false
, the domain is ignored, and the local user becomes the default value of the operating system user returned to the server. The default value is true
.
Enables client users to access Oracle Database as X.509-compliant enterprise users. This parameter is required only if you want to use enterprise users and roles in an Oracle Database computer running in a Windows 2000 domain. The default value is false
.
Specifies the location of backup database files. The default value is ORACLE_BASE
\
ORACLE_HOME
\database\archive
.
Specifies the location of backup database control files. The default value is ORACLE_BASE
\
ORACLE_HOME
\database
.
This subkey contains the following parameters:
HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet
contains four keys:
The first three are used by the operating system. You can edit only the Services
subkey, which contains:
Oracle Counters for Windows Performance Monitor parameters appear in:
where ORACLE
ver
refers to whatever version of Oracle Database is installed.
For multiple Oracle homes compliance starting with Oracle Database 10g Release 1 (10.1), parameters Hostname
, Username
, Password
, LOGFILE
, and PERF_FILE_NAME
have been moved to
Note: Modify only theHostname , Password , and Username values to point to any database. Oracle recommends that you use operfcfg . See "Using operfcfg". |
For Oracle Counters for Windows Performance Monitor to display information for Oracle Database performance objects, it must log in to the database. Modify the following parameters if the default information is not applicable or if you want to access another database:
Hostname
displays the SID of the database that Oracle Counters for Windows Performance Monitor will connect to. The default value is blank, causing Oracle Counters for Windows Performance Monitor to connect to the default database on the computer. If you specify a different SID, you must also add a connect descriptor for that SID to your tnsnames.ora
file. Oracle recommends that you use Oracle Net Configuration Assistant, but you can also copy, paste, and modify the following example:
Password
displays the encrypted password for the username to access the database. The default value is MANAGER
(encrypted). Username
displays the username to access the database. The default value is SYSTEM
. Oracle Counters for Windows Performance Monitor requires the following parameters as entry points:
Close
specifies the close entry point for the DLL. The default value is CloseOracle
ver
PerformanceData
. Collect
specifies the collect entry point for the DLL. The default value is CollectOracle
ver
PerformanceData
. Library
specifies the name of the Oracle Counters for Windows Performance Monitor DLL. The default value is ORAPERF
ver
.dll
Open
specifies the open entry point for the DLL. The default value is OpenOracle
ver
PerformanceData
. The following parameters specify Oracle Counters for Windows Performance Monitor log file and object configuration files:
LOGFILE
specifies the name of the Oracle Counters for Windows Performance Monitor log file. This log file reports any errors, such as Oracle Database objects not appearing or database access problems. The default value is ORACLE_BASE
\
ORACLE_HOME
\dbs\operf
ver
.log
. PERF_FILE_NAME
specifies the location of the PERF
ver
.ora
file, which contains all performance objects displayed by Oracle Counters for Windows Performance Monitor. The default value is ORACLE_BASE
\
ORACLE_HOME
\dbs\perf
ver
.ora
HKEY_LOCAL_MACHINE\SYSTEM\CURRENTCONTROLSET\SERVICES
subkey contains additional subkeys that correspond to each Oracle Database service.
Each service subkey contains the following parameters:
DisplayName
specifies the service name of the instance whose SID
is SID
. The default value is the name of the service. For example, OracleServiceORCL1
, where ORCL1
is the SID
. ImagePath
specifies the fully qualified path name of the executable started by the service and any command-line arguments passed into the executable at runtime. The default value is the path to the executable file of the product. ObjectName
specifies the logon user account and computer to which the service should log on. The default value is LocalSystem
. Oracle Real Application Clusters registry values are based on the clusterware. If you are not using the clusterware, then some of this information may not be applicable to your particular cluster environment.
Note: Oracle Real Application Clusters is not supported on Windows XP and Windows Vista. |
This subkey contains the following values:
OCRROOT
points to the location of the Oracle Cluster Registry file LOCAL_ONLY
which is set to False
for a cluster installation and True
for a single-instance database installation Caution: Do not edit your registry unless absolutely necessary. If an error occurs in your registry, then Oracle Database for Windows can stop functioning, and the registry itself can become unusable. |
To edit Oracle-related settings:
>
Run, enter regedit
in the Open field, and click OK. The Registry Editor window appears.
The left-hand side of the window shows the hierarchy of registry keys, and the right-hand side of the window shows various values associated with a key.
The String Editor dialog appears:
To add a parameter to the registry:
>
Run, enter regedit
in the Open field, and click OK. The Registry Editor window appears.
The Add Value dialog appears:
REG_SZ
, REG_EXPAND_SZ
(for an expandable string), or REG_MULTI_SZ
(for multiple strings) for a data string REG_DWORD
prefix to identify a value entry as a DWORD
(hexadecimal data) entry The String Editor dialog appears:
Registry Editor adds the parameter.
Instead of using regedit
to add, edit, and delete parameters for an Oracle home, you can use the Oracle Home Configuration snap-in, one of several snap-ins included as part of Oracle Administration Assistant for Windows. You must have Microsoft Management Console on your computer to use this product.
See Also: "HKEY_LOCAL_MACHINE\SOFTWARE\ORACLE\KEY_HOME_NAME" for more information about Oracle home parameters |
To start Oracle Administration Assistant for Windows:
>
Programs >
Oracle - HOME_NAME >
Configuration and Migration Tools >
Administration Assistant for Windows. Oracle Administration Assistant for Windows starts.
To add an Oracle home parameter:
The Add Value dialog appears.
Note: With Oracle Administration Assistant for Windows, you can add parameters only with a datatype ofREG_SZ . Use regedit to add parameters with a datatype of REG_EXPAND_SZ , REG_MULTI_SZ , or REG_DWORD . |
To change the default SID, select the SID from the Default SID list in the Properties dialog. To edit one of the other parameters:
The Edit Value dialog appears.
To delete an Oracle home parameter:
Instead of using regedit
to modify Oracle Counters for Windows Performance Monitor's Hostname
, Password
, and Username
parameters, you can use operfcfg
or Oracle Administration Assistant for Windows.
See Also: "Parameters for Oracle Counters for Windows Performance Monitor" for more information aboutHostname , Password , and Username parameters |
operfcfg
is an Oracle Database tool that you run from the command prompt. You must specify the system password by running operfcfg.exe
, located in the ORACLE_HOME\
bin
directory. operfcfg.exe
prompts for a user name, password, and TNS alias.
For example:
If you run the following command, then operfcfg.exe
does not prompt for a password:
The -U
and -D
commands are optional.
The following examples illustrate the use of operfcfg
. First, to change user name to dba_admin
and leave database name at its current value, enter:
To change username to dba_admin
and database name to prod
, enter:
In the final example, you change host name
to a blank value, causing Oracle Counters for Windows Performance Monitor to connect to the default database on the computer. The current user name and password must be valid user accounts on this database. Enter:
Oracle Counters for Windows Performance Monitor snap-in is part of Oracle Administration Assistant for Windows. You must have Microsoft Management Console on your computer in order to use this product.
To use Oracle Counters for Windows Performance Monitor snap-in:
>
Programs > Oracle - HOME_NAME >
Configuration and Migration Tools >
Administration Assistant for Windows. Oracle Administration Assistant for Windows starts.
The Performance Monitor Properties dialog appears.
This chapter points to sources of information about developing applications for Windows and outlines a procedure for building and debugging external procedures.
This chapter contains these topics:
This section describes where to find information about developing applications specifically for Windows. These products are included on your Oracle Database Server CD-ROM.
Oracle Database includes an integrated Java Virtual Machine and JServer Accelerator. Oracle Database also provides Oracle Java Database Connectivity (JDBC) Drivers. For more information, see Oracle Database Java Developer's Guide.
Oracle Data Provider for .NET (ODP.NET) is an implementation of a data provider for Oracle Database. ODP.NET uses Oracle native APIs to offer fast and reliable access to Oracle data and features from any .NET application. ODP.NET also uses and inherits classes and interfaces available in the Microsoft .NET Framework Class Library. For more information:
Note: Oracle Data Provider for .NET is supported on Microsoft Windows (x64) starting with the 10.2.0.3 release. |
Oracle XML products include XML Developer's Kit (XDK) and Oracle XML SQL Utility. For more information:
Oracle Database support for internet applications includes Oracle Portal, which enables you to publish your data to the Web, Oracle HTTP Server, and PL/SQL Embedded Gateway, which offers PL/SQL procedures stored in Oracle Database that can be started through browsers. For more information:
Note: Oracle Portal and Oracle HTTP Server are not supported on Oracle Database for Microsoft Windows (x64). |
Oracle COM Automation feature enables Java stored procedure developers and COM/COM+ developers to load COM+ objects from an Oracle Database. For more information:
Oracle Objects for OLE (OO4O) provides easy access to data stored in Oracle Database servers with any programming or scripting language that supports the Microsoft COM Automation and ActiveX technology. These include Visual Basic, Visual C++, Visual Basic For Applications (VBA), IIS Active Server Pages (VBScript and JavaScript), and others. For more information:
Note: Oracle Objects for OLE (OO4O) is not supported on Oracle Database 10g Release 2 (10.2) for 64-bit Windows. |
Oracle Database for Windows permits enhanced deployment of COM/COM+ components in Microsoft Transaction Server, using Oracle Database as the resource manager. For more information:
Oracle Provider for OLE DB is an OLE DB data provider that offers high performance and efficient access to Oracle data by OLE DB and ADO consumers.
Open Database Connectivity (ODBC) provides a common C programming interface for applications to access data from database management systems. Access to databases is managed by the ODBC Driver Manager. The driver manager provides the linkage between an ODBC application and an ODBC driver for a specific database management system.
Oracle ODBC Driver provides access to Oracle databases for applications written using the ODBC interface.
Oracle Technology Network has both Oracle home based ODBC driver and Instant Client enabled ODBC driver.
Note: Download Instant Client enabled ODBC driver from |
Oracle Database provides a comprehensive set of APIs for Windows application developers and is well suited for both Java, .NET, and COM/COM+ development. Oracle Database is integrated with Microsoft's development and deployment components. Performance and data access on Windows is enhanced in the following areas:
Developers are able to deploy their database applications more quickly by using the data access method with which they are familiar, rather than having to learn a new one. An Oracle Database server can communicate with Windows clients in a variety of methods, as described in Table 15-1.
Table 15-1 Oracle Data Access Methods
Development Environment | Data Access Method |
---|---|
Java | JDBC SQLJ |
.NET | ODP.NET |
COM/COM+ | Oracle Provider for OLE DB COM/COM+ Automation Feature |
By using Oracle Database data access interfaces, developers can take advantage of specific Oracle Database features. These interfaces also offer flexibility and adherence to open standards.
Use Oracle 64-bit components to create your applications. To migrate your business logic, refer to Migration Tips on the Microsoft Developer Network (MSDN) Web site at http://msdn.microsoft.com/en-us/library/aa384214(VS.85).aspx
.
Note: NCHAR columns in user tables are not changed during the migration. To change NCHAR columns in user tables, refer to "Upgrade User NCHAR Columns" in Oracle Database Upgrade Guide. |
This section describes how to create and use external procedures on Windows. The following files are located in ORACLE_BASE
\
ORACLE_HOME
\rdbms\extproc
:
extern.c
is the code example shown in "Writing an External Procedure" make.bat
is the batch file that builds the dynamic link library extern.sql
automates the instructions described in "Registering an External Procedure" and "Executing an External Procedure" External procedures are functions written in a third-generation language (C, for example) and callable from within PL/SQL or SQL as if they were a PL/SQL routine or function. External procedures let you take advantage of strengths and capabilities of a third-generation programming language in a PL/SQL environment.
Note: Oracle Database also provides a special purpose interface, the call specification, that lets you call external procedures from other languages, as long as they are callable by C. |
The main advantages of external procedures are:
You can use external procedures to perform specific processes:
Caution: Special security precautions are warranted when configuring a listener to handle external procedures. See "Modifying Configuration of External Procedures for Higher Security" and Oracle Database Net Services Administrator's Guide for more information. |
To create and use an external procedure, perform the following sequential steps:
Note: You must have a C compiler and linker installed on your system to build DLLs. |
Note: You can combine the instructions described in the fourth and fifth tasks into one SQL script that automates the task of registering and executing your external procedure. SeeORACLE_BASE \ ORACLE_HOME \rdbms\extproc\extern.sql for an example of a SQL script that combines these steps. |
This section describes installation and configuration of Oracle Database and Oracle Net.
Follow the steps in Oracle Database Installation Guide for Microsoft Windows x64 to install these products on your Windows server:
During database server installation, Oracle Net Configuration Assistant configures listener.ora
and tnsnames.ora
files for external procedure calls.
When an application calls an external procedure, Oracle Net Listener starts an external procedure agent called EXTPROC. Using a network connection established by the listener, the application passes the following information to EXTPROC:
EXTPROC then loads the DLL, runs the external procedure, and passes back any values returned by the external procedure.
If you overwrite default listener.ora
and tnsnames.ora
files, then you must manually configure the following files for the external procedure behavior described previously to occur:
ORACLE_BASE
\
ORACLE_HOME
\network\admin\listener.ora
ORACLE_BASE
\
ORACLE_HOME
\network\admin\tnsnames.ora
Caution: Additional security may be required for the listener in a production environment. See Oracle Database Net Services Administrator's Guide for more information. |
Using a third-generation programming language, you can write functions to be built into DLLs and started by EXTPROC. The following is a simple Microsoft Visual C++ example of an external procedure called FIND_MAX
:
Note: Because external procedures are built into DLLs, they must be explicitly exported. In this example, theDLLEXPORT storage class modifier exports the function FIND_MAX from a dynamic link library. |
After writing your external procedure(s) in a third-generation programming language, use the appropriate compiler and linker to build a DLL, making sure to export the external procedures as noted previously. See your compiler and linker documentation for instructions on building a DLL and exporting its functions.
You can build the external procedure FIND_MAX
, created in "Writing an External Procedure", into a DLL called extern.dll
by going to ORACLE_BASE
\
ORACLE_HOME
\rdbms\extproc
and typing make
. After building the DLL, you can move it to any directory on your system.
Starting with Oracle9i release 2, however, the default behavior of EXTPROC is to load DLLs only from ORACLE_HOME
\bin
or ORACLE_HOME
\lib
. To load DLLs from other directories, you must set environment variable EXTPROC_DLLS
to a colon (:) separated list of DLL names qualified with their complete paths. The preferred way to set this environment variable is through the ENVS
parameter in listener.ora
.
See Also: Oracle Database Application Developer's Guide - Fundamentals for more information about EXTPROC |
Once you have built a DLL containing your external procedure(s), you must register your external procedure(s) with Oracle Database:
To create a PL/SQL library to map to the DLL:
EXTPROC_DLLS
in the ENVS
parameter in listener.ora
. For example: CREATE LIBRARY
command: where externProcedures
is an alias library (essentially a schema object in the database), and
is the path to the Windows operating system dllextern.dll
. This example uses C:\oracle\product\10.2.0
as your Oracle base and db_1
as your Oracle home.
Note: The DBA must grant theEXECUTE privilege on the PL/SQL library to users who want to call the library's external procedure from PL/SQL or SQL. |
Do this by writing a PL/SQL subprogram that uses the EXTERNAL
clause instead of declarations and a BEGIN...END
block. The EXTERNAL
clause is the interface between PL/SQL and the external procedure. The EXTERNAL
clause identifies the following information about the external procedure:
In the following example, externProcedures
is a DLL alias. You need the EXECUTE
privilege for this library. The external procedure to call is find_max
. If enclosed in double quotation marks, it becomes case-sensitive. The LANGUAGE
term specifies the language in which the external procedure was written.
To run an external procedure, you must call the PL/SQL program unit (that is, the alias for the external function) that registered the external procedure. These calls can appear in any of the following:
In "Registering an External Procedure", PL/SQL function PLS_MAX
registered external procedure find_max
. Follow these steps to run find_max
:
PLS_MAX
from a PL/SQL routine named UseIt
: An agent process is started for each session to access a system at the same time leading to several thousand agent processes running concurrently. The agent processes operate regardless of whether each individual agent process is actually active at the moment. Agent processes and open connections can consume a disproportionate amount of system resources. This problem is addressed by using multithreaded agent architecture.
The multithreaded agent architecture uses a pool of shared agent threads. The tasks requested by the user sessions are put in a queue and are picked up by the first available multithreaded agent thread. Because only a small percentage of user connections are active at a given moment, using a multithreaded architecture allows for more efficient use of system resources.
See Also:
|
Usually, when an external procedure fails, its C prototype is faulty. That is, the prototype does not match the one generated internally by PL/SQL. This can happen if you specify an incompatible C datatype. For example, to pass an OUT
parameter of type REAL
, you must specify float
*
. Specifying float
, double
*
, or any other C datatype will result in a mismatch.
In such cases, you might get a lost
RPC
connection
to
external
procedure
agent
error, which means that agent extproc
terminated abnormally because the external procedure caused a core dump. To avoid errors when declaring C prototype parameters, refer to Oracle Database Data Cartridge Developer's Guide.
To help you debug external procedures, PL/SQL provides utility package DEBUG_EXTPROC. To install the package, run script dbgextp.sql
, which you can find in the PL/SQL demo directory.
To use the package, follow instructions in dbgextp.sql
. Your Oracle Database account must have EXECUTE
privileges on the package and CREATE
LIBRARY
privileges.
To debug external procedures:
If you have built your DLL in a debug fashion with Microsoft Visual C++, then Visual C++ is activated.
>
Breakpoints. Use the breakpoint identified in dbgextp.sql
in the PL/SQL demo directory.
See Also:
|
Package UTL_FILE
allows your PL/SQL programs to read and write operating system text files. It provides a restricted version of standard operating system stream file I/O, including open, put, get, and close operations. When you want to read or write a text file, you call the function fopen
, which returns a file handle for use in subsequent procedure calls. For example, the procedure put_line
writes a text string and line terminator to an open file, and the procedure get_line
reads a line of text from an open file into an output buffer.
FSEEK
, a UTL_FILE
subprogram, adjusts the file pointer forward or backward within the file by the number of bytes specified. In order for UTL_FILE.FSEEK
to work correctly, the lines in the file must have platform-specific line terminator characters. On Windows platforms the correct line terminator characters are <CR><LF>
.
This section discusses the following topics:
You must add a parameter to the registry before using Intercartridge Exchange.
The Registry Editor window appears.
HTTP_PROXY
to the registry subkey of the Oracle home directory that you are using. The location of this parameter is determined by how many Oracle home directories are on your computer. If you have only one home directory, add HTTP_PROXY
to If you have multiple home directories, add it to
The Add Value dialog appears.
HTTP_PROXY
in the Value Name field and REG_SZ
in the Data Type field. www-proxy.
your-site
in the String field. In this example, the Web site is marketing.com
. You will enter the domain name of your actual Web site.
Intercartridge Exchange enables you to use a stored package called UTL_HTTP
to make Hypertext Transfer Protocol (HTTP) calls from PL/SQL, SQL, and SQL*Plus statements.
UTL_HTTP
can do both of the following:
UTL_HTTP
contains two similar entry points, known as packaged functions, that turn PL/SQL and SQL statements into HTTP callouts:
UTL_HTTP.REQUEST
UTL_HTTP.REQUEST_PIECES
Both packaged functions perform the following tasks:
Declarations to use with both packaged functions are described in the following subsections.
UTL_HTTP.REQUEST
uses a URL as its argument and returns up to the first 2000 bytes of data retrieved from that URL. Specify UTL_HTTP.REQUEST
as follows:
To use UTL_HTTP.REQUEST
from SQL*Plus, enter:
which returns:
UTL_HTTP.REQUEST_PIECES
uses a URL as its argument and returns a PL/SQL table of 2000 bytes of data retrieved from the given URL. The final element can be shorter than 2000 characters. The UTL_HTTP.REQUEST_PIECES
return type is a PL/SQL table of type UTL_HTTP.HTML_PIECES
.
UTL_HTTP.REQUEST_PIECES
, which uses type UTL_HTTP.HTML_PIECES
, is specified as:
A call to REQUEST_PIECES
can look like this example. Note the use of PL/SQL table method COUNT
to discover the number of pieces returned; it can be zero or more:
The second argument to UTL_HTTP.REQUEST_PIECES
(MAX_PIECES
) is optional. MAX_PIECES
is the maximum number of pieces (each 2000 characters in length, except for the last, which can be shorter) that UTL_HTTP.REQUEST_PIECES
returns. If provided, that argument is usually a positive integer.
For example, the following block retrieves up to 100 pieces of data (each 2000 bytes, except perhaps the last) from the URL. The block prints the number of pieces retrieved and the total length, in bytes, of the data retrieved.
Elements of the PL/SQL table returned by UTL_HTTP.REQUEST_PIECES
are successive pieces of data obtained from the HTTP request to that URL.
This subsection describes exceptions (errors) that can be raised by packaged functions UTL_HTTP.REQUEST
and UTL_HTTP.REQUEST_PIECES
.
PRAGMA
RESTRICT_REFERENCES
enables display of exceptions:
PRAGMA
RESTRICT_REFERENCES
enables display of exceptions:
If initialization of the HTTP callout subsystem fails for environmental reasons (such as lack of available memory), then exception UTL_HTTP.INIT_FAILED
is raised:
If the HTTP call fails due to failure of the HTTP daemon or because the argument to REQUEST
or REQUEST_PIECES
cannot be interpreted as a URL (because it is NULL
or has non-HTTP syntax), then exception UTL_HTTP.REQUEST_FAILED
is raised:
Unless explicitly caught by an exception handler, these first two exceptions are reported by a generic message that shows them as "user-defined" exceptions, even though they are defined in this system package:
If any other exception is raised during processing of the HTTP request (for example, an out-of-memory error), then function UTL_HTTP.REQUEST
or UTL_HTTP.REQUEST_PIECES
reraises that exception.
If no response is received from a request to the given URL, because the function made no contact with a site corresponding to that URL, then a formatted HTML error message may be returned:
If UTL_HTTP.REQUEST
or UTL_HTTP.REQUEST_PIECES
raises an exception or returns an HTML-formatted error message, yet you believe that the URL argument is correct, try contacting that same URL with a browser to verify network availability from your computer.
The Oracle Database Online Documentation Library CD-ROM for Windows is not shipped with Oracle Database for 64-bit Windows. Everything in the library is available for download from the Oracle Technology Network (OTN) at http://www.oracle.com/technetwork/indexes/documentation/index.html
You must register online before using OTN; registration is free and can be done at http://www.oracle.com/technetwork/index.html
.
This appendix describes how to configure your system to store datafiles for a tablespace on raw partitions.
This appendix contains these topics:
Note: Oracle Real Application Clusters require additional configuration tools. See Oracle Database Oracle Clusterware and Oracle Real Application Clusters Administration and Deployment Guide for information about creating logical partitions and assigning symbolic links. Do not use this appendix to create partitions for Oracle Real Application Clusters. |
Datafiles for tablespaces can be stored on a file system or on raw partitions. A raw partition is a portion of a physical disk that is accessed at the lowest possible level. Input/output (I/O) to a raw partition offers approximately a 5% to 10% performance improvement over I/O to a partition with a file system on it.
To create a raw partition, you must first generate an extended partition and a logical partition. An extended partition points to raw space on the disk that can be assigned multiple logical partitions for database files. An extended partition also avoids the four-partition limit by letting you define large numbers of logical partitions to accommodate applications using the Oracle Database server. Logical partitions can then be given symbolic link names to free up drive letters.
On Windows Vista, Windows Server 2008, and Windows 2008 R2, create primary partitions and logical drives in extended partitions by right-clicking in the unallocated space for the disk and selecting the New Simple Volume option. To create a raw device, select Do not assign a drive letter or drive path. To mount the raw device, assign and remove a drive letter. Do not use spanned volumes or striped volumes. These options will convert the volume to a dynamic disk. Automatic Storage Management does not support dynamic disks.
A physical disk represents the entire disk and points to the following:
Symbolic link name \\.\PhysicalDrive
x
is automatically defined by Windows for every hard disk in the computer. For example, a computer with three hard disks will have the following symbolic links:
Internally, these names expand to the following:
Partition0
is special, because it represents the entire physical disk regardless of any partitioning scheme on that disk. Windows writes a signature on the first block of all disks it recognizes. To avoid overwriting that block, Oracle Database skips the first block of a physical raw partition that is used for an Oracle Database datafile.
Note: Although you can use physical disks, Oracle recommends that you use logical partitions. |
Logical partitions point to drives other than \Device\Harddisk
x
\Partition0
. They are initially assigned names with drive letters (\\.\
drive_letter
:) and typically re-assigned symbolic link names (\\.\
symbolic link name
). For example, \\.\D
: may be assigned a symbolic link name of \\.\ACCOUNTING_1
. Regardless of whether a drive letter or symbolic link name is used, logical partitions are defined to represent a specific partition in a disk rather than the entire disk. Internally, these names can expand to:
Note: Oracle Database does not skip the first block of a logical raw partition used for an Oracle Database datafile. |
Consider the following when deciding which raw partition to use:
Partition0
. Partition0
) for an Oracle Database datafile and using a partition that occupies the entire disk for an Oracle Database datafile are not the same thing. Even when a partition occupies the entire disk, there is still a small space on the disk that is not part of the partition. Partition0
), then use the pre-defined physical raw names that Windows provides. Note: For both physical and logical raw conventions, use OCOPY to transfer the contents of a raw partition to a standard file system for backup purposes. |
You can create logical partitions, but define physical disk convention names for them. For example:
Oracle Database then handles datafiles using the physical disk convention even though it really is a logical partition. This will not cause any data corruption or loss as long as you continue to use physical disk naming conventions. Oracle recommends that you convert to the logical partition at your earliest convenience.
You can also create logical names representing Partition0
, but this is definitely not recommended. For example:
This poses severe problems, because Disk Management typically writes a signature into the first block of every disk, and consequently may overwrite a portion of the datafile header. It can also cause data loss. Never use Partition0
with the logical partition convention.
Physical and logical partition conventions are not compatible with one another because of the extra block that is skipped for physical raw conventions. This also means you cannot simply use OCOPY to copy from a physical disk to a logical partition, because contents of these partitions are incompatible.
To convert from a physical convention to a logical convention, you must:
If your database installation uses physical disk conventions with logical partitions, Oracle recommends converting to the logical partition conventions at your earliest convenience, using the preceding steps.
See Also: Your operating system documentation for information about creating extended and logical partitions |
To create a tablespace using a datafile located in a raw partition:
where password
for user account SYSTEM is MANAGER
by default. If you have changed this password, substitute the correct password for MANAGER
.
Create the tablespace:
'\\.\
datafile' SIZE xm;where:
tablespace
is the tablespace name '\\.\'
is the drive letter or symbolic link name assigned to the raw partition x
is the tablespace size in megabytes (Twenty megabytes is a good starting place.) For example, to create a tablespace named accounting_1
that was assigned a symbolic link name of accounting_1
, enter the following:
Note: If you are creating a database with theSQL script, modify datafiles that are stored on raw partitions with a naming convention of \\.\drive_letter: or \\.\symbolic link name . |
To use Automatic Storage Management with direct attached storage (DAS) or storage area network (SAN) storage, the disks must be stamped with a header by asmtool
or asmtoolg
(GUI version).
See Also: "Manually Configuring Disks for Automatic Storage Management" in Oracle Database Installation Guide for Microsoft Windows x64 for instructions on usingasmtool or asmtoolg |
Each DAS or SAN disk must have a partition table. Oracle recommends creating exactly one partition for each disk containing the entire disk. Use Microsoft Computer Management or the command line tool diskpart
to create the partition. Once the partitions have been created, run asmtoolg
or asmtool
. These tools associate meaningful, persistent names with disks to facilitate using those disks with Automatic Storage Management. Automatic Storage Management uses disk strings to more easily operate on groups of disks at once, so the names created by asmtool
make this easier than using Windows drive letters.All disk names created by asmtool
begin with the prefix ORCLDISK
for identification purposes.
Automatic Storage Management uses the value of initialization parameter ASM_DISKSTRING
as its search path when it discovers disks. The default value of ASM_DISKSTRING
is \\.\ORCLDISK
n
. If you want a different search path, then you must specify a different value for this parameter.
This appendix describes Oracle Net Services configuration for Windows. For more generic information about Oracle Net Services configuration, see Oracle Database Net Services Administrator's Guide.
This appendix contains these topics:
Oracle Database for Windows installations that use Automatic Storage Management (ASM) must use Windows native authentication, which is enabled by default. To ensure that it is, check that the sqlnet.ora
file, by default located in ORACLE_BASE
\
ORACLE_HOME
\network\admin
, has NTS enabled. For example:
The registry contains entries for Oracle Net Services parameters and subkeys. To successfully add or modify Oracle Net Services configuration parameters, you must understand where they are located and the rules that apply to them.
HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services
contains subkeys that correspond to services. Depending on what is installed, your Oracle Net Services consist of all or a subset of the following:
Each service subkey contains the parameters shown in Table C-1.
In Oracle Database 10g Release 1 (10.1) or later, the listener is set to start automatically at system restart. If you intend to use only the listener for all of your databases, ensure that only the Windows service for the listener, as listed in the Control Panel, is set to start automatically.
Oracle usually recommends that you only have a single net listener service running on a Windows computer at any one time. This single listener can support multiple databases. If you need to have two different net listener services running on a Windows computer at the same time, ensure that they are configured to listen on different TCP/IP port numbers.
If the same IP address and port are used for different listeners, you might expect that the second and subsequent listeners would fail to bind. Instead, Windows allows them all to listen on the same IP address and port, resulting in unexpected behavior of the listeners. This is a suspected Windows operating system problem with TCP/IP and has been reported to Microsoft.
You can use the following parameters on Windows:
Oracle Net Service first checks for the parameters as environment variables, and uses the values defined. If environment variables are not defined, it searches for these parameters in the registry.
You can use parameter LOCAL
to connect to Oracle Database without specifying a connect identifier in the connect string. The value of parameter LOCAL
is any connect identifier, such as a net service name. For example, if parameter LOCAL
is specified as finance
, you can connect to a database from SQL*Plus with:
rather than
Oracle Net checks if LOCAL
is defined as an environment variable or as a parameter in the registry, and uses finance
as the service name. If it exists, Oracle Net connects.
You can add parameter TNS_ADMIN
to change the directory path of Oracle Net Services configuration files from the default location of ORACLE_HOME
\network\admin
. For example, if you set TNS_ADMIN
to ORACLE_BASE
\
ORACLE_HOME
\test\admin
, the configuration files are used from ORACLE_BASE
\
ORACLE_HOME
\test\admin
.
The use of shared sockets is enabled by default (USE_SHARED_SOCKET=true
) allowing the network listener to pass the socket descriptor for client connections to the database thread. As a result, the client does not need to establish a new connection to the database thread and database connection time improves. Also, all database connections share the port number used by the network listener, which can be useful if you are setting up third-party proxy servers. Setting USE_SHARED_SOCKET
to false
disables the use of shared sockets.
Note: This parameter only works in dedicated server mode in a TCP/IP environment. To spawn a dedicated server for an instance of Oracle Database not associated with the same Oracle home as the listener and with shared socket enabled, you must also setUSE_SHARED_SOCKET parameter for both the Oracle homes. |
The following sections describe advanced configuration procedures specifically for Oracle Net Services on Windows operating systems.
Oracle Net Services provides authentication methods for Windows operating systems using Windows Native Authentication.
The network listener service may be unable to open the Named Pipe created by Oracle Names unless service Oracle
HOME_NAME
TNSListener
has a valid user ID and password associated with it.
See Also: Your operating system documentation for instructions on setting up network listener permissions |
This section supplements generic information provided in Oracle Database Net Services Administrator's Guide to configure a listener on Windows operating systems to exclusively handle external procedures. For a higher level of security, you are instructed to start the listener for external procedures from a user account with lower privileges than the oracle
user. For Windows operating systems, this requires that you change the user account from LocalSystem to a local, unprivileged user for the OracleHOME_NAMETNSListener
extproc_listener_name service
.
Note: The following instructions assume that you have performed steps 1 through 5 in the section "Modifying Configuration of External Procedures for Higher Security" in Oracle Database Net Services Administrator's Guide. |
To change the listener account:
Note: Ensure that this user account does not have general access to files owned byoracle . Specifically, this user should not have permission to read or write to database files or to the Oracle Database server address space. In addition, this user should have read access to the listener.ora file, but must not have write access to it. |
OracleHOME_NAMETNSListener
extproc_listener_name
. See Also: Your operating system documentation for instructions on accessing the Services dialog and stopping services |
Note: If theOracleHOME_NAMETNSListener extproc_listener_name service does not exist, issue the following command from the command prompt: lsnrctl start extproc_listener_name This creates the |
OracleHOME_NAMETNSListener
extproc_listener_name
service in the Services dialog and then display the properties of the service. Note: You can also useNET START OracleHOME_NAMETNSListener extproc_listener_name to start the listener from the command prompt. Running the listener with lower privileges prevents you from using Listener Control utility SET commands to alter the configuration of this listener in file listener.ora . You can perform other administrative tasks on this listener with the Listener Control utility, including stopping the listener. Oracle recommends that you complete listener.ora file configuration before running the listener. |
This appendix lists error messages, causes, and corrective actions that are specific to operation of Oracle Database for Windows. This appendix also includes database connection issues.
This appendix contains these topics:
Note: Theora.hlp file, which was shipped in previous releases, is no longer available. See this Appendix, Oracle Database Error Messages, and Oracle Enterprise Manager Messages Manual for information about error messages. |
CONNECT INTERNAL
is no longer supported.CONNECT / AS SYSDBA
. If NTS is not enabled, you can connect as CONNECT SYS/password AS SYSDBA
. You can also connect as an existing user with the appropriate password.Error messages in this section are Oracle Database operating system-dependent (OSD) messages displayed in response to an error condition in Windows. Each message in this section triggers an Oracle Database error message.
Error messages appear first in summary tables consisting of error numbers and the corresponding error message. Following the tables is a more detailed discussion of errors, including causes and corrective actions.
File I/O Errors: | OSD-04000 to OSD-04099 |
---|---|
4000 | Logical block size mismatch |
4001 | Invalid logical block size |
4002 | Unable to open file |
4003 | Unable to read file header block |
4004 | Invalid file header |
4005 | SetFilePointer() failure, unable to read from file |
4006 | ReadFile() failure, unable to read from file |
4007 | Truncated read |
4008 | WriteFile() failure, unable to write to file |
4009 | Truncated write |
4010 | <create> option specified, file already exists |
4011 | GetFileInformationByHandle() failure, unable to obtain file info |
4012 | File size mismatch |
4013 | Unable to read line from file |
4014 | Unable to close file |
4015 | An asynchronous I/O request returned an error |
4016 | Error queuing an asynchronous I/O request |
4017 | Unable to open the specified RAW device |
4018 | Unable to access the specified directory or device |
4019 | Unable to set file pointer |
4020 | Unable to set eof file marker |
4021 | Unable to read file |
4022 | Unable to write file |
4023 | SleepEx() failure, unable to Sleep |
4024 | Unable to delete file |
4025 | Invalid question asked |
4026 | Invalid parameter passed |
Memory Errors: | OSD-04100 to OSD-04199 |
---|---|
4100 | malloc() failure, unable to allocate memory |
4101 | Invalid SGA: SGA not initialized |
4102 | Unable to open/create file for shared memory object |
4103 | Unable to attach to SGA: SGA does not exist |
4104 | Unable to map shared memory (SGA) into the address space |
4105 | Shared memory (SGA) mapped to wrong address |
4106 | Unable to allocate memory with VirtualAlloc |
4107 | Unable to deallocate memory with VirtualFree |
4108 | Unable to protect memory with VirtualProtect |
Loader Errors: | OSD-04300 to OSD-04399 |
---|---|
4300 | Unable to read complete record from datafile |
4301 | Record size too large |
4302 | Invalid record type, load options, or both |
Semaphore Errors: | OSD-04400 to OSD-04499 |
---|---|
4400 | Unable to acquire internal semaphore for process |
4401 | WaitForSingleObject() failure, unable to obtain semaphore |
Miscellaneous Errors: | OSD-04500 to OSD-04599 |
---|---|
4500 | Illegal option specified |
4501 | Internal buffer overflow |
4502 | Translations nested too deep |
4503 | Text contains no translatable elements |
4505 | stdin not responding |
4506 | Unable to spawn process via system() |
4510 | Operating system roles are not supported |
4511 | Unable to get date and time from the operating system |
4512 | Unable to translate the 'USERNAME' config.ora variable on server |
4513 | 'remote_os_authent' init.ora variable not set to true |
4514 | The Windows Group name is too long for internal buffer |
4515 | This command is not implemented at this time |
DB_BLOCK_SIZE
in the initialization parameter file.REUSE
option in SQL statement.ORACLE_PRIORITY
ORACLE_PRIORITY
.IDENTIFIED
BY
PASSWORD
' as opposed to 'IDENTIFIED
EXTERNALLY
'.USERNAME
' config.ora variable on serverUSERNAME
' configuration parameter variable on host is not properly set.USERNAME
' variable is set.REMOTE_OS_AUTHENT
' parameter must be set to TRUE
.REMOTE_OS_AUTHENT = TRUE
' in initialization parameter file.ORADIM
is a command-line tool for starting and stopping database instances that is only available on Oracle Database for Windows. It is not available on any other platform.
Oradim Errors | DIM-0000 to DIM-0039 |
---|---|
00000 | ORADIM completed with no errors |
00001 | ORADIM: <command> [options]. Refer to manual. |
00002 | The specified command was invalid. |
00003 | An argument is missing for the parameter |
00004 | SID or service name was not specified. |
00005 | SID with more than 64 characters specified. |
00006 | Missing SID |
00007 | Missing or invalid - STARTMODE parameter. Valid - STARTMODE parameter is AUTO or MANUAL. |
00008 | A valid service name is OracleService appended with a SID |
00009 | SID name is mandatory. |
00010 | SYSTEM\CurrentControlSet\Services\OracleService key does not exist. |
00011 | The specified service does not exist. |
00012 | A PFILE is necessary for AUTOSTART option. |
00013 | Service start mode could not be set in the registry. |
00014 | Cannot open the Windows Service Control Manager. |
00015 | Cannot start already-running ORACLE - shut it down first. |
00016 | Missing or invalid - SHUTTYPE parameter. A valid - SHUTTYPE parameter is SRVC or INST. |
00017 | Instance shutdown mode must be one of the following: a for abort, i for immediate or n for normal. |
00018 | Failed to stop Oracle Service. |
00019 | Create Service Error. |
00020 | A service for this name exists. |
00021 | Registry open failed. |
00023 | Create an instance by specifying the following options: |
00024 | -NEW -SID sid | -SRVC srvc | -ASMSID sid | -ASMSRVC srvc [-SYSPWD pass] |
00025 | [-STARTMODE auto | manual] [-SRVCSTART system | demand] [-PFILE file | -SPFILE] |
00026 | [-SHUTMODE normal | immediate | abort] [-TIMEOUT secs] [-RUNAS osusr/ospass] |
00027 | Edit an instance by specifying the following options: |
00028 | -EDIT -SID sid | -ASMSID sid [-SYSPWD pass] |
00029 | [-STARTMODE auto | manual] [SRVCSTART system | demand] [-PFILE file | -SPFILE] |
00030 | [-SHUTMODE normal | immediate | abort] [-SHUTTYPE srvc | inst] [-RUNAS osusr/ospass] |
00031 | Delete instances by specifying the following options: |
00032 | -DELETE -SID sid | -ASMSID sid | -SRVC srvc | -ASMSRVC srvc |
00033 | Startup services and instance by specifying the following options: |
00034 | -STARTUP -SID sid | -ASMSID sid [-SYSPWD pass] |
00035 | [-STARTTYPE srvc | inst | srvc,inst] [-PFILE filename | -SPFILE] |
00036 | Shutdown services and instance by specifying the following options: |
00037 | -SHUTDOWN -SID sid | -ASMSID sid [-SYSPWD pass] |
00038 | [-SHUTTYPE srvc | inst | srvc,inst] [-SHUTMODE normal | immediate | abort] |
00039 | Query for help by specifying the following parameters: -? | -h | -help |
00040 | Invalid option for the -NEW command. |
00041 | Invalid option for the -EDIT command. |
00042 | Invalid option for the -DELETE command. |
00043 | Invalid option for the -STARTUP command. |
00044 | Invalid option for the -SHUTDOWN command. |
00045 | Internal error in ORADIM. |
00046 | Invalid Pfile. |
00050 | Instance deleted. |
00051 | Instance created. |
00075 | Failed to control service. |
00076 | Failed to delete service. |
00077 | Failed to change service configuration. |
00078 | Failed to start service. |
SID
of 64 characters and retry.The following are common Oracle Database connection error codes, their causes, and suggested remedies.
ORA-09352:
Windows
32-bit
Two-Task
driver
unable
to spawn
new
ORACLE
task
.tnsnames.ora
and listener.ora files have not been correctly configured to use external procedures.tnsnames.ora
and listener.ora files have not been correctly configured to use external procedures.tnsnames.ora
and listener.ora
files have not been correctly configured to use external procedures.tnsnames.ora
and listener.ora
files have not been correctly configured to use external procedures.oradim -delete -sid
sid
where sid
is the name of your database (for example, orcl
). Re-create the SID and services by entering: oradim -new -sid
sid
-startmode auto -pfile
full_path_to_init.ora
This chapter lists major differences between Oracle Database on Windows and UNIX. For Oracle Database developers and database administrators moving from a UNIX platform to Windows, this information can be helpful in understanding Windows features that are relevant to Oracle Database.
This chapter contains these topics:
On UNIX, several files and scripts in different directories are used to start an instance automatically. Other scripts are run on computer shutdown, allowing applications such as Oracle Database to shut down cleanly.
For automatic startup on Windows, set registry parameter ORA_
SID
_AUTOSTART
to true
using an Oracle Database tool such as ORADIM. Enter the following with parameters at the command prompt:
To start the listener automatically, set services startup type to automatic.
For automatic shutdown on Windows, set registry parameters ORA_SHUTDOWN
and ORA_
SID
_SHUTDOWN
to stop the relevant OracleServiceSID and shut down. Set registry parameter ORA_
SID
_SHUTDOWNTYPE
to control shutdown mode (default is i
, or immediate
).
UNIX provides sophisticated control mechanisms for background processing and batch jobs.
For similar functionality on Windows, use the AT command or a GUI version in the Microsoft Resource Kit.
On UNIX, utilities such as sar
and vmstat
are used to monitor Oracle Database background and shadow processes. These utilities are not integrated with Oracle Database.
Performance utilities available on Windows include Oracle Counters for Windows Performance Monitor, Task Manager, Control Panel, Event Viewer, User Manager, and Microsoft Management Console (included only with Windows 2000).
Oracle Database is integrated with several of these tools. For example:
ps -ef
command or HP OpenVMS SHOW SYSTEM
. But Task Manager is easier to interpret and the columns can be customized. On both UNIX and Windows platforms, bypassing the file system buffer cache ensures data is written to disk.
On UNIX, Oracle Database uses the O_SYNC
flag to bypass the file system buffer cache. The flag name depends on the UNIX port.
On Windows, Oracle Database bypasses the file system buffer cache completely.
Shared libraries on UNIX are similar to shared DLLs on Windows. Object files and archive libraries are linked to generate Oracle Database executables. Relinking is necessary after certain operations, such as installation of a patch.
On Windows, Oracle Database DLLs form part of the executable at run time and are therefore smaller. DLLs can be shared between multiple executables. Relinking by the user is not supported, but executable images can be modified using ORASTACK.
Modifying executable images on Windows reduces the chances of running out of virtual memory when using a large SGA or when supporting thousands of connections. However, Oracle recommends doing this only under the guidance of Oracle Support Services.
A (manual) hot backup is equivalent to backing up a tablespace that is in offline backup mode.
Backup strategy on UNIX is as follows: put the tablespace into backup mode, copy the files to the backup location, and bring the tablespace out of backup mode.
Windows supports the same backup strategy, but you cannot copy files in use with normal Windows utilities. Use OCOPY to copy open database files to another disk location. Then use a utility to copy the files to tape.
On UNIX, you can specify multiple database writers' process with initialization parameter DB_WRITERS
. Multiple database writers can help, for example, when a UNIX port does not support asynchronous I/O.
DB_WRITERS
is supported but typically unnecessary on Windows, which has its own asynchronous I/O capabilities.
UNIX uses the concept of a DBA group. The root account cannot be used to install Oracle Database. A separate Oracle Database account must be created manually.
On Windows, Oracle Database must be installed by a Windows username in the Administrators group. The username is automatically added to the Windows local group ORA_DBA
, which receives the SYSDBA privilege. This allows the user to log in to the database using CONNECT
/
AS SYSDBA
and not be prompted for a password.
Password files are located in the ORACLE_BASE
\
ORACLE_HOME
\database
directory and are named pwd
SID
.ora
, where SID
identifies the Oracle Database instance.
The following manual setup tasks, all required on UNIX, are not required on Windows:
The resources provided by the UNIX default kernels are often inadequate for a medium or large instance of Oracle Database. The maximum size of a shared memory segment (SHMMAX
) and maximum number of semaphores available (SEMMNS
) may be too low for Oracle Database recommendations.
On Windows, fewer resources are needed for interprocess communication (IPC), because the Oracle Database relational database management system is thread-based and not process-based. These resources, including shared memory and semaphores, are not adjustable by the user.
UNIX does not support Microsoft Transaction Server.
Windows supports Microsoft Transaction Server beginning with Oracle8. Using Oracle Services for Microsoft Transaction Server, you can develop and deploy applications based on COM/COM+. Microsoft Transaction Server coordinates application transactions for Oracle Database.
The goal of OFA is to place all Oracle Database software under one ORACLE_HOME directory and to spread database files across different physical drives as databases increase in size. OFA is implemented on Windows and UNIX in the same way, and main subdirectory and filenames are the same on both operating systems. Windows and UNIX differ, however, in their OFA directory tree top-level names and in the way variables are set.
On UNIX, ORACLE_BASE
is associated with a user's environment. ORACLE_HOME and ORACLE_SID
must be set in system or user login scripts. Symbolic links are supported. Although everything seems to be in one directory on the same hard drive, files may be on different hard drives if they are symbolically linked or have that directory as a mount point.
On Windows, ORACLE_BASE
is defined in the registry (for example, in HKEY_LOCAL_MACHINE\SOFTWARE\ORACLE\HOME0
). ORACLE_HOME
and ORACLE_SID
are variables defined in the registry. Symbolic links like those on UNIX are not supported, although Microsoft has announced the intention to support them in a future release.
See Also: Appendix B, "Optimal Flexible Architecture" in Oracle Database Installation Guide for Microsoft Windows x64 |
On UNIX, Oracle Database uses a process to implement each of such background tasks as database writer (DBW0
), log writer (LGWR
), shared server process dispatchers, and shared servers. Each dedicated connection made to the database causes another operating system process to be spawned on behalf of that session.
On Windows, each background process is implemented as a thread inside a single, large process. For each Oracle Database instance or system identifier, there is one corresponding process for Oracle Database. For example, 100 Oracle Database processes for a database instance on UNIX are handled by 100 threads inside one process on Windows.
All Oracle Database background, dedicated server, and client processes are threads of the master Oracle Database Windows process, and all threads of the Oracle Database process share resources. This multithreaded architecture is highly efficient, allowing fast context switches with low overhead.
To view processes or end individual threads, use Oracle Administration Assistant for Windows. Choose Start > Programs > Oracle - HOME_NAME > Configuration and Migration Tools > Administration Assistant for Windows. Right-click the SID
and choose Process Information.
Note: Microsoft Management Console (MMC) is started when Oracle Administration Assistant for Windows is started. Oracle Database has integrated several database administration snap-ins into MMC. |
See Also:
|
Datafiles for tablespaces may be stored on a file system or on raw partitions. A raw partition is a portion of a physical disk that is accessed at the lowest possible level.
UNIX supports raw partitions (logical drives). There is no limitation on the number of disk drives.
Windows is limited to using drive letters A-Z, but creating raw partitions lets you bypass the disk drive limitation and divide disks into smaller sections.
Use Windows disk management tools to create an extended partition on a physical drive. An extended partition points to raw space on the disk that can be assigned multiple logical partitions for database files.
An extended partition avoids the four-partition limit on Windows by allowing you to define large numbers of logical partitions to accommodate applications using Oracle Database. Logical partitions can then be given symbolic link names to free up drive letters.
On Windows Vista and Windows Server 2008, create primary partitions and logical drives in extended partitions by right-clicking in the unallocated space for the disk and selecting the New Simple Volume option. To create a raw device, select Do not assign a drive letter or drive path. To mount the raw device, assign and remove a drive letter. Do not use spanned volumes or striped volumes. These options will convert the volume to a dynamic disk. Automatic Storage Management does not support dynamic disks.
Note: Raw partitions are necessary for shared datafiles in an Oracle Real Application Clusters environment, available on Windows. Oracle Real Application Clusters, in which Oracle Database instances run on all nodes simultaneously, provides clustering and high availability. Oracle Real Application Clusters is not supported on Windows XP. |
Windows services are similar to UNIX daemons.
Oracle Database registers a database instance as a service (OracleServiceSID). Services start background processes.
To connect to and use an Oracle Database instance, an Oracle Database service is created during database creation and associated with Oracle Database. Once a service is created with Oracle Database, the service can run even while no user is logged on.
By default, services run under the SYSTEM account. Choose Start >
Settings >
Control Panel >
Services to access the Services dialog.
alert log
A file that contains important information and error messages that are generated during database operations.
authenticate
To verify the identity of a user, device, or other entity in a computer system, often as a prerequisite for allowing access to resources in a system.
authentication
Identification of a user, device, or other entity in a computer system, often as a prerequisite for allowing access to resources in a system.
authorization
Permission given to a user, program, or process to access an object or set of objects. In Oracle Database, authorization is done through the role mechanism. A single person or a group of people can be granted a role or a group of roles. A role, in turn, can be granted other roles.
backup
A representative copy of data. This copy includes important parts of your database such as control files, redo log files, and datafiles.
A backup is a safeguard against unexpected data loss; if you lose your original data, then you can use the backup to make the data available again. A backup is also a safeguard against an application error; if an application makes incorrect changes, then you can restore the backup.
certificate authority
A certificate authority (CA) is a trusted third party that certifies the identity of other entities such as users, databases, administrators, clients, and servers. The certificate authority verifies the user's identity and grants a certificate, signing it with one of the certificate authority's private keys.
COM/COM+
Microsoft's Component Object Model is an object-oriented programming architecture and a set of operating system services. These services notify running application components of significant events and ensure that they are authorized to run. COM/COM+ is intended to make it relatively easy to create business applications that work well with Microsoft Transaction Server in Windows.
connect descriptor
A specially formatted description of the destination for a network connection. A connect descriptor contains destination services and network route information. The destination service is indicated by using its service name for Oracle9i or Oracle8i databases or its Oracle system identifier for Oracle8 release 8.0 databases. The network route provides, at a minimum, the location of the listener through use of a network address.
connect identifier
A net service name or service name, that maps to a connect descriptor. Users initiate a connect request by passing a username and password along with a connect identifier in a connect string for the services to which they want to connect, for example:
connect string
See net service name.
control files
Files that record the physical structure of a database and contain the database name, the names and locations of associated databases and online redo log files, the time stamp of the database creation, the current log sequence number, and checkpoint information.
credentials
A username, password, or certificate used to gain access to the database.
data dictionary
A set of read-only tables that provide information about a database.
database alias
See net service name.
decryption
Process of converting contents of a message that has gone through encryption (ciphertext) back into its original readable format (plaintext).
digital certificates
ITU X.509 v3 standard data structures that securely bind an identity to a public key. A certificate is created when an entity's public key is signed by a trusted identity, a certificate authority. The certificate ensures that the entity's information is correct and that the public key actually belongs to that entity.
digital signature
Digital signatures are created when a public key algorithm is used to sign messages with senders' private keys. A digital signature assures that a document is authentic, has not been forged by another entity, has not been altered, and cannot be repudiated by the sender.
DLL
See dynamic link library.
downgrade
To convert the data in Oracle Database to an earlier Oracle release. See upgrade and migrate.
dynamic link library
An executable file that a Windows application can load when needed.
encryption
Process of disguising a message, rendering it unreadable to any but the intended recipient.
enterprise domains
Directory constructs consisting of Oracle Database and enterprise users and roles. Enterprise domains are different from Windows 2000 domains, which are collections of computers that share a common directory database.
enterprise role
A directory structure which contains global roles on multiple databases, and which can be granted to an enterprise user.
enterprise user
A user that has a unique identity across an enterprise. An enterprise user connects to individual databases through a schema and is assigned an enterprise role that determines the user's access privileges on databases.
external procedures
Functions written in a third-generation language (C, for example) and callable from within PL/SQL or SQL as if they were PL/SQL functions or procedures.
external role
Roles created and managed by Windows 2000 operating systems. Once an external role is created, you can grant or revoke that role to a database user. You must set init.ora parameter OS_ROLES
to true
and restart Oracle Database before you can create an external role. You cannot use both Windows operating systems and Oracle Database to grant roles concurrently.
external routine
A function written in a third-generation language (3GL), such as C, and callable from within PL/SQL or SQL as if it were a PL/SQL function or procedure.
external user
A user authenticated by the Windows 2000 operating system who can access Oracle Database without being prompted for a password. External users are typically regular database users (non-database administrators) to which you assign standard database roles (such as DBA
), but do not want to assign SYSDBA (database administrator) or SYSOPER (database operator) privilege.
external user
The Windows operating system can authenticate a user, who can then access Oracle Database without being prompted for a password. External users are typically regular database users (non-database administrators) to whom you assign standard database roles (such as DBA
), but do not want to assign the SYSDBA (database administrator) or SYSOPER (database operator) privilege.
global groups
global role
A role whose privileges are contained within a single database, but which is managed in a directory.
Globalization Support
The Oracle Database architecture that ensures that database utilities, error messages, sort order, date, time, monetary, numeric, and calendar conventions automatically adapt to the native language and locale.
HOME_NAME
Represents the name of an Oracle home. In Oracle Database 10g Release 2 (10.2), all Oracle homes have a unique HOME_NAME.
init.ora
initialization parameter file
An ASCII text file that contains information needed to initialize a database and instance.
instance
Every running Oracle Database is associated with an Oracle Database or Automatic Storage Management instance. When a database is started on a database server (regardless of the type of computer), Oracle Database allocates a memory area called the System Global Area and starts one or more Oracle Database processes. This combination of the System Global Area and Oracle Database processes is called an instance. The memory and processes of an instance manage the associated database's data efficiently and serve the users of the database.
instantiate
Produce a more defined version of some object by replacing variables with values (or other variables).
latch
A simple, low-level serialization mechanism to protect shared data structures in the System Global Area.
Lightweight Directory Access Protocol (LDAP)
A standard, extensible directory access protocol. It is a common language that LDAP clients and servers use to communicate. LDAP is a framework of design conventions supporting industry-standard directory products, such as Oracle Internet Directory.
listener
The Oracle Database server process that listens for and accepts incoming connection requests from client applications. The listener process starts Oracle Database processes to handle subsequent communications with the client; then it goes back to listening for new connection requests.
listener.ora
A configuration file that describes one or more Transparent Network Substrate (TNS) listeners on a server.
local groups
See Windows local groups.
local roles
Roles created and managed by the database. Once a local role is created, you can grant or revoke that role to a database user. You cannot use Windows (for external role management) and Oracle Database (for local role management) concurrently.
Microsoft Management Console
An application that serves as a host for administrative tools called snap-ins. By itself, Microsoft Management Console does not provide any functionality.
Microsoft Transaction Server
A transaction processing system based on COM/COM+ that runs on an Internet or network server.
migrate
To upgrade or downgrade an Oracle Database or convert the data in a non-Oracle database into an Oracle Database.
mount
To associate a database with an instance that has been started.
MTS
net service name
The name used by clients to identify an Oracle Net server and the specific system identifier or database for the Oracle Net connection. A net service name is mapped to a port number and protocol. Also known as a connect string, database alias, host string, or service name.
This also identifies the specific SID or database to which the connection is attaching, not just the Oracle Net server.
network listener
A listener on a server that listens for connection requests for one or more databases on one or more protocols. See listener.
network service
In an Oracle application network, a service performs tasks for its service consumers. For example, a Names Server provides name resolution services for clients.
obfuscated
Protected by a process often used by companies for intellectual property written in the form of Java programs. The obfuscation process mixes up Java symbols found in the code. It leaves the original program structure intact, allowing the program to run correctly, while changing the names of the classes, methods, and variables in order to hide the intended behavior. Although it is possible to decompile and read non-obfuscated Java code, obfuscated Java code is sufficiently difficult to decompile to satisfy U.S. government export controls.
OCI
OFA
Optimal Flexible Architecture
A set of file naming and placement guidelines for Oracle Database software and databases.
ORACLE_BASE
ORACLE_BASE is the root of the Oracle Database directory tree. If you install an OFA-compliant database using Oracle Universal Installer defaults, then ORACLE_BASE is X:\oracle\product\10.2.0
where X
is any hard drive.
Oracle Call Interface
An application programming interface that enables you to manipulate data and schema in an Oracle Database. You compile and link an Oracle Call Interface application in the same way that you compile and link a non-database application. There is no need for a separate preprocessing or precompilation step.
Oracle COM Automation Feature
Oracle COM Automation Feature enables Java stored procedure developers and COM/COM+ developers to load COM+ objects from an Oracle Database.
ORACLE_HOME
Corresponds to the environment in which Oracle Database products run. This environment includes the location of installed product files, the PATH variable pointing to the binary files of installed products, registry entries, net service names, and program groups.
If you install an OFA-compliant database, using Oracle Universal Installer defaults, then Oracle home (known as ORACLE_HOME in this guide) is located beneath ORACLE_BASE. It contains subdirectories for Oracle Database software executables and network files.
Oracle Internet Directory
An Oracle Database-based LDAP V3 directory server, used for centralizing database user, Oracle Net network connector, and database listener parameters. Oracle Internet Directory ships only with Oracle Application Server, not the Oracle Database 10g product set.
Oracle Net
A component of Oracle Net Services that enables a network session from a client application to an Oracle Database server. Once a network session is established, Oracle Net acts as a data courier for the client application and the database server. It is responsible for establishing and maintaining the connection between the client application and database server, as well as exchanging messages between them. Oracle Net is able to perform these jobs because it is located on each computer in the network.
Oracle Net Services
A suite of networking components that provide enterprise-wide connectivity solutions in distributed, heterogeneous computing environments. Oracle Net Services are comprised of Oracle Net, listener, Oracle Connection Manager, Oracle Net Configuration Assistant, and Oracle Net Manager.
Oracle PKI
Oracle Advanced Security includes Oracle PKI (public key infrastructure) integration for authentication and single sign-on. Oracle-based applications are integrated with the PKI authentication and encryption framework, using Oracle Wallet Manager.
Oracle Protocol Support
A product that maps the functions of a given network protocol into Oracle Transparent Network Substrate (TNS) architecture. This process translates TNS function calls into requests to the underlying network protocol. This allows TNS to act as an interface among all protocols. Oracle Net requires Oracle Protocol Support.
Oracle services
Windows services that are associated with particular Oracle Database components.
PL/SQL
Procedural language extension to SQL that is part of Oracle Database.
PL/SQL enables you to mix SQL statements with procedural constructs. You can define and run PL/SQL program units such as procedures, functions, and packages.
precompiler
A programming tool that enables you to embed SQL statements in a high-level source program.
private keys
In public key cryptography, these are the secret keys. They are used primarily for decryption but also for encryption with a digital signature.
privilege
A right to run a particular type of SQL statement or to access another user's object.
process
A mechanism in an operating system that can run an executable. (Some operating systems use the terms job or task.) A process normally has its own private memory area in which it runs. On Windows a process is created when an application runs (such as Oracle Database or Microsoft Word). In addition to an executable program, all processes consist of at least one thread. The Oracle Database master process contains hundreds of threads.
public key
In public key cryptography, this key is made public to all. It is primarily used for encryption but can also be used for verifying signatures.
public key cryptography
Public key cryptography involves information encryption and decryption using a shared public key paired with private keys. Provides for secure, private communications within a public network.
quota
A limit on a resource, such as a limit on the amount of database storage used by a database user. A database administrator can set tablespace quotas for each Oracle Database username.
raw partitions
Portions of a physical disk that are accessed at the lowest possible disk (block) level.
recovery
To restore a physical backup is to reconstruct it and make it available to the Oracle Database server. To recover a restored backup is to update it using redo records (that is, records of changes made to the database after the backup was taken). Recovering a backup involves two distinct operations: rolling forward the backup to a more current time by applying redo data, and rolling back all changes made in uncommitted transactions to their original state.
redo log buffer
A circular buffer in the System Global Area that contains information about changes made to the database.
redo log files
Files that contain a record of all changes made to data in the database buffer cache. If an instance failure occurs, then the redo log files are used to recover the modified data that was in memory.
registry
A Windows repository that stores configuration information for a computer.
remote computer
A computer on a network other than the local computer.
replication
The process of copying and maintaining database objects in multiple databases that make up a distributed database system.
role
A named groups of related privileges. You can grant a role to users or to another role.
schema
A named collection of objects, such as tables, views, clusters, procedures, and packages, associated with one or more particular users.
services
Executable processes installed in the Windows registry and administered by Windows. Once services are created and started, they can run even when no user is logged on to the computer.
service name
See net service name.
SGA
See System Global Area.
Shared Server Process
A server configuration which allows many user processes to share very few server processes. The user processes connect to a dispatcher background process, which routes client requests to the next available shared server process.
SID
See system identifier.
snap-ins
Administrative tools that run within Microsoft Management Console.
snapshot
(1) Information stored in rollback segments to provide transaction recovery and read consistency. Rollback segment information can be used to re-create a snapshot of a row before an update.
(2) A point-in-time copy of a master table located on a remote site. Read-only snapshots can be queried, but not updated. Updateable snapshots can be queried and updated. They are periodically refreshed to reflect changes made to the master table, and at the snapshot site.
SYSDBA
A special database administration role that contains all system privileges with the ADMIN
OPTION
, and the SYSOPER system privilege. SYSDBA
also permits CREATE DATABASE
actions and time-based recovery.
SYSOPER
A special database administration role that permits a database administrator to perform STARTUP
, SHUTDOWN
, ALTER
DATABASE
OPEN/MOUNT
, ALTER
DATABASE
BACKUP
, ARCHIVE
LOG
, and RECOVER
, and includes the RESTRICTED
SESSION
privilege.
System Global Area
A group of shared memory structures that contain data and control information for an Oracle Database instance.
system identifier
A unique name for an Oracle Database instance. To switch between instances of Oracle Database, users must specify the desired system identifier. The system identifier is included in the CONNECT
DATA
parts of the connect descriptors in a tnsnames.ora file, and in the definition of the network listener in a tnsnames.ora file.
SYSTEM
One of two standard database administrator usernames automatically created with each database. (The other username is SYS
.). The SYSTEM
username is the preferred username for database administrators to use for database maintenance.
tablespace
A database is divided into one or more logical storage units called tablespaces. Tablespaces are divided into logical units of storage called segments, which are further divided into extents.
thread
An individual path of execution within a process. Threads are objects within a process that run program instructions. Threads allow concurrent operations within a process so that a process can run different parts of its program simultaneously on different processors. A thread is the most fundamental component that can be scheduled on Windows.
tnsnames.ora
A file that contains connect descriptors mapped to net service names. The file can be maintained centrally or locally, for use by all or individual clients.
trace file
Each server and background process can write to an associated trace file. When a process detects an internal error, it dumps information about the error to its trace file. Some of the information written to a trace file is intended for the database administrator, while other information is intended for Oracle Support Services. Trace file information is also used to tune applications and instances.
trust points
Trust points or trusted certificates are third party identities that are qualified with a level of trust. A trusted certificate is used when an identity is being validated as the entity it claims to be. Certificate authorities you trust are called trusted certificates. If there are several levels of trusted certificates, a trusted certificate at a lower level in the certificate chain does not need to have all its higher level certificates reverified.
universal groups
Universal groups are available in Windows. They can contain other groups, including other universal groups, local groups, and global groups.
username
A name that can connect to and access objects in a database.
view
A selective presentation of the structure and data of one or more tables. Views can also be based on other views.
Windows global groups
Groups that can be granted permissions and rights in their own domain, member servers and workstations of their domain, and in trusted domains. They can also become members of Windows local groups in all these places. But global groups can contain user accounts only from their own domains.
Windows local groups
Groups that can be granted permissions and rights only for its own computer or, if part of a domain, to the domain controllers of that domain. Local groups can, however, contain user accounts and Windows global groups from both their own domain and from trusted domains.
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